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Message of the Director General 
 
The first curriculum revision for the new millennium is based on the elimination of the several 
problems obtaining in the present education system.  The present curriculum reforms have 
been planned having identified the problems that youth face consequent to the weakening of 
their thinking abilities, social abilities as well as personal abilities and step by step 
exploration of factors leading to this situation, to overcome which, the necessary background 
was prepared.   
 
Compared to the other countries in the Asian region, our country took the lead in education 
in earlier years.  But most countries in this region have superceded Sri Lanka in education 
today.  Some factors that influenced this deterioration are the action taken by educational 
institutions to continue to take action to confirm the known, learn that which had been 
decided on earlier, and reconstruct that which was, in the same form itself.   
 
All these matters have been taken into consideration and the officers of the National Institute 
of Education have endeavoured to prepare the new curriculum on the basis of a distinct 
philosophy.  The primary objective here is to change that which is known, explore that which 
is new and develop that which is necessary for tomorrow and build up a generation of 
students who can display their readiness for a successful future.  But there is no need to 
reiterate, the need for a visible change in the teacher’s role for the realization of this 
objective. In place of the obvious transactional teacher role presenting in our classrooms so 
far, the Sri Lankan school teacher will have to understand and conform to a student-
centered, competency based and activity focused transformational role. 
 
It is our firm belief that this Teacher Instruction Manual will serve you as an aid to become an 
effective teacher through the provision of numerous instructions that will help you adapt to 
the new situation.  Through the study of these instructions you will be provided the 
opportunity of making your daily teaching as well as the evaluation task easy.  There is no 
doubt that instructions for student exploration and other quality inputs will help facilitate the 
teacher’s task.  Similarly, the Teacher Instruction Manual will help convey to school 
principals valuable information they can use in time-tabling, sharing of limited resources and 
internal supervision. 
 
My sincere thanks go to Dr. Mrs. I. L. Ginige, Assistant Director General (Curriculum 
Development) Science & Technology Faculty of National Institute of Education for her direct 
involvement in the preparation of this Teacher Instruction Manual that will serve an immense 
purpose in the task performed at school level by the section above and also teacher 
educationist involved in beginning or continuous teacher educational matters, in-service 
advisors as well as officers at various levels, involved in external supervision plus monitoring 
programmes.   
 
 
Professor J. W. Wickramasinghe 
Director General 
National Institute of Education               
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Preface 

The first curriculum reform for the millennium implemented with the aim of preparing a 
powerful basis for a new Sri Lanka anticipates a visible transformation of the teacher’s role. 
The three main sections below are included in the Teachers Instruction Manual prepared 
with the objective of providing the teacher with the necessary support in this regard. 

• Detailed Syllabus 
• Activity Continuum that helps in the implementation of the syllabus  
• Instruments for the extension of the learning teaching process. 
  
Teachers have been provided the opportunity of understanding several basic matters 

that have been taken into consideration in the preparation of the curriculum for the detailed 
syllabus extending beyond subject topics and sub-topics. Competency levels that 
correspond to subject competency have been included in this section that commences with 
an introduction to the factors and subject aims that formed the basis of the new syllabus. 
One special features of this section is that, while the knowledge-base determined under 
competency level each student needs to develop has been introduced as the subject content 
the multiple learning and teaching methods employed in transmitting this section to the 
student has also been taken into consideration in determining the time frame with respect to 
each competency level.  
The final part of the detailed syllabus presented under the heading “School Policy and 
Programs” needs to be studied very carefully and understood by every instructional leader. 
This section provides school managers a range of valuable instructions to assist them in the 
allocation for teaching, subject-teaching assigning functions to teachers, implementing co-
curricular activities as well as supervision of the teacher’s task. The second section of the 
Teacher Instruction Manual has been prepared with the objective of providing teachers with 
clear understanding of the proposed learning- teaching methodology. This section 
commences with the introduction of the methods of planning activities under competency-
based education as well as the change in the teacher’s role. Although the activity continuum 
necessary for the implementation of the curriculum has been introduced next, the 
implementation of the proposed activity in the very same manner is not expected of 
teachers. The teacher should endeavor to make use of his / her creative, as well as critical 
thinking abilities and adapt these activities in a manner that suits ones class, best. Although 
instructions have been provided on the constitution of groups in keeping with the facets of 
the problems subject to exploration, the teacher is expected to take an intelligent decision on 
the number of groups based on number of students in the class.  
  Time has been allocated for activities to ensure achievement of the relevant 
competency levels. Therefore, teachers may have to exceed the 40-minute period. While 
each activity has been provided adequate time for the actualization of each competency 
level, the teacher is expected to make use of single or double periods in the time table and 
breakdown these activities, as suitable in implementing them. For the success of the 
procedure it is essential that every time an activity commenced the previous day is carried 
over to the following day, that a brief summary of the part of the activity completed the 
previous day is presented to the class. Similarly, this decision will provide the school 
community with the opportunity of involving students in effective learning where teachers 
obtain leave of absence. The final item in this section  is a list of quality inputs necessary for 
the maintenance of the quality of  subject learning and teaching, when taken as a whole. As 
such, the teacher has a choice of ordering out the necessary learning-teaching materials in 
time and having them on hard. 
 
Included in the third part of the teacher Instruction Manual under the title “ Assessment and 
evaluation” are a number of important hints to ensure that the expected results of the 
exercise are realized. 
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This section has been so structured as to introduce matters related to the assessment and 
evaluation that should take place under each activity, extension of the learning and teaching 
that takes place based on activity groups and the nature of the questions that might be 
expected in general examinations. It must be pointed out that the primary responsibility of 
the teachers is to Identify instances where assessment and evaluation  can be implemented 
in the  course of each activity and to carry out this task successfully on the basis of common 
criteria. The set of instruments prepared with a   range of activities as the objective for the 
purpose of extending learning and teaching provide students with the opportunity of 
involvement in continuous learning outside the recommended classroom sessions. While it is 
the task of the teacher to regularly examine the learning students receive, based on these 
instruments, and encourage them, arriving at a correct decision regarding the final results of 
the activities and communicating that decision to the relevant parties is expected of the 
teacher. It is essential that a visible change takes place in general examinations for the 
success of the learning-teaching process. The National Institute of Education, with the 
assistance of the Sri-Lanka Department of Examinations, has introduce several prototype 
questions for educational levels that terminate with these examinations. Since this change in 
examination question papers has been suggested in order to direct students to learn through 
practice and experience, instead of resorting to mechanical approaches like memorizing or 
answering model question papers, the education of school students and parents about this 
change should commence at the beginning itself. 
 
All teachers should realize that various activities can be developed for the achievement of 
any particular competency level. Accordingly, they should be prepared for more successful 
teaching through the use of better approaches, exploration, as well as instruments for the 
extension of learning and teaching. 
 
 
The present Teacher Instruction Manual will give teachers right throughout the country the 
courage to effect a visible change in the teacher’s role and prevent their becoming inactive in 
the presence of new approaches. Similarly, we expect to award certificates and provide 
numerous development opportunities to teachers who go beyond the activities to involve 
themselves in the innovation of novel creations. What teachers have to do order in to 
become eligible to the awards is to improve these activities, using their creative thinking, and 
present them. Learning-teaching plans prepared in this manner outside the basic activity 
plan, should be forwarded to Assistant Director General ( Curriculum Development ), 
Science and Technology faculty, National Institute of Education, Sri Lanka. Selection of 
those entitled to awards will be made subsequent to the study of these activities by the 
relevant subject committees. 
We have endeavoured in this manner, to bring learning-teaching assessment and evaluation 
on to the same platform through new methodologies. According to this, teachers will be 
provided substantial latitude to meaningfully handle the learning-teaching process, school-
based assessment, as well as assignment of home-work. It is our firm conviction that the  
school system of Sri Lanka will, make maximum use of this aid and depart from orthodox 
learning-teaching approaches to enhance the thinking abilities, social abilities as well as the 
individual abilities of the sons and daughters of the county.  
 
Dr Indira Lilamani Ginige  
Assistant director general (Curriculum Development),  
Science and technology faculty,  
National Institute of Education,  
Sri Lanka  
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Information And Communication Technology 

 
RATIONALE 
The Information and Communication Technology sector is acknowledged worldwide as a 

tool that could be used to increase the productivity, efficiency and effectiveness of work. This 

technology has enabled dramatic changes in the job market and the way workers 

communicate with each other and perform job related activities. Every sector of the economy 

is forced to use this technology to make their work effective and efficient and thereby 

maintain a competitive edge.   Therefore, those who enter the job market should acquire 

proper IT skills to find employment in the modern business world without much difficulty. 

However, in Sri Lanka, the level of IT skills of the majority of the students is not adequate to 

meet the current requirements of business and industry. This is mainly due to lack of 

opportunities for students to study IT related subjects in the school curriculum. Therefore, it 

is very important to bridge the gap between requirements of the industry and quality of 

education standards through the curriculum, providing transferable skills and competencies 

related to the world of work. Especially, the ICT and entrepreneurial skills of students should 

be developed.  The student should learn at school a wide variety of competencies for 

different needs of life in the changing world. They should have various views and different 

ways to continue studies and proceed to employment. 

 

Since Sri Lanka is in the early stages of introducing ICT to the lower grades, the present 

syllabus does not demand any ICT knowledge as an entry requirement. Therefore, this 

syllabus is intended to introduce ICT as a technical subject to be offered at the G.C.E (O/L). 

Examination. The main objective of this syllabus is to develop the competencies to use ICT 

tools and to build a basic theoretical base for students to pursue higher studies in ICT. 
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Course Objectives: 
 
Such a surge in the growth, development and the application of Information Communication 
Technology as today has never been experienced before. The importance and relevance of 
ICT to almost all walks of life today has made it all the more important that knowledge and 
expertise, both practical and theoretical, of its application, should begin at the very grass 
roots level of education.  
 
It with the objective of accommodating this perception that there is the need for ICT to be 
firmly and pervasively established in the schools system, that the present initiative for the 
introduction of the ICT–G.C.E. (O / L) syllabus on a competency based format, was taken in 
keep with curriculum reforms of 2007. 
 
 
Objectives to be achieved by the course are as follows: 
 

 Inculcate basic computer literacy and develop a base for further pursuit of 
Information Technology and Communication Technology studies. 

 
 Develop understanding of use and resultant outcomes of use of different 

types of ICT applications. 
 

 Develop concepts and principles related to ICT. 
 

 Improve skills required for the development of ICT based solutions for real 
world problems. 

 
 Provide awareness of benefits and problems of ICT use to participants.    
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Subject Content and Time Duration by Competencies and  Competency Levels,  
 

 
 
 
 
 
 

Competency and competency 
levels 

Content Time 
minutes

 
1. Investigates the place of the computer in the world of information. 
 

 

1.1 Investigates the contribution of 
ICT towards national 
development. 

. 

 

 Definition of ICT 

 Uses of ICT in society  

 Importance of ICT 
 
 

120 

 
1.2 Investigates the computer as a 

system for converting data into 
information. 

 

 Parts of a system 

 Difference between Data and 
Information 

 Data and Information as input and 
output  

 Processing as the method for 
converting data into information 

 

90 

 
1.3 Explores the evolution of 

computers to identify its major 
developments. 

 

 Computer Generations  

 Hardware changes 

o  Vacuum Tubes 
o Transistors 
o Integrated Circuits 
o LSIC 
o VLSIC  

 

 Related changes in characteristics 

o Size 
o Capacity 
o Speed 
o Accuracy 
o Efficiency 
 

 

90 



G.C.E.(O/L) IT Teacher Instructional Manual  

© 2007 National Institute of Education 12

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Competency and competency 

levels 

 
Content 

 
Time 

minutes 
 
2. Selects and uses computer hardware 

2.1 Classifies computers using a 
variety of methods. 

 Computer classifications 
o Mainframe/Mini/Micro/Super 
o Digital/Analog/Hybrid  
o General purpose/special 
      purpose 

 

90 

2.2 Classifies computer peripherals 
by function. 

 Functions of computer 
peripherals 

o Input  
o Processing 
o Output  
o Storage  
o Dissemination   

 

120 

2.3 Identifies and connects basic 
peripherals to the computer. 

 Basic computer components 
      Keyboard, mouse, system unit, 
      monitor 
 Ports 

o PS/2 ports 
o Serial port 
o Parallel ports 
o USB port 
o RJ 45 

       

90 

2.4 Uses the basic block diagram 
to demonstrate the computer 
system. 

 Flow path 
o Data/instruction signals 
o Control Signals  

 

80 

2.5 Investigates benefits and 
concerns of computer networks 
for optimal communication.  

 Purpose of computer networks 
o Data communication 
o Resource sharing 

 Components of a network 
o Network Interface Cards  
o Internal/External 
o Transmission Media 
o Network cable  
o Twisted Pair, Co-axial, Fiber 
      optics,  
o Microwaves  
o Client/Server 
o Computers 
o Modems  
o Hub/Switches 

 Network Operating Systems 
 Types of computer Networks 

o LAN 
o MAN  
o WAN 

 Disadvantages of Networks 
 

80 
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Competency and competency 

levels 

 
Content 

 
Time 

minutes 
 
3 Investigates the methods used for data representation in computer systems 

3.1. Uses the Binary number system 
to represent data in computer 
systems 

 Methods for data representation 

o One and zero to represent two 
      states 

 Binary number system to represent 
the two states 

60 

3.2. Converts decimal numbers to 
Binary, Octal and Hexadecimal 

  
 Number systems 

o Decimal 
o Binary 
o Octal 
o Hexadecimal 

 Methods for related conversions 

90 

3.3 Converts Binary numbers to 
Decimal, Octal, Hexadecimal 
numbers and vice versa 

  Methods for relevant conversions   

o Binary to Decimal 
o Binary to Octal 

 Binary to Hexadecimal and vise 
versa 

90 

3.4 Determines the capacity of 
computers in terms of data 
storage 

 Bit 

 Byte 

 Kilobyte 

 Megabyte 

 Gigabyte 

 Terabyte 

 

90 

3.5 Uses coding systems in 
computers 

 BCD 

 EBCDIC 

 ASCII 

 Unicode 

 

80 
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Competency and competency 

levels 

 
Content 

 
Time 

minutes 
 
4. Uses Boolean Algebra to work effectively with logic gates 

 
4.1 Identifies basic logic operators 

and draws truth tables to illustrate 
their functions. 

 

 Operators 

o AND 
o OR 
o NOT 

 Introduction to Truth Table (more 
than two inputs) 

 

80 

 
4.2 Assesses the suitability of basic  
      logic gates to illustrate logic     
      operations. 

 

 Identify Basic Logical Gates 

o AND 
o OR 
o NOT 

 

 
80 

 
4.3 Uses basic laws of Boolean 

algebra to handle logic gates 

 

 Introduction to Boolean Algebra 

 Introduction to Basic Laws of 
Boolean Algebra  

 

 
80 

4.4 Integrates basic gates to develop 
simple circuits  

 

 Uses Boolean algebra to simplify 
problems in designing simple 
circuits.   

 

 
80 

5.Works effectively with operating systems 
5.1 Explores operating system by 

type functions benefits and 
concerns 

 Manual system and the OS 
 Functions of the OS  
 Benefits of the OS 

 

60 

5.2 Adopts the graphical user 
interface to meet ones own need 

 GUI 
 Benefits of GUI  
 GUI components & its features 

120 
 

5.3 Handles files and folders in the 
Windows operating system. 

 Windows Explorer/ My computer 
o Drives 
o Folders 
o Files and extensions 

 Manipulating files and folders.  
 Recycle bin 

60 
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Competency and competency 

levels 

 
Content 

 
Time 

minutes 
 
6. Uses Word Processing Software To Solve Day-To-Day Problems. 

 
6.1 Explores the concept and 

features of Word Processing 

 

 Introduction to Word processing 

 Components of Word processing 
Application Window. 

 

120 

 
6.2:  Performs basic tasks in Word  
        Processing 

 

 Creating a new document 

 Opening an existing document 

 Saving and closing 

120 

 
6.3 Uses different types of formatting  
       in Word Processing  

 

 Formatting text 

 Drawing, Formatting and Inserting 

120 
 

 
6.4 Inserts tables into documents and 

acquires the ability of customizing 
them. 

 

 Inserting table 

 Column width and row height 

 Deleting, inserting, splitting and 
merging  

60 

6.5 Creates documents and obtains 
printouts.  

 Spelling and Grammar checking 

 Find and replace 

 Page setup (paper size, margins, 
orientation and selecting printer 

 Print options (copies and page 
range) 

90 

6.6 Uses the mail merge facility.  Document types  

 Common document 

 Source data 

 

120 
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7. Uses Spreadsheet to solve simple statistical problems. 

 
7.1 Explores a Spreadsheet to 

identify its basic features and 
functions. 

 

 Introduction to Spreadsheets 

 Components of Spreadsheets 
Application Window. 

 

90 

7.2 Moves around the worksheet to 
gain hands on experience of data 
entry 

 Worksheet, columns, rows and cells 

 Moving around worksheet. 

 Data entries (label, number, 
formulae) 

60 

 
7.3 Performs basic mathematical 

operations 

 Simple calculations using values 
and operators (+, -, *, /) 

 Simple calculations using cell 
names and operators (+, -, *, /) 

60 

7.4 Uses inbuilt functions for  
calculations 

 Simple calculations using values 
and operators (+, -, *, /) 

 Simple calculations using cell 
names and operators (+, -, *, /) 

60 

7.5 Formats a worksheet  Font, Font size, Bold, Italic etc. 

 Alignment (centre, left, right) 

 Decimal places (increase and 
decrease) 

90 

7.6 Recognizes relative versus 
absolute cell references. 

 Absolute and Relative cell 

      references. 

90 

7.7 Creates charts Using 
Spreadsheet 

 Charts, chart type, chart options 90 
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Competency and competency 

levels 

 
Content 

 
Time 

minutes 
 
8.  Uses Presentation software to design electronic presentations. 

8.1. Makes attractive presentations  
using basic features of 
presentation software 

 Introduction to presentation 

 Changing Background, Slide layout, 
Slide designs. 

 Inserting Suitable pictures 

 Customizing animation 

120 

 
9. Develops simple databases to elicit information. 

 
9.1 Explores the Concept of 

Database 

 Introduction to database 

 Tables, Fields, Records, Key field 

120 

 
9.2 Creates a simple database with a 

single table, manually 
 

 Field name, unique field, data types, 
field size 

90 

 
9.3 Converts a manual database into 

electronic media 

 Field name, data types, field size, 
Primary key, Field properties 

90 

 
9.4: Creates a relational   
       Database manually 

 Relational DBMS 

 Primary key, Foreign key, 
Relationship  

60 

9.5 Uses DBMS software to convert 
manually developed relational 
database into electronic media 

 Relational DBMS 

 Primary key, Foreign key, 
Relationship 

120 

9.6 Creates Queries to extract 
information 

 

 New query design 

 Using criteria 

 Sorting 

60 

 9.7 Uses Forms to append data and 
view information 

 New form design 

 Controls and properties 

 Header & footer (Form & Page) 

60 
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School Policies and Programmes 
The schools attempting to implement the new technical subject ICT at the GCE (OL) are likely to 
face a number of challenges.  First and foremost, the non-availability of a computer laboratory or an 
adequate number of computers for the task will not allow all schools with GCE (OL) classes to 
initiate the course in year 2007 itself.  The technical nature of ICT will further limit the number of 
teachers opting to teach the subject thereby preventing the school authorities from selecting the 
most suitable teacher to be trained for the purpose.  Moreover, lack of senior teachers both within 
and in the vicinity of the school will not allow adequate assistance and guidance to be offered to 
those teachers who undertake teaching of the new subject.   
 
Curricula proposed under the first curriculum reform of the new millennium require all subject 
teachers to introduce the philosophy of learning by doing. The teachers attempting to meet this 
requirement have to link theory with practice in every activity they plan for their students.  The 
learning thus acquired through activities has to be supplemented with a number of additional 
practice sessions.  All this requires every school offering the subject to be equipped with a computer 
laboratory with multimedia facilities.  Although the ideal situation in this respect is to provide a 
computer to each student, the many limitations resulting through resource constraints would 
necessitate two students to share one computer.  
 
It is also important that each school has a technician or at least a competent teacher to attend to 
minor repairs and breakdowns and troubleshoot software. The school authorities, however, are 
encouraged to get the major repairs attended to by the Computer Resource Centre (CRC) in the 
region or by the computer vendor itself in the availability of a valid warranty.  Maintenance and 
repairs to computer items thus will ensure the availability of a running computer laboratory for 
continuous use by students throughout the course period.   
 
All teachers selected for teaching of ICT must have skills over and above mere computer users.  
Such teachers should be able to understand the logic of programming.  They should further have 
the capacity and willingness to update the competencies they acquire originally to be in line with the 
new developments of the industry.  In view of facilitating this, the teachers selected should be 
exposed to both initial and continuing teacher education programmes organized for them by the IT 
Department of the Science and Technology Faculty of the National Institute of Education. 
 
Even though all students should have equal opportunity to select ICT as their technical subject, 
resource limitations, particularly in the areas of computer laboratories and capable teachers, may 
not allow all those who are interested to be selected for the course.  Considering the resources 
available to the schools, the authorities, therefore, will have to find a reasonable basis to select an 
appropriate number of students to follow the course.   
 
As with any other optional subject included in the technical or any other subject group, ICT has to be 
allocated with three periods a week.  The teachers will have to study the activities given in the 
Teacher Instructional Manual (TIM) in dividing the time assigned between activity and practice 
sessions.  Since the computer laboratory available to each school is shared for Computer Assisted 
Learning (CAL), General Information Technology (GIT), and various other programmes on computer 
awareness, it is advisable to maintain a time allocation chart in the computer laboratory itself to 
prevent any possible clashes. 
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The group project to be undertaken in the second year of the course will have to be carried out 
beyond the normal classroom sessions.  Thirteen periods, however, will be devoted for teacher led 
discussions at different stages of the project.  For the success of this activity which enables a score 
comprising both individual and group marks, arrangements will have to be made for the students to 
use the computer laboratory outside the timetabled sessions. 
 
The tools developed to extend learning and teaching can be used for assessment and evaluation as 
well.  The resulting marks can be submitted to the Sri Lanka Department of Examinations for 
certification purposes. 
 
Until the full cadre of In-Service Advisors (ISAs) are appointed to support teachers at school level, 
the schools are expected to maintain a close relationship with the closest CRC and the Provincial 
Centre for IT for purposes of monitoring the progress of the subject and provision of necessary 
feedback to the teachers.   The relevant sectional head and the senior teachers of the school also 
may assist the ICT teacher on pedagogical matters to enable joyful learning for the students.  All 
parties responsible for ICT also will be updated from time to time on such matters. 

 
For successful implementation of ICT at school level, the schools should demonstrate a culture 
conducive to ICT.  School administrative and instructional processes embracing IT for day-to-day 
activities are two features of such a culture.  It is also important for the majority of students of the 
school to have some exposure to IT and the school community to value ICT education as a tool for 
future employability.   To accomplish the first task here, the schools are encouraged to form ICT 
clubs, conduct ICT exhibitions, and make visits to ICT organizations.  Links with relevant industries 
in the locality will pave the way for the latter.  Support extended by such institutions in developing 
the ICT sections of the schools and in supplying employment to school leavers will enable the 
schools to make ICT popular among their school communities. 
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Part 2 
 

Learning – Teaching 
Methodology 
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Introduction 
 
In deciding upon the learning teaching methodology relevant to the course, attention has been paid 
to the planning of learning-teaching activities so as to facilitate building up of student competencies 
based on exploration.  In preparing for competency-based education, in this manner, an obvious 
change in the role of the teacher is expected. 
 
The transmission role practiced in our classroom from way back and the more recently introduced 
transaction role is evident in the classroom even in the present day.  When taking the deterioration 
of the thinking skills, personal skills and social skills of school leavers into consideration, it needs no 
effort to understand that there is a need for the development of the learning-teaching methodology 
and how it should be effected. 
 
In the transmission role while the teacher is considered an individual who knows everything, his task 
has become that of considering the student as one who does not know anything and of transmitting 
knowledge to him.  This learning-teaching process that takes the guise of lectures is restricted only 
to the flow of knowledge from the teacher to the student, does not make an adequate contribution 
either to the stimulation of student thinking or to the development of his personal and social skills.  
 
The dialogue initiated by the teachers within the class is the initial stage of the transaction role apart 
from the ideas that flow from the teacher to the class and from the class to the teacher. These 
dialogues get gradually transformed into discussions as a result of the student-student interaction 
that takes place subsequently.  The teacher is continuously involved in the task of questioning in 
order to take the student from the known to the unknown, from the simple to the complex and from 
the concrete to the abstract. 
 
While, in competency-based education, student tasks occupy a powerful position, the teacher 
occupies the position of a resource person who mediates in order to provide every student in the 
class with at least the competency proximate to each relevant competency.  For this purpose the 
basic functions the teacher is expected to perform include planning of a learning environment 
consisting of the materials and other facilities necessary for learning, close observation of how 
students learn, identification of student abilities and inabilities and the promotion of student learning 
through feed back and provision of feed forward as well as the preparation of instruments of 
assessment for the extension of learning beyond the classroom.  The teacher’s role based 
eventually upon the tasks above is called the transformation role.   
 
The series of activities that can be used in the implementation of the descriptive curriculum 
introduced in the first part of this course guide, has been included in its second part.  Each of these 
activities has been developed so as to contain a minimum of three steps.  It is expected to get the 
student involved in the learning process through the first step of the activities.  As such, this step is 
called the “Engagement” step.  As an introduction to this step, the teacher assumes the Transaction 
role and engages in a dialogue with the students.  Later, along with the transformation of this 
dialogue to a discussion the students engage in exploration and are provided the opportunity to 
recall the pre-knowledge related to the basic competency they should develop and to acquire a hint 
regarding the future of the activity.  The teacher possesses a host of strategies that can be used in 
these exchanges of ideas.  Some of the devices at the disposal of the teacher for the exchange of 
these ideas are questioning/stimulants like pictures, newspaper advertisements and flash cards/use 
of puzzles or case studies/dialogues, role play, poems, songs and demonstrations, video tapes or 
audio tapes.  In summary, the first step of the activities is implemented with the objective of 
actualizing the three objectives below. 

• Winning over of the attention of the class. 
• Providing the students with the opportunity for students’ recall of the necessary pre-

knowledge. 
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• Introducing the elements of the explanation the students are expected to be directed to 
under the second step of the activity. 

It is with the objective of providing the students with the opportunity of Exploration that the second 
step of the activity has been planned. Students base their exploration on a special leaflet prepared 
for the purpose. The teacher has to plan this explanation to enable the students to engage in co-
operative learning through the exploration of various aspects of the problem, in groups. Some of the 
most important qualities of this step are involvement in the conscious group discussions and the use 
of the resource materials provided. As a result of involvement in group activities through a long 
period of time, student will acquire the ability to develop a number of skills like self-discipline, 
listening to others, working co-operatively with others, helping them, management of time, obtain 
creations of high quality, honesty etc.  In directing students to exploration, while the teacher should 
avoid taking decisions regarding leadership, he should build up the background necessary to 
surface. Accordingly, the students will have the privilege of taking on leadership when opportune, 
based on hidden abilities. 
 
During the 3rd step of the activity, every group will get the opportunity of presenting the results of its 
exploration for the enlightenment of the others. What the teacher has to do here is to encourage 
students to group presentations. It would be effective if students are directed so as to ensure that 
every member is given responsibility in the planning of the presentation. An important quality of this 
step, related to the explanation of student findings, is the creation of the opportunity for the voice of 
students to be heard in the classroom where, commonly the voice of the teacher had dominated.    
 
After the explanation of the findings in the third step of the activities, students should be directed to 
elaboration. Each group is given the opportunity to provide constructive suggestions on its findings 
first, and subsequently, members of other groups are given this opportunity. Anyway the final review 
is the responsibility of the teacher. The teacher is expected to touch on all the important points 
relevant to the students’ exploration.  
 
The main responsibility of the teacher in this learning teaching process is to monitor continuously, 
whether the classroom learning-teaching process is implemented successfully, as expected. While 
assessment and evaluation should be made use of for this purpose, the teacher is provided the 
opportunity, through planned activities, in the learning teaching process itself. The teacher is given 
the opportunity for assessment while the students are involved in exploration during the second 
stage of the activity and for evaluation when the students are involved in explanation and expansion 
during the third stage. A detailed inquiry into assessment and evaluation will be provided later on in 
this document.  
The teacher is provided direction on the transformation role by the learning –teaching methodology 
described so far. While priority is given to group exploration here, the teacher is also afforded the 
opportunity for transaction, discussion and short lectures. While there is room for transaction and 
discussion, the teacher may also give a short lecture, under review, in the final stage. In the 
development of the learning-teaching methodology related to this curriculum, the first to be 
introduced under the curriculum reforms for the new millennium, the attention paid to the important 
features relevant to the transmission as well as the transaction roles of the teacher, apart from the 
transformation role, is a special feature of this methodology. 
 
The learning-teaching process can be broadened through the improvement of the evaluation 
program. For this purpose the teacher has the opportunity of creating several evaluation situations 
through an activity continuum. The program of assessment can be made meaningful by dividing the 
activity continuum to several activity clusters to facilitate identification of evaluation points. It is 
necessary that the evaluation instrument being used with respect to each activity is introduced to 
the students at the beginning of every activity cluster. It is also necessary in the selection of learning 
varieties, those activities where student motivation to learn are helped to blossom forth, is selected. 
Below is a list of the relevant activities. 
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Concept maps 
Wall newspapers 
Quizzes 
Question and answer books 
Portfolios 
Exhibitions 
Debates 
Panel discussions 
Seminars 
Impromptu speeches 
Role-play 
Presentation of literature reviews 
Field books/ nature diaries 
Practical tests 
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Quality Inputs     

A classroom environment replete with quality inputs is necessary for active education. The inputs 

referred to here can be utilized for purposes of Information and communication technology.  

Some of these equipment may be obtained from the various sections of the school. It is important 

that this equipment is introduced to the students. In the course of the lesson it becomes necessary 

for students to be introduced, physically, to certain peripherals. It is true that certain schools do have 

such equipment but there are others that don’t. The lesson can be, all the more enriched, if students 

are afforded the opportunity of viewing such material. If is left to the ingenuity of the teacher to find 

the necessary equipment, possibly on loan basis. 
 

• Fully equipped computer lab 

with multimedia projector.   

• Demy sheets 

• Markers 

• Half sheets 

• A4 sheets 

• Felt pens 

• Diskettes 

• Counter frames 

• 

A simple circuit built on a circuit 

board. 

• Scanners, digital cameras, 

printers, speakers and other 

peripherals available in the lab.  

• Different types of machines. 

(Manually operated machine 

like coconut scraper, Grinder, 

Grater.)          

 
 Drawings or Diagrams 

• Picture, illustrating the use of ICT in society.  

• Picture on the evolution of the human being 

• Pictures with descriptions of computer peripherals  

• Labeled diagram of starting Window of Word Processing application 

• Labeled diagram of Keyboard layout. 

• Labeled diagram of Starting Window of Spreadsheet 

•  Labeled diagram of formatting tool bar 

• Printouts of Home Page layouts 

• A poster on hobbies 
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Activity Continuum 
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Competency  Level 1.1: Investigates the contribution of ICT towards national 
development        

Activity 1.1   :  Let’s investigate the  role of ICT in society. 

Time  :  120 minutes. 

Quality Inputs   :     ●   The picture illustrating the use of ICT in society in Annexe 1.1.1. 

       ●   Seven copies of the  group exploration instructions in  

   Annexe 1.1.2 

   ●  Seven copies of reading material in Annexe 1.1.3 

●   Demy sheets and markers.  

Learning – Teaching Process: 

Step 1.1.1  : ● Display picture to class. 

  ● Lead a discussion to highlight the following.  

  

  

 

 

(15 minutes) 

Step 1.1.2  : ●   Divide the class into seven groups. 

  ●   Distribute copies of the group exploration instructions and reading 

material to each group with a demy sheet and marker. 

 • Involve the groups in the exploration. 

 • Prepare them for a presentation at the plenary session. 

(45 minutes) 

 

 

● Computers are used to meet a variety of human needs. 

● The many functions facilitated by the computer makes it a  

 multi - purpose tool. 

● Society, however, has to be cautious of its advantages and 

disadvantages. 

 
Competency 1: Investigates the place of the computer in the world of  
                           information. 
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Step 1.1.3 :   ●   Get the groups to present their findings.  

 ● Request the presenters themselves to fill in any gaps they have 

left.  

●   Invite constructive comments of the other groups. 

   ●  Conclude the session by highlighting the following. 

 

 

 

 

 

  

 

   

 

 

(60 minutes) 

Criteria for assessment and evaluation 

 ● Names the main fields where computers are commonly used. 

 ● Accepts the value of the computer as a multi-purpose tool. 

 ● Analyses the contribution of the computer in making day-to-day work efficient and 

effective. 

 ● Reflects on previous experiences to arrive at suitable answers. 

 ● Acknowledges the learning derived from other sources. 

• A common definition for ICT is  “Processing of data using 

the technologies of computing, electronics, and 

telecommunications to disseminate information to clients in 

digital and other forms”. 

• A common use of ICT in education is e-learning. 

• In banking ICT is used for immediate transactions. 

• ICT facilitates customer service in transportation.    

• Scanning is one main use of ICT in medicine.   

• Thus ICT provides us with numerous opportunities to make 

our day-to-day life easy. 

• Society, however, has to be prepared to give due credit to 

its founders.  
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Annexe 1.1.1 
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Annexe 1.1.2 
Instructions for the Group Exploration 

 
Today, ICT has become an important part of day-to-day life.  Most human activities now take 

place with the aid of ICT solutions. The reason behind this is that, ICT gives more effective 

and speedy solutions to real life problems. In fact, a characteristic feature of this era is that 

people lead such complex lifestyles with greater requirements that need rapid and suitable 

solutions. ICT satisfies these requirements in a comprehensive manner. Hence today has 

become the ICT age. 

 

 A few instances where ICT is used currently are:  

 
o Education 

o Banking & Accounting 

o Transportation 

o Medicine 

o Engineering 

o Security & Defense  

o Entertainment 

 

• You will be working in seven groups with the seven fields above randomly distribute 

among the groups. 

• Go through the relevant section of the reading material.  

• Develop a definition for ICT on the basis of your reading experience. 

• List how the computer is used in the particular field assigned to your group. 

• Suggest other uses to be added to the list. 

(Use a different marker to highlight the additions) 

• Identify the relevance of ICT in your own field of work. 

• Be prepared to present your findings at the plenary session.  
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Annexe 1.1.3 
Reading Material 

 
Uses of ICT in society 
 
Education 

•  Learning 

•  Teaching 

•  Educational administration 

Computer Assisted School Administration+ 

This involves the use of IT to automate activities in school administration such as keeping 

records of students, examination results, normal office work and communication with other 

schools via e-mail etc.   

 

 

 

 

 

 

 

 

 

 
 
Accounting and Banking  
[ATM, Transactions, Tele banking, Credit card payments] 

    IT is used to automate manual accounting systems such as general ledger, sales and 

purchases, stock control (with point of sales terminal connected to stock data base) In 

banking the use of Automatic Teller Machine is a useful application of IT. 

 

 

 

 

 

 

Transportation 
Transportation 
[Air traffic controlling, Ticketing, Cargo operations, ] 
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Transportation 
IT is used in transportation by railways and airlines for reservation of seats, control of traffic 

and maintaining time-tables of vehicles and duties of the crew. It is used in all fields of air 

traffic. Every aircraft has a small computer fitted to help pilots in various ways. 

 

 

 

 

 

 

 

 

 
Medicine  
[Chemical analysis, CT, MRI, US Scanning, ECG, EEG, Surgery]  

In hospitals special computers are built inside different equipment. For example CAT 

scanners (Computer Axial Tomography) Further maintenance of patients records in 

electronic databases enhances services provided to them. 

In hospitals special computers are built inside different equipment. For example CAT 

scanners (Computer Axial Tomography) Further, maintenance of patients records in 

electronic databases enhances service provided to them. 

 

 

 

 

 

 

 

 

 

 
 
 



G.C.E.(O/L) IT Teacher Instructional Manual 
 

 
 

 
National Institute of Education- 2007 

 
41

 
Defense & Security  
[Signal operations, Missile guidance, and nuclear plant operations] 

  IT is very useful in tracking down criminals through the maintenance of their databases. In 

warfare computers are used to guide missiles. 

 

 

 

 

 

 

 

 

Error! 
 
 
 
 
 
 
 
Engineering 
Engineers use IT to prepare drawings of machines, tools, bridges, buildings etc. 

 (Computer Assisted Drawing- CAD). Also computers are used to control manufacture of 

items. (Computer Assisted Manufacture). The use of Robots in industries is another 

example. 
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Entertainment 
This basically covers video games, music and movies played back by computers with 

multimedia facilities. 

 
 

Importance of ICT 
ICT provides many opportunities for the users 

• Makes learning more interesting especially of hard-to-understand topics 

• Bridge distances – e.g. using e-mail, phone, video conferencing etc. 

• Breaks literacy barriers in communication – e.g. use of video and radio. 

• Helps research and information sharing – e.g. use of Internet 

• Helps access information on jobs/internships 

• Creates new employment opportunities (via ICTs/with ICTs) 

• Enhances interaction with peers over long distances. 

• Creates entertainment opportunities (games, music, video)  

• Provides more realistic information on life elsewhere. 

• Provides educational information (distance learning) 

• Provides health information, including information on sensitive issues. 
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Competency Level 1.2:  Investigates the computer as a system for converting data 
                                         into information 
Activity 1.2  :  Let’s differentiate between data and information. 

Time  :  90 minutes. 

Quality Inputs :    ●   Three copies of the group exploration instructions in 

             Annexe 1.2.1 

  ● Three copies of reading material in Annexe 1.2.2 

●    Demy sheets and markers. 

Learning – Teaching process: 

Step 1.2.1 :   ● Draw the following table on the board.        

  ●  Get a volunteer to question the others and complete it.  

  

  

 

 

 

 

 

  ● Conduct a discussion to highlight the following.                                                  
 

 

 

 

 

 

 

 
(15 minutes) 

Step 1.2.2          :  ●   Divide the class into three groups.  

                                  ●   Provide each group with copies of the group exploration 

instructions and reading material.  

How do we make a cake? 

Ingredients Process Output 

   

Competency 1:Investigates the place of the computer in the world of 
                          information. 

 

  ● Ingredients are needed to make a cake. 

  ●   Proper instructions are needed to guide the process. 

  ●   Ingredients and instructions are the inputs of this process. 

  ●   The cake is the output. 

  ●   Similarly, data need to be processed through a set of 

instructions to obtain information. 
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 ●   Assign each group to study Data, Data processing and information 

separately.          

  ● Prepare each group to present its findings.    

(45 minutes) 

Step 1.2.3 :   ● Get each group to present its findings.  
 ● Request the other groups to present constructive comments. 

 ●   Conduct a discussion to highlight the following. 

 

        

 

 

 

 

 

 

 

 

 

 

 

 

 
 

(30 minutes) 
Criteria for assessment and evaluation  
 ● Differentiates between data and information. 

 ● Accepts that any result comes through a guided process  

 ● Gives proper instructions to obtain better results. 

 ● Collects data and processes them into information in real life situations.  

 ● Expresses verbally the facts obtained from a document.  

 
 
 
 
 
 
 
 
 

●    Data are the basic facts about things.  

●    Data can exist in the following two basic forms. 

o Data that cannot be expressed numerically. 

o Data that can be expressed numerically. 
●    Data can be processed in many ways as follows. 

o Arithmetical processes. 

o Organizing – Storing, Indexing. 

o Statistical processes. 

●    Information is obtained by processing data in a meaningful       
      way. 

●    Information has nine characteristics. 

●    There are six factors that improve the quality of information. 

●    Information is used in day – to – day routine work, increasing  

      our knowledge and planning, forecasting. 
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Annexe 1.2.1   
Instructions for the Group Exploration 

•  You will be working in three groups on the following three topics randomly assigned to 

the groups 

o Data  

o Data processing  
o Information  

• Go through the handout to identify the nature of the data type given to your group. 

• Discuss with members and identify examples of the data types. 

• Explain how you would process the data given. 

• Describe the type of information you expect after processing. 

• What differences do you see between data and information? 

• Write down your answers on the demy sheet given and be prepared for a presentation.  
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Annexe 1.2.2 
Reading Material 

 
Data 
Data are the basic facts about aspects such as things, persons, places, business activities, 
and events that exist in unprocessed form and have little meaning. They are treated as raw 
material.  
 
E.g. Data concerning. An employee 
 
  Employee number 
  Name 
  Data of employment 
  Department 
  Job title 
  Salary 
Data exists in the following forms. 

1. Text (read & write) 
Digits (numerical)   [0...9] 
Letters (Alphabetical)   [a..z, A..Z] 
Punctuation marks   [. , : : etc.] 
Special tokens    [$ # @ ^ * !  Space etc] 
Control characters. 

2. Audio   - Tones and other sounds, voice 
3. Imaging - Dots, Lines, Circles, rectangles, diagrams, images, 

pictures. 
 
Classification of data 
   
Data can be categorized into two basic forms: 

1. Data that cannot be expressed numerically 
e.g.  Colour, shape, sound, degree of health. 

2. Quantitative Data 
Data that can be expressed numerically are either discrete or continuous. 

 
 
Nature of Data. 
 
Data can be 

1. Collected and stored. 
2. Retrieved from a storage medium. 
3. Communicated. 
4. Processed. 

 
 

Data Processing 
A set of numerical data can be processed in many ways. Some of these are:  

1. Arithmetical Process. 
2. Organizing – Storing, Indexing. 
3. Statistical Processes. 



G.C.E.(O/L) IT Teacher Instructional Manual 
 

 
 

 
National Institute of Education- 2007 

 
47

Manual Process and Technological Process 
Basically, Data Processing can be done in two ways: Manual and Technological. 
When compared to manual processing, technological processing is extremely fast, accurate 
and more reliable. Technology thus allows the highest value for information by giving rise to 
the field of Information technology.    
 

Information 
 
The term information refers to the result obtained by processing data in a meaningful way. 
 
    Input         Process           Output 
 
    Data                                                                                                      Information                                        
 

Relevance of Information 
Information must have a purpose and so, it must be available to someone who can use it. 
The relevance of information varies from person to person. For an average person, the fifth 
root of 100 may mean nothing, but it may be very useful to a scientist or a technologist.  
 
Characteristics of Information. 
Information  

1. is meaningful 
2. is a surprise element 
3. is an action   
4. is an action motivator 
5. confirms and refreshes previous knowledge 
6. is considered an economic resource, somewhat on par with other resources such as 

labor, material, and capital.  
7. is an economic commodity  which helps to stimulate the worldwide growth of a new 

segment of national economics – the information service sector. 
8. can only be shared in transactions and not exchanged. 
9. is relative. 

Factors that improve the quality of information 
1. Relevance 
2. Completeness 
3. Accuracy 
4. Clarity 
5. Timeliness 
6. Make of Communication  

Uses of information 
Information facilitates 

• Day – to – day routine work 
• Knowledge 
• Planning 
• Forecasting 

Processing into meaningful form 
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Value of information 
The value of information is determined on the basis of its relevance. The moment you create 
or receive information, it has a great value but this drops rapidly with time. This leads to a 
very important rule called the ‘Golden Rule’ of information. It states that the highest value of 
information occurs at time zero. 
 
 
         Data                                                                                                     Information                                   
 
 
 
Data and Information 
 
The two terms data and information are often used as meaning the same thing. An important 
distinction, however, exists between them. 
 
 
 
 
 
 
 
 
 
 

Meaningful Processing 
(t-->0) 
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 Competency Level 1.3: Explores the evolution of the computer to identify its major                

              developments.  
Activity 1.3       :  Let’s trace the development of computers to their present status.  

Time : 90 minutes. 

Quality Inputs :  ● The picture illustrating  the evolution of the human being in Annexe  

                                         1.3.1.    

  ● Four copies of the group exploration instructions in Annexe 

                                         1.3.2 

  ● Four copies of the reading material  in Annexe 1.3.3 

  ● Demy sheets and markers. 

 
  
Learning – Teaching Process 
 
Step 1.3.1 : ● Expose the picture to the class.  

  ● Lead a discussion to highlight the following.  

 

 

 

 

 

 

 

(15 minutes) 

 

Step 1.3.2 :  ●  Divide the class into four groups. 

● Provide each group with copies of group exploration instructions, 

reading material, demy sheets and markers. 

 ● Assign four generations to the four groups and involve them in   

the exploration. 

   ●  Prepare the groups for an innovative presentations at plenary  

    session. 

(40 minutes) 
 

• The human beings have evolved from the apes. 

• Over the generations, they have retained their basic structure 

while losing certain features and adding new features. 

• Now human beings rule the world. 

• Computers also have followed a similar pattern. 

• They have developed over a number of generations.   

Competency 1:Investigates the place of the computer in the world of 
                     information. 



G.C.E.(O/L) IT Teacher Instructional Manual 
 

 
 

 
National Institute of Education- 2007 

 
50

 
Step 1.3.3 : ●  Request each group to present its findings. 

  ● Conduct a discussion to highlight the following. 

 
 
 
 
 
 
 
 
 
 
 

 

 

 

 

 

(35 minutes) 

 
(35 minutes) 

Criteria for assessment and evaluation 

• Names the electronic components pertaining to the computer generations. 

• Accepts the need to study the past and the present to be prepared for the future. 

• Traces the evolution of the computer in terms of its major generations. 

• Picks relevant information from reading materials. 

• Works cooperatively with peers.  

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

          
 

• The first computer was developed in 1939. 

• The evolution of the computer rests basically on the 

development of its electronic component as follows. 

o Vacuum tube 

o Transistor 

o Integrated Circuit (IC) 

o Micro chip  

o The size, power consumption and heat generation are few 

computer aspects that have decreased over the 

generations. 

o The speed of processing and the performance are the 

features that have increased over the years. 
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       Annexe 1.3.1 
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Annexe 1.3.3 
Reading Material 

The Evolution of the Computer 
 

1. First Generation (1939-1954) - Vacuum Tube 

• 1937 - John V. Atanasoff designed the first digital electronic computer  
• 1939 - Atanasoff and Clifford Berry demonstrate in Nov. the ABC prototype  
• 1941 - Konrad Zuse in Germany developed in secret the Z3  
• 1943 - In Britain, the Colossus was designed in secret at Bletchley Park to decode 

German messages  
• 1944 - Howard Aiken developed the Harvard Mark I mechanical computer for the 

Navy  
• 1945 - John W. Mauchly and J. Presper Eckert built ENIAC at U of PA for the U.S. 

Army  
• 1946 - Mauchly and Eckert start Electronic Control Co., received grant from National 

Bureau of Standards to build a ENIAC-type computer with magnetic tape 
input/output, renamed UNIVAC in 1947 but run out of money, formed in Dec. 1947 
the new company Eckert-Mauchly Computer Corporation (EMCC).  

• 1948 - Howard Aiken developed the Harvard Mark III electronic computer with 5000 
tubes  

• 1948 - U of Manchester in Britain developed the SSEM Baby electronic computer 
with CRT memory  

• 1949 - Mauchly and Eckert in March successfully tested the BINAC stored-program 
computer for Northrop Aircraft, with mercury delay line memory and a primitive 
magnetic tape drive; Remington Rand bought EMCC Feb. 1950 and provided funds 
to finish UNIVAC  

• 1950- Commander William C. Norris led Engineering Research Associates to 
develop the Atlas, based on the secret code-breaking computers used by the Navy in 
WWII; the Atlas was 38 feet long, 20 feet wide, and used 2700 vacuum tubes  

• 1951 - S. A. Lebedev developed the MESM computer in Russia  
• 1951 - Remington Rand successfully tested UNIVAC March 30, 1951, and 

announced to the public its sale to the Census Bureau June 14, 1951, the first 
commercial computer to feature a magnetic tape storage system, the eight 
UNISERVO tape drives that stood separate from the CPU and control console on the 
other side of a garage-size room. Each tape drive was six feet high and three feet 
wide, used 1/2-inch metal tape of nickel-plated bronze 1200 feet long, recorded data 
on eight channels at 100 inches per second with a transfer rate of 7,200 characters 
per second. The complete UNIVAC system weighed 29,000 pounds, included 5200 
vacuum tubes, and an offline typewriter-printer UNIPRINTER with an attached metal 
tape drive. Later, a punched card-to-tape machine was added to read IBM 80-column 
and Remington Rand 90-column cards.  

• 1952 - Remington Rand bought the ERA in Dec. 1951 and combined the UNIVAC 
product line in 1952: the ERA 1101 computer became the UNIVAC 1101. The 
UNIVAC I was used in November to calculate the presidential election returns and 
successfully predict the winner, although it was not trusted by the TV networks who 
refused to use the prediction.  

• 1954 - The SAGE aircraft-warning system was the largest vacuum tube computer 
system ever built. It began in 1954 at MIT's Lincoln Lab with funding from the Air 
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Force. The first of 23 Direction Centers went online in Nov. 1956, and the last in 
1962. Each Center had two 55,000-tube computers built by IBM, MIT, AND Bell 
Labs. The 275-ton computers known as "Clyde" were based on Jay Forrester's 
Whirlwind I and had magnetic core memory, magnetic drum and magnetic tape 
storage. The Centers were connected by an early network, and pioneered 
development of the modem and graphics display.  

 

 

 

 

 

 

 

 

 

 
UNIVAC 1951, from 
Smithsonian NMAH 

 
UNIVAC I ca. 1955, from 

Smithsonian 

 

UNIVAC I of 1951 was the first business computer made in the U.S. "Many people saw a 
computer for the first time on television when UNIVAC I predicted the outcome of the 1952 

presidential elections." 
 

  

Atanasoff- 
Berry Computer  
1939, from IEEE 

magnetic drum 
memory of the 
Atanasoff-Berry 
Computer 1939, 
from Smithsonian 
NMAH

Whirlwind core 
memory 1951, 
from IEEE 
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Bendix G-15 of 1956, inexpensive at $60,000, for science and industry but could also be 
used by a single user; several hundred were built - used magnetic tape drive and key punch 
terminal 
 

 
IBM 650 that "became the most popular medium-sized computer in America in the 1950's" - 
rental cost was $5000 per month - 1500 were installed - able to read punched cards or 
magnetic tape - used rotating magnetic drum main memory unit that could store 4000 words, 
from Smithsonian NMAH 
 
 

2. Second Generation Computers (1954 -1959) - Transistor 

• 1950 - National Bureau of Standards (NBS) introduced its Standards Eastern 
Automatic Computer (SEAC) with 10,000 newly developed germanium diodes in its 
logic circuits, and the first magnetic disk drive designed by Jacob Rabinow  

• 1953 - Tom Watson, Jr., led IBM to introduce the model 604 computer, its first with 
transistors that became the basis of the model 608 of 1957, the first solid-state 
computer for the commercial market. Transistors were expensive at first, cost $8 vs. 
$.75 for a vacuum tube. But Watson was impressed with the new transistor radios 
and gave them to his engineers to study. IBM also developed the 650 Magnetic Drum 
Calculator, the first by IBM to use magnetic drum memory rather punched cards, and 
began shipment of the 701 scientific "Defense Calculator" that was the first of the 
Model 700 line that dominated main frame computers for the next decade  

• 1955 - IBM introduced the 702 business computer; Watson on the cover of Time 
magazine March 28  

• 1956 - Bendix G-15A small business computer sold for only $45,000, designed by 
Harry Huskey of NBS  

• 1959 - General Electric Corporation delivered its Electronic Recording Machine 
Accounting (ERMA) computing system to the Bank of America in California; based on 
a design by SRI, the ERMA system employed Magnetic Ink Character Recognition 
(MICR) as the means to capture data from the checks and introduced automation in 
banking that continued with ATM machines in 1974  
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transistor, from 

Smithsonian NMAH 

"First transistor (model), 
December 1947. 

Constructed by John 
Bardeen, Walter 

Brattain and William 
Shockley at Bell 

Laboratories," from 
Smithsonian NMAH 

 
Regency transistor radio 

1954 (TL), Zenith 
transistor hearing aid 

1952, from Smithsonian 
NMAH 

Regency transistor radio 
1954, from Smithsonian 

NMAH 

 
Philco and Emerson 

transistor radios, from 
Smithsonian NMAH 

transistor radios, from 
Smithsonian NMAH 

 
transistor radios, from 
Smithsonian NMAH 

 
 

3. Third Generation Computers (1959 -1971) - IC 

• 1959 - Jack Kilby of Texas Instruments patented the first integrated circuit in Feb. 
1959; Kilby had made his first germanium IC in Oct. 1958; Robert Noyce at Fairchild 
used planar process to make connections of components within a silicon IC in early 
1959; the first commercial product using IC was the hearing aid in Dec. 1963; 
General Instrument made LSI chip (100+ components) for Hammond organs 1968  

• 1964 - IBM produced SABRE, the first airline reservation tracking system for 
American Airlines; IBM announced the System/360 all-purpose computer, using 8-bit 
character word length (a "byte") that was pioneered in the 7030 of April 1961 that 
grew out of the AF contract of Oct. 1958 following Sputnik to develop transistor 
computers for BMEWS  

• 1968 - DEC introduced the first "mini-computer", the PDP-8, named after the mini-
skirt; DEC was founded in 1957 by Kenneth H. Olsen who came for the SAGE 
project at MIT and began sales of the PDP-1 in 1960  

• 1969 - Development began on ARPAnet, funded by the DOD  
• 1971 - Intel produced large scale integrated (LSI) circuits that were used in the digital 

delay line, the first digital audio device  
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IC, from Smithsonian 
NMAH 

Polaroid IC 1961, from 
Smithsonian NMAH 

 
DEC PDP-1 of 1960, 

from CHM DEC PDP8/E minicomputer 
1973 from SDCM 

 
Anderson Jacobson ADC 

260 acoustic coupler 
1963, from SDCM 

 
early transistor 

calculators - Casio 
"Mini" used chips from 

TI (left); TI SR-10 
calculator showing 

circuit in transparent 
case, used a single chip 
1972, from Smithsonian 

NMAH 

early transistor 
calculators - Casio 

"Mini" used chips from 
TI (left); TI SR-10 
calculator showing 

circuit in transparent 
case, used a single chip 
1972, from Smithsonian 

NMAH 

 
IC, from 

Smithsonian 
NMAH 

 
IC, from Smithsonian 

NMAH 

 
 
 
 
4. Fourth Generation (1971-Present) - microprocessor 

• 1971 - Gilbert Hyatt at Micro Computer Co. patented the microprocessor; Ted Hoff at 
Intel in February introduced the 4-bit 4004, a VSLI of 2300 components, for the 
Japanese company Busicom to create a single chip for a calculator; IBM introduced 
the first 8-inch "memory disk", as it was called then, or the "floppy disk" later; 
Hoffmann-La Roche patented the passive LCD display for calculators and watches; 
in November Intel announced the first microcomputer, the MCS-4; Nolan Bushnell 
designed the first commercial arcade video game "Computer Space"  

• 1972 - Intel made the 8-bit 8008 and 8080 microprocessors; Gary Kildall wrote his 
Control Program/Microprocessor (CP/M) disk operating system to provide 
instructions for floppy disk drives to work with the 8080 processor. He offered it to 
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Intel, but was turned down, so he sold it on his own, and soon CP/M was the 
standard operating system for 8-bit microcomputers; Bushnell created Atari and 
introduced the successful "Pong" game  

• 1973 - IBM developed the first true sealed hard disk drive, called the "Winchester" 
after the rifle company, using two 30 Mb platters; Robert Metcalfe at Xerox PARC 
created Ethernet as the basis for a local area network, and later founded 3COM  

• 1974 - Xerox developed the Alto workstation at PARC, with a monitor, a graphical 
user interface, a mouse, and an ethernet card for networking  

• 1975 - the Altair personal computer is sold in kit form, and influenced Steve Jobs and 
Steve Wozniak  

• 1976 - Jobs and Wozniak developed the Apple personal computer; Alan Shugart 
introduced the 5.25-inch floppy disk  

• 1977 - Nintendo in Japan began to make computer games that stored the data on 
chips inside a game cartridge that sold for around $40 but only cost a few dollars to 
manufacture. It introduced its most popular game "Donkey Kong" in 1981, Super 
Mario Bros in 1985  

• 1978 - Visicalc spreadsheet software was written by Daniel Bricklin and Bob 
Frankston  

• 1979 - Micropro released Wordstar that set the standard for word processing 
software  

• 1980 - IBM signed a contract with the Microsoft Co. of Bill Gates and Paul Allen and 
Steve Ballmer to supply an operating system for IBM's new PC model. Microsoft paid 
$25,000 to Seattle Computer for the rights to QDOS that became Microsoft DOS, and 
Microsoft began its climb to become the dominant computer company in the world.  

• 1984 - Apple Computer introduced the Macintosh personal computer January 24.  
• 1987 - Bill Atkinson of Apple Computers created a software program called 

HyperCard that was bundled free with all Macintosh computers. This program for the 
first time made hypertext popular and useable to a wide number of people. Ted 
Nelson coined the terms "hypertext" and "hypermedia" in 1965 based on the pre-
computer ideas of Vannevar Bush published in his "As We May Think" article in the 
July 1945 issue of The Atlantic Monthly.  

 
Intel 4004 

microprocessor in 1971, 
from Intel Museum 

Apple I of 1976, from 
Smithsonian NMAH 

 
Wozniak and Jobs 

introduced Apple II in 
1977, from History of 

Apple 

 
MITS Altair 8800A 1975 from 
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SDCM  

 
Apple II personal 

computer 1978 with 
5.25-inch Disk drives, 

from SDCM  
IBM 5151 personal computer 

1981, from SDCM  

 
Seagate ST-251 5-inch 
40 MB hard drive 1978, 

from SDCM 

Memorex 
Model 101 

hard drive, 10 
MB, 1983, 

from SDCM 
 
 
 
 
5. Fifth Generation (Present and Beyond)  
 
Scientists are now at work with the fifth generation of computers. The world is moving 
towards the development of what one can call ‘Super Large Scale Integration’ – which in turn 
will compliment and improve speed, miniaturization and cost reduction. Development of 
ARTIFICIAL INTELLIGENCE to make the computer function and take decisions almost like 
human beings, implementation of expert systems, robots, intelligent programs, speech 
synthesizers as well as the use of video disks and tapes for external storage media, are 
included in the fifth generation of computer innovation    

• 1991 - World-Wide Web (WWW) was developed by Tim Berners-Lee and released 
by CERN.  

• 1993 - The first Web browser called Mosaic was created by student Marc Andreesen 
and programmer Eric Bina at NCSA in the first 3 months of 1993. The beta version 
0.5 of X Mosaic for UNIX was released Jan. 23 1993 and was instant success. The 
PC and Mac versions of Mosaic followed quickly in 1993. Mosaic was the first 
software to interpret a new IMG tag, and to display graphics along with text. Berners-
Lee objected to the IMG tag, considered it frivolous, but image display became one 
of the most used features of the Web. The Web grew fast because the infrastructure 
was already in place: the Internet, desktop PC, home modems connected to online 
services such as AOL and Compuserve  

• 1994 - Netscape Navigator 1.0 was released Dec. 1994, and was given away free, 
soon gaining 75% of world browser market.  

• 1996 - Microsoft failed to recognized the importance of the Web, but finally released 
the much imporoved browser Explorer 3.0 in the summer.  
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Microsoft Reader 
 

 
 

 
Wearable computers 

 
Apple G4 

Linux 

 

 
Nokia 9210 

Communicator is part of 
the latest wave of web 

cell phones 

The raveMP player sells 
for $269 and can store 
more than an hour of 

MP3 music 

 
world's first production 

microchips made of 
silicon-on-insulator (SOI) 
transistors and copper 

wiring by IBM (AP 
5/22/00) 

body scans to buy 
clothes 
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Annexe 1.3.3 

Instructions for the Group Exploration 

• You will be working in four groups with one of the following four generations of 

computer assigned to each group. 

 

Group Generation Significant Feature 

1 First generation  

2 Second generation  

3 Third generation  

4 Forth generation  

 

• Write the significant feature of each generation in the appropriate cage of the 

table. 

• List any other features you have noticed. 

o Identify the changes according to the generations. 

o What are the features you notice about the present progress of the computer?  

o Be prepared to present your findings at the plenary session. 
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Competency 2 :  Selects and uses computer hardware.                    

Competency 2.1 : Classifies computers using a variety of methods. 

Activity 2.1. :   Let’s explore the different classification methods used in 

                                 computers. 

Time :   90 minutes. 

Quality Inputs :     • Eight copies of the group exploration instructions  in Annexe 2.1.1. 

  • Eight copies of the reading material in Annexe 2.1.2. 

●   Demy sheets and markers.  

Learning – Teaching Process: 

Step 2.1.1 :    •    Ask a volunteer to write a few names of vehicles on the 

blackboard.   

  •   Ask another student to classify the vehicles. 

  •   Conduct a discussion to highlight the following. 

 

 

 

 

 

(10 minutes) 
 Step 2.1.2      : •    Divide the class into eight groups.    

  • Distribute copies of the group exploration instructions to each 

group with a demy sheet and marker. 

 • Involve the groups in the exploration. 

  • Prepare groups for a presentation at plenary session. 

                                          (40 minutes) 

Step 2.1.3 : • Get each group to present its findings. 

• Request the presenters themselves to fill gaps, if any.  

•   Seek for constructive comments of other groups. 

   ●  Conclude the session by highlighting the following. 

 

• Main features are taken into account in classification. 

   •   The working capacity of a computer increasing when more 

         features are available. 

• Classification of computers also taken into account the above 

       aspects 
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        (40 minutes) 

 
Criteria for Assessment and Evaluation 

• Names different methods used to classify computer systems and describes 

      them. 

• Accepts the need to use a variety of methods to classify computers.    

•    Classifies computers on the basis of number of methods. 

• Expresses ones own ideas in different forms.    

• Classifies things to facilitate learning.   
 

 

 

•   Computers can be classified as follows. 

o Type 

o Size and Capability 

o Purpose 

•    According to logic,  computers can be classified as follows 

o Digital computers 

o Analog computers 

o Hybrid computers 

•    According to size and capability,  computers can be 

classified as follows. 

o Super computers 

o Mainframe computers 

o Mini computers 

o Micro computers 

•    According to purpose, computers can be classified as 

follows. 

o General purpose computers  

o Special purpose computers  
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Annexe 2.1.1 
 

Instructions for the Group Exploration 
 

• You will be working in eight groups with the following eight topics randomly 

distributed among the groups. 

o Digital computers 

o Analog computers 

o Hybrid computers 

o Classification according to purpose 

o Super computer 

o Mainframe computer 

o Mini computer 

o Micro computer 

• On the basis of the document provided, carry out the part assigned to you. 

• Write down the important points relevant to your topic. 

• Be prepared to present your findings at the plenary session 
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Annexe 2.1.2 
Reading Material 

Classification of computers 
 
A computer can be classified as  follows: 

1. Computational method (Type) 
2. Size and Capability. 
3. Purpose 

 
Classification based on Computational method 
Based on the way a system performs computations, a computer can be classified as follows: 

• Digital  
• Analog 
• Hybrid 

 
Digital Computer 
A digital computer can count and accept numbers and letters through various input devices. 
The input devices convert data into electronic pulses, and perform arithmetical operations on 
numbers in discrete form. In addition to performing arithmetical operations, they are also 
capable of: 

1. Storing data for processing 
2. Performing logical operations 
3. Editing or deleting the input data 

 
One of the main advantages of the use of digital computers is that any desired level of 
accuracy can be achieved by considering as many decimal places as are necessary and 
hence are most suitable for business applications. The main disadvantage is their high cost, 
even after regular reductions in price and the complexity in programming. 
 
Example 
To calculate the distance traveled by a car in a particular time interval, you might take the 
diameter of the tyre to calculate the periphery, take into consideration the number of 
revolutions of the wheel per minute, take the time in minutes and multiply them all to get the 
distance moved. This is called digital calculation. A computer using this principle of digital 
calculations will be called a digital computer. 

 
Analog Computer 
Analog computers process data input in a continuous form. Data such as voltage, resistance 
or temperature are represented in the computer as a continuous, unbroken flow of 
information, as in engineering and scientific applications, where quantities to be processed 
exists as waveforms of continually rising and falling voltages, pressure and so on. As the 
measurements in analog computer are carried out by a few single purpose devices, the 
analog computer offers low cost and ease of programming.    
 
The main disadvantage of an analog computer is the accuracy factor, and the limited storage 
capacity. Hence it is not suitable for processing business data. 
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Example 
If you see the principle of the milometer in a car it does not work on the same principle as 
explained in digital calculation. The rotation of the car wheels move some gears, the 
movement is transmitted to the meter by a flexible shaft. The meter itself contains some 
gears/ wheels marked with numbers and is calibrated to give the exact distance traveled in 
meter/kilometers. There is no calculation involved by numbers and the result is obtained by 
physical phenomenon. This method of calculation is called the Analog method. A computer 
using the analog method of calculation will be termed an analog computer. 

 
 
Hybrid Computer 
A computer can also be built using some parts employing digital computations and some 
parts based on Analog principles. Such computers are called Hybrid Computers. 
 
Example 
In Process Control Computer Systems, the input comes from devices likes pressure, gauze, 
thermometers, meters etc. The pressure control uses analog methods in the relevant areas. 
The inputs from analog devices are sent to a digital computation unit that runs the 
mathematical model for controlling the process. These types of computers are called Hybrid 
because they use analog methodology in some parts and digital methodology in some 
others. 
 
Classification according to purpose 
General purpose computers  
The computers, which can be theoretically used for any type of application, are called 
general-purpose computers. 
Special purpose computers 
The computers, which are made and used for specific jobs like air traffic control systems. 
Controlling fuel in automobiles are called special purpose computers 
Classification based on Size and Capability 
On the basis of size and capability, the digital computer can be classified as:      

• Super Computer 
• Mainframe computer 
• Mini Computer 
• Micro Computer 

 
 
Super Computer 
These are the largest and fastest computers available but are typically not used for 
commercial data processing. Instead they are used in specialized areas as in Defense, 
Aircraft design, computer generated movies, weather research etc. The first super computer 
was the ILLIAC IV made by Burroughs. Other suppliers of supercomputer are CRAY, CDC, 
FUGITSU, NEC etc. A supercomputer CRAY-1 is considered the most powerful computer 
today. The supercomputers CRAY-2 and CRAY-3 developed by Seymore Cray are 
wonderful. Supercomputers can process 64 bits or more at a time. Their processing speed 
ranges from 10,000 million instructions per sec (MIPS) to 1.2 billion instructions per sec. 
They can support 10,000 terminals at a time. They have huge numbers of storage and other 
devises connected to them.    
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Mainframe 
Mainframes are less powerful and cheaper than Super computers. However, they are big 
general purpose computers capable of handling all kinds of scientific and business 
applications. Mainframes can process several million instructions per second. More than 
1000 remote terminals can be supported by a Mainframe. Mainframes have large on-line 
secondary storage capacity. A number of different types of peripheral devices like magnetic 
tape drivers, hard disk drive, visual display units, plotters, printers and telecommunication 
terminals can be attached to Mainframe computers. Mainframes, such as ES/9000 family of 
computers of the International Business Machines Corp. (IBM) are used for such 
applications as payroll computations, accounting, business transactions, information retrieval 
and airline seat reservations. 

 
 
Mini Computers 
This type of computer performs data processing activities in the same way as the Mainframe 
but on a smaller scale. The cost of minis is lower. As the name implies, a minicomputer is 
small compared to a Mainframe and may be called a scaled down Mainframe as the 
processor and the number of peripherals are physically smaller. A mini computer can 
typically support 10 to 12 terminals. The most popular Minicomputers or minis are Nova, 
Dec, PDP_II and IBM series. 

 
 
Micro Computers 
This is the smallest category of computers, consisting of a microprocessor and associated 
storage and input/output devices. These are also called Personal Computer systems. 
Microcomputers were first available for widespread use in the 1970’s, when it became 
possible to put the entire circuitry of computers (CPU) in to a small silicon chip. 
 
Example 
Personnel Computers (PC) 
A Personnel Computer is so named because it is designed for personal use. IBM, the 
foremost computer-manufacturing firm in the world, introduced the first PC named as IBM-
PC. Personal computers are classified on the basis of size and portability. Personal 
computers that can be placed on top of a desk but are not very portable are called desktop 
computers. Portable computers are those personal computers that are light enough to be 
easily transported. Portable personal computers that are small enough to be set up on the 
lap of a user are called laptop computers; notebook computers are approximately the size of 
a book. Portable personal computers that can be put in a pocket are called pocket or palm-
sized computers.  
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Competency Level 2.2 : Classifies computer peripherals by function. 
 
Activity 2.2  :  Let’s simulate the function of computer peripherals. 
 
Time  :  120 minutes 
 
Quality Inputs     :    ●  Seven copies of the  group exploration instructions in  

   Annexe 2.2.1 

 ● Seven copies of the reading material in Annexe  2.2.2 

                                ●  Scanners, digital cameras, printers, speakers and other 

     peripherals available in the lab.           
Learning – Teaching Process: 
 
Step 2.2.1       :   ●    Get the students to look around the computer laboratory to identify  

      different peripherals there. 

  ● Conduct a discussion to highlight the following.       
                                     

             
 
 
 

(15 minutes) 
Step 2.2.2          :  ●   Divide the class into Seven groups.  

                         ●   Provide each group with the copies of group  exploration 

    instructions. 

 ●   Request the groups to study the peripheral given to simulate its 

functions.   

         (60 minutes) 
 

Step 2.2.3            :   ●  Allocate three corners of the classroom for input, output,  

        devices and storage devices.   

 ●   Get each group to simulate the peripheral  given. 
       ●   Encourage the other groups to question about the simulation. 

 ●   Fill any gaps indicated. 

 ●   Get the groups completing the simulation . 

       ●   Conduct a discussion to highlight the following. 

 
Competency 2 : Selects and uses computer hardware 
 

   ●   Peripherals are devices that can be attached to the computer  

        system.  

   ●   They can be classified as input devices and output devices  
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(45 minutes) 

 
Criteria for assessment and evaluation  
 
 ● Names computer peripherals and describes their functions. 

 ● Accepts that peripherals serve a specific purpose. 

 ● Classifies peripherals as input, output, and storage devices  

 ● Illustrates one’s own learning through simulations.  

 ● Justifies one’s own answers. 

 
 

   ●   All input devices are used to input data to the system. 

   ●   All output devices are used to get outputs from the system. 

   ●   Some other devices are used to store data.  



G.C.E.(O/L) IT Teacher Instructional Manual 
 

 
 

 
National Institute of Education- 2007 

 
69

Annexe 2.2.1 
 

Instructions for the Group Exploration 
 

• You will be working in seven groups with the following seven topics distributed 

randomly across the groups. 

o CD-Rom 

o Digital Camera 

o Hard Drive 

o Floppy Disk 

o Computer Keyboard 

o Computer Monitors 

o Removable Storage 

 

• On the basis of the document provided, carry out the part assigned to you. 

• Study the peripherals selected and simulate their functions. 

• Be prepared to present your findings at the plenary session 

 

 

 

 

 

 

 

 

 

 



G.C.E.(O/L) IT Teacher Instructional Manual 
 

 
 

 
National Institute of Education- 2007 

 
70

Annexe 2.2.1 
Reading Material 

 

CD-ROM  
You can choose between internal and external CD-ROM. Internal is the most common and 
for most purposes the most practical. The advantage of an external station is that it can be 
moved from one PC to another, although the majority of PCs nowadays have CD-ROM. 
Also, external CD-ROM stations tend to be slower.  
                                       

      

External CD player                                                                  Internal CD player 
 
CD Player (CD Rom) Components 

The CD player has the job of finding and reading the data stored as bumps on the CD. 
Considering how small the bumps are, the CD player is an exceptionally precise piece of 
equipment. The drive consists of three fundamental components:  

. 

 
  
 
 
 
 
 
 
 
 

                                                                                Inside a CD player 
 
 
CDs and DVDs are everywhere these days. Whether they are used to hold music, data or 
computer software, they have become the standard medium for distributing large quantities 
of information in a reliable package. Compact discs are so easy and cheap to produce that 
America Online sends out millions of them every year to entice new users. And if you have a 
computer and CD-R drive, you can create your own CDs, including any information you 
want.  
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Digital Camera 
There are a variety of different digital cameras that vary significantly in price and quality.  
 
Resolution  
 
The resolution is the most important aspect, as it gives the image-quality as well as stating 
its overall pixel capacity.  
 
Some digital cameras can record short film sequences it's normally only possible to record. 
Digital camcorders are able to record long film sequences of high quality.  
 
Some digital cameras have a small monitor on the back that shows you how the pictures are 
going to look like. This monitor is called an LCD monitor, and it gives you a preview of your 
photos. You can go back and look at all the pictures you've taken, and erase those you don't 
want to keep. This will free the space on your memory chip, enabling you to take more 
pictures.  
 
How to transfer your pictures from the camera to 
the PC. 
It's common to use a USB cable. It's also a good 
solution. Some cameras use a disc or a card. 
 
       
                                                              Digital camera 
 
Hard Drive  
Today all PCs use a hard drive for storage of GBs. The data the computer needs to 
remember after it's switched off are stored on the hard drive. Software, images, audio and 
video take up a lot of the storage capacity. 
 

           
 
 
 
 
   
 
Hard Drive                                                         

Removable hard drive 
Removable hard drive 
It's possible to install your hard drive so that it can be removed quite 
easily and inserted into another computer.  

When you're upgrading you might want to consider getting a 
removable hard drive. The way this works, is that the hard drive is 
placed together with the disk drive and the CD-ROM station, making it 
easy to remove the hard drive at any given time. This is particularly 
useful if you're working at two locations, e.g. at home and at work. But 
it's also useful in other respects. For instance, it makes upgrading it 
an easy task.        
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The Floppy Disk 
A floppy disk is a lot like a cassette tape:  

• Both use a thin plastic base material coated with iron oxide. This oxide is a 
ferromagnetic material, meaning that if you expose it to a magnetic field it is 
permanently magnetized by the field.  

• Both can record information instantly.  
• Both can be erased and reused many times.  
• Both are very inexpensive and easy to use.  

A floppy disk, like a cassette tape, is made from a thin piece of plastic coated with a 
magnetic material on both sides. However, it is shaped like a disk rather than a long thin 
ribbon. The tracks are arranged in concentric rings so that the software can jump from "file 
1" to "file 19" without having to fast forward through files 2-18. The diskette spins like a 
record and the heads move to the correct track, providing what is known as direct access 
storage.  

The Floppy Disk Drive 
The major parts of a FDD include:  

• Read/Write Heads: Located on both sides of a diskette, they move together on the 
same assembly. The heads are not directly opposite each other in an effort to 
prevent interaction between write operations on each of the two media surfaces. The 
same head is used for reading and writing, while a second, wider head is used for 
erasing a track just prior to it being written. This allows the data to be written on a 
wider "clean slate," without interfering with the analog data on an adjacent track.  

• Drive Motor: A very small spindle motor engages the metal hub at the center of the 
diskette, spinning it at either 300 or 360 rotations per minute (RPM).  

• Stepper Motor: This motor makes a precise number of stepped revolutions to move 
the read/write head assembly to the proper track position. The read/write head 
assembly is fastened to the stepper motor shaft.  

• Mechanical Frame: A system of levers that opens the little protective window on the 
diskette to allow the read/write heads to touch the dual-sided diskette media. An 
external button allows the diskette to be ejected, at which point the spring-loaded 
protective window on the diskette closes.  

• Circuit Board: Contains all of the electronics to handle the data read from or written 
to the diskette. It also controls the stepper-motor control circuits used to move the 
read/write heads to each track, as well as the movement of the read/write heads 
toward the diskette surface.  

 

Computer Keyboards  
The part of the computer that we come into contact with 
most is probably the piece that we think about the least. 
But the keyboard is an amazing piece of technology. For 
instance, did you know that the keyboard on a typical 
computer system is actually a computer itself?  

Your basic Windows keyboard 
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At its essence, a keyboard is a series of switches connected to a microprocessor that 
monitors the state of each switch and initiates a specific response to a change in that state.  

Keyboards have changed very little in layout since their introduction. In fact, the most 
common change has simply been the natural evolution of adding more keys that provide 
additional functionality.  

The most common keyboards are:  

• 101-key Enhanced keyboard  
• 104-key Windows keyboard  
• 82-key Apple standard keyboard  
• 108-key Apple Extended keyboard  

Portable computers such as laptops quite often have custom keyboards that have slightly 
different key arrangements than a standard keyboard. Also, many system manufacturers 
add specialty buttons to the standard layout. A typical keyboard has four basic types of keys:  

• Typing keys  
• Numeric keypad  
• Function keys  
• Control keys  

The typing keys are the section of the keyboard that contains the letter keys, generally laid 
out in the same style that was common for typewriters. This layout, known as QWERTY for 
the first six letters in the layout, was originally designed to slow down fast typists by making 
the arrangement of the keys somewhat awkward! The reason that typewriter manufacturers 
did this was because the mechanical arms that imprinted each character on the paper could 
jam together if the keys were pressed too rapidly. Because it has been long established as a 
standard, and people have become accustomed to the QWERTY configuration, 
manufacturers developed keyboards for computers using the same layout, even though 
jamming is no longer an issue. Critics of the QWERTY layout have adopted another layout, 
Dvorak that places the most commonly used letters in the most convenient arrangement.  

The numeric keypad is a part of the natural evolution mentioned previously. As the use of 
computers in business environments increased, so did the need for speedy data entry. Since 
a large part of the data was numbers, a set of 17 keys was added to the keyboard. These 
keys are laid out in the same configuration used by most adding machines and calculators, 
to facilitate the transition to computer for clerks accustomed to these other machines.  

In 1986, IBM extended the basic keyboard with the addition of function and control keys. 
The function keys, arranged in a line across the top of the keyboard, could be assigned 
specific commands by the current application or the operating system. Control keys provided 
cursor and screen control. Four keys arranged in an inverted T formation between the typing 
keys and numeric keypad allows the user to move the cursor on the display in small 
increments. The control keys allow the user to make large jumps in most applications. 
Common control keys include:  

 

• Home  
• End  
• Insert  
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• Delete  
• Page Up  
• Page Down  
• Control (Ctrl)  
• Alternate (Alt)  
• Escape (Esc)  

The Windows keyboard adds some extra control keys: two Windows or Start keys, and an 
Application key. The Apple keyboards are specific to Apple Mac systems.  
 
Computer Mice  

 
 
 

                

 
 
Mice first broke onto the public stage with the introduction of the Apple Macintosh in 1984, 
and since then they have helped to completely redefine the way we use computers.  

Every day of your computing life, you reach out for your mouse whenever you want to move 
your cursor or activate something. Your mouse senses your motion and your clicks and 
sends them to the computer so it can respond appropriately.  

The Optical Mouse 

With advances in mouse technology, it appears that the venerable wheeled mouse is in 
danger of extinction. The now-preferred device for pointing and clicking is the optical 
mouse.  

 

 

 

                    The Optical Mouse 

This Microsoft Intellimouse uses optical technology. 

Able to work on almost any surface, the mouse has a small, red light-emitting diode (LED) 
that bounces light off that surface onto a complimentary metal-oxide semiconductor (CMOS) 
sensor. The CMOS sensor sends each image to a digital signal processor (DSP) for 
analysis. The DSP, operating at 18 MIPS (million instructions per second), is able to detect 
patterns in the images and see how these patterns have moved since the previous image. 
Based on the change in patterns over a sequence of images, the DSP determines how far 
the mouse has moved and sends the corresponding coordinates to the computer. The 
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computer moves the cursor on the screen based on the coordinates received from the 
mouse. This happens hundreds of times each second, 

 
Computer Monitors  
 
A computer display is a marvelous thing. An unassuming 
dark gray surface can suddenly transform into an artist's 
canvas, an engineer's gauge, a writer's page or your very 
own window to both the real world and a huge range of 
artificial worlds. 
 
 
 
 
 

      Computer Monitor 
The Basics 
Often referred to as a monitor but the display is the most - used output device on a 
computer. It shows you text and graphic images as you work or play. Most desktop displays 
use a cathode ray tube (CRT), while portable computing devices such as laptops incorporate 
liquid crystal display (LCD), light-emitting diode (LED), gas plasma or other image projection 
technology. Because of their slimmer design and smaller energy consumption, monitors 
using LCD technologies are beginning to replace the venerable CRT on many desktops.  

When purchasing a display, you have a number of decisions to make. These decisions affect 
how well your display will perform for you, how much it will cost and how much information 
you will be able to view with it. Your decisions include:  

• Display technology - Currently, the choices are mainly between CRT and LCD 

 technologies.  

 

• Cable technology - VGA and DVI are the two most common.  
• Viewable area (usually measured diagonally)  
• Aspect ratio and orientation (landscape or portrait)  
• Maximum resolution  
• Dot pitch  
• Refresh rate  
• Color depth  
• Amount of power consumption  
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 Purchasing and Operating 

Printers come in all sizes and price ranges. It's important that you know what you need and 
what the market has to offer. It's also important to be aware that a printer has two prices; a 
purchase price and an operating price. A low purchase price will usually mean high 
operating costs. If a company is looking for a high-performance printer, the printer's 
operating costs will be decisive in their choice.  
Ink or Laser? 
These are terms you should familiarize yourself with. Inkjet printers are the cheapest. But 
that's their only advantage. A laser printer provides you with better and faster printouts, as 
well as having lower operating costs. This is because it's cheaper to buy laser toner than 
printer ink. In addition, inkjet printers may require more expensive paper. Inkjet printers need 
special paper to achieve the best possible printouts and as a result you incur additional 
costs.  
                 
 
 
 
 
 

Printer 

 

Removable Storage 
Portable Memory 
There are several reasons why removable storage is useful:  

• Commercial software  
• Making back-up copies of important information  
• Transporting data between two computers  
• Storing software and information that you don't need to be accessed constantly  
• Copying information to be given to someone else  
• Securing information that you don't want anyone else to access  

 

Portable Memory 

A tiny hard drive powers this removable storage device. 
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Modern removable storage devices offer an incredible number of options, with storage 
capacities ranging from the 1.44 megabytes (MB) of a standard floppy to upwards of 20-
gigabyte (GB) capacity of some portable drives. All these devices fall into one of three 
categories:  

• Magnetic storage  
• Optical storage  
• Solid-state storage 

 

USB Storage Unit 

You plug it into the USB port, use it to store 
information and bring it with you to another PC. 
Simple and practical. 
 

 
 

  USB Storage Unit 
 
The unit is often called a USB drive. There are no disks inside the storage unit. It's a 
memory module (or, if you like, a memory chip) with a larger storage capacity than a floppy 
disk. This kind of unit is mainly used for transporting data from one PC to another. It's small 
and light and fits into your pocket and transferring data to and from the unit is done in no 
time.  
 
You can use it for backup, since transferring data to and from it is done relatively fast. If 
you're working on a document that you're constantly updating, it might be easier to use the 
USB unit for backup, instead of floppy disks or CDs.  
 
Scanners  

Scanners have become an important part of the home office over the last few years. 
Scanner technology is everywhere and used in many ways:  

• Flatbed scanners, also called desktop scanners, are the most versatile and 
commonly used scanners. In fact, this article will focus on the technology as it relates 
to flatbed scanners.  

• Sheet-fed scanners are similar to flatbed scanners except that the document is 
moved and the scan head is immobile. A sheet-fed scanner looks a lot like a small 
portable printer.  

• Handheld scanners use the same basic technology as a flatbed scanner, but rely on 
the user to move them instead of a motorized belt. This type of scanner typically 
does not provide good image quality. However, it can be useful for quickly capturing 
text.  
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• Drum scanners are used by the publishing industry to capture incredibly detailed 
images. They use a technology called a photomultiplier tube (PMT). In PMT, the 
document to be scanned is mounted on a glass cylinder. At the center of the cylinder 
is a sensor that splits light bounced from the document into three beams. Each beam 
is sent through a color filter into a photomultiplier tube where the light is changed into 
an electrical signal.  

 
 
 
 
 
 
 
 

Microtel’s Scan maker flatbed scanner 
PC Speakers 
It's difficult deciding which speakers are the best buy without 
listening to the different speakers to judge the sound quality. 
However, people don't do this very often when they buy speakers 
for their computer.  
 
 
                                                                               

                                                     
 PC Speakers 
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Competency Level 2.3: Identifies and connects basic peripherals to the computer.   
 
Activity 2.3 :   Let’s connect peripherals to the computer. 

Time :  90 minutes. 

Quality Inputs : • Five copies of the group exploration instructions in Annexe 2.3.1.  

  •     Five computers with peripherals detached. 

  ●   Demy sheets and markers.  

Learning – Teaching Process: 

Step 2.3.1 :    •    Display the back panel of the system units to the whole group. 

  •   Ask a volunteer to describe what he sees.   

  •   Conduct a discussion to highlight the following. 

 

 

 

(15 minutes) 

Step 2.3.2 : • Divide the class into five groups.    

  • Distribute copies of the group exploration instructions to each 

group with demy sheets and markers. 

 • Involve the groups in the exploration. 

  • Prepare them for presentation at the plenary session. 

(45 minutes) 

Step 2.3.3 : • Get each group to present its findings. 

• Request the presenters themselves to fill in any gaps they have 

left.  

•   Seek for constructive comments of the other groups. 

    ●    Conclude the session by highlighting the following. 

 

• A System unit has jack points.  

• Some jack points have symbols. 

• Some jack points have pins and some have holes.  

 
Competency 2 : Selects and uses computer hardware 
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(30 minutes) 

 
Criteria for Assessment and evaluation 

• Describes the ports used in a computer system.  

• Accepts the need to use different types of ports.    

• Uses correct ports to connect peripherals. 

• Expresses ones own ideas in different forms.    

• Uses electronic devises accurately.    

 

 

 

 
  

 
 
 

Annexe 2.3.1 

• Jack points are called ports. 

• Ports are used to connect peripherals to the computer. 

• There are many types of ports 

• Symbols help to identify the relevant peripheral. 

• Male ports have pins. 

• Female ports have holes. 

• PS/2 ports are used to connect the mouse and keyboard. 

• A VGA port is used to connect the monitor. 

• Parallel ports are used to connect external devices such as 

scanners and printers. 

• A USB port can be used to connect all kinds of external 

devices, such as external hard drives, printers, mice and 

scanners. 

• The Ethernet (Network) port is used to connect the computer 

to a network or to Internet.
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Figure 1.12 –System Unit, Ports Layouts 

 

Instructions for Group Exploration 
 

• You will be working in five groups.  

• On the basis of the document provided, carry out the task assigned to you. 

• Identify the various ports used in computers. 

• Relate the relevant peripherals to relevant port.  

• Connect relevant peripherals to relevant port. 

• Write down the important points. 

• Be prepared to present your findings at the plenary session. 

 
 
Power Supply  
The regulated power supply inside the computer transforms mains electricity into DC current 

used in the computer. It has an internal fan to cool the unit. 

 

Peripheral Devices 
Peripheral devices are the components of the computer situated outside the main casing of 

the computer. Peripheral devices are typically connected to the computer, using ports. 

Different Types of Ports 

A typical computer may provide a number of different types of ports to connect external 

devices to it. Some of these different port types and their typical usages are explained in the 

following sections. 

 

 
 
 
 

 

 

 

Serial Port 

A serial port is used to connect external modems or an older computer mouse to the 
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computer. There are two serial port versions:  9-pin version, or 25-pin version.  The serial 

port is a male port and the typical data transfer rate over a serial port is 115 kilobits per 

second. 

 

 

 

 

 

Video Card Port    
This connector is used to connect a computer display monitor to a computer's video card. 

The port is a female port and has 15 holes 

. 

 

  

Parallel Port 
A Parallel port has 25 holes and is commonly known as the printer port. They are used to 

connect external devices such as scanners and printers.  

 

 

 

 

 

PS/2 Port 

A PS/2 port, also referred to as a mouse port, is used to connect a mouse or keyboard with 

the computer. Most computers come with two PS/2 ports, one for the keyboard and the other 

for the mouse. 

  

 

 

 

 

 

USB Port 
A universal serial bus (USB) port is a fairly new port - introduced around 1997. This port can 

be used to connect all kinds of external devices, such as external hard drives, printers and 
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mice, scanners. USB-compliant devices can draw power from a USB port.  USB 2.0 

connectors were introduced in 2003 and are capable of transferring data at 480 Mbps.   

 

 

 

 

 

 

Ethernet (Network) Port 
This port is used to connect the computer to a network or to Internet. Data travel through this 

port at speeds of either 10 Megabits or 100 Megabits depending on the speed of the network 

card in the computer. Little monitor lights on these devices flicker when the port is in use. 
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Competency Level 2.4:  Uses basic block diagram to demonstrate the computer  

                  system. 
 

Activity 2.4. :   Let’s learn the Architecture of computers.  

Time :   90 minutes. 

Quality inputs : • Five copies of the group exploration instructions in Annexe  2.4.1 

• Demy sheets and markers. 

                              

Learning – Teaching Process: 

Step 2.4.1 :    •    Pose the following question to the whole class and conduct a 

brainstorming discussion. 

   How do people respond to their environment?     

  •   Conduct a discussion to highlight the following. 

 

 

 

 

 
 

(20 minutes) 

Step .2.4.2 : • Divide class into five groups. 

  ●   Distribute copies of the instruction sheet to each group with a 

demy sheet and marker. 

 • Involve the groups in the exploration. 

• Prepare them for a presentation at the plenary session. 

(40 minutes) 

 

• People get data and information from their environment 

through the five senses. 

• Data and information are processed in their brains. 

• The brain controls all parts of the human system   

• It also has some output methods. 

•  Computers also show the same behavior.  

 
Competency 2: Selects and uses computer hardware          
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Step 2.4.3 : •    Get the groups to present their findings.  

• Request the presenters themselves to fill in any gaps they have 

left.  

●   Seek for constructive comments of the other groups. 

   ●    Conclude the session by highlighting the following 

 

 

 

 

 

 

 

 

 

(30 minutes) 

 
Criteria for Assessment and evaluation 

• Describes the basic block diagram of the computer system  

• Accepts that each part the block diagram performs a specific task. 

• Draws block diagrams with flow path. 

• Expresses ones own ideas in different forms.    

● Expresses one’s own learning through simulations.  

 

 
 
 
 
 

•      Input devices are used to input data to the computer. 

• Output devices are used to output information. 

• The programs and data must be in the main memory to be 

used by the CPU. 
• Secondary or auxiliary storage devices are used to store 

large volumes of information more permanently. 

• The central processing unit performs the majority of 

calculations and controls the operation of a computer. 

• The CPU consists of two parts -  ALU  and CU 
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Annexe 2.4.1 

 
Instructions for the group investigations 

 
By considering the functions performed by the various components, a computer can be 
represented as a collection of logical components as in the following figure. The main 
hardware components of a modern computer system are the central processing unit (CPU), 
the main memory, the secondary storage and the input output devices. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Block Diagram of a Computer System 

 
• Computer Block Diagram consist of the following parts  

 
o Control unit 
o ALU 
o Main Memory 
o Auxiliary/Secondary Storage 
o Input and Output 

 
• You will be working in five groups with the fields above randomly distributed among 

the groups. 
• On the basis of the document type assigned to your group engage in the 

following task. 

• Go through the specimen document given. 
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• Write down the important points. 

• Identify how your part associates with other parts 

• Be prepared to present your findings at the plenary session. 
 
 
Central Processing Unit (CPU) 
The central processing unit performs the majority of calculations and controls the operation 
of a computer. CPUs are rated by the speed at which they can execute instructions.  The 
speed of a CPU is measured in Megahertz (MHz), and is also known as the clock speed.  

 
 

 
 
 
Different manufactures make CPUs today. Some of these popular CPUs available today are 
the Intel, AMD, Cyrix and Motorola. The CPU consists of two parts: the control unit (CU) and 
the arithmetic and logic unit (ALU).  
 
Control Unit (CU) 
The control unit controls and directs the operation of the entire computer system. Although it 
does not perform any actual processing on the data, the control unit acts as the central 
nervous system for the other components of the computer by  generating clock pulses. 
 
 
 
Arithmetic and Logic Unit (ALU) 
The Arithmetic-Logic unit performs arithmetic operations such as addition, subtraction, 
multiplication and division on data. It also performs logical operations, which involve 
comparison of data. 
 
 
 Main Memory (Random Access Memory - RAM)  
The programs and data must be in the main memory to be used by the CPU. The main 
memory is the only large storage area that the CPU can access directly. The memory of a 
computer is measured in Megabytes.  
 
 

RAM or the main memory is the computer’s short-term memory that 
temporarily holds data and instructions, which will be needed shortly 
by the CPU. Data and instructions can be stored and retrieved from 
anywhere in the RAM, and the time taken for such operations is 
approximately the same irrespective of the locations they are stored 
in the RAM. RAM is volatile, which means that it loses its data when 
the computer is turned off. RAM is supplied in modules; small circuit 
boards which can be plugged into the motherboard in special 
sockets. 

Auxiliary Storage  
Secondary or auxiliary storage devices are used to store large volumes of information more 
permanently. There are many types of secondary storage devices. 
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Hard Disks 
A hard disk drive is a device housed inside the computer on which data is stored for later 
retrieval. Most computers have at least one hard disk. Hard disks are considered the most 
reliable method of storage. Hard disk storage capacities range from a few hundred 
megabytes to many gigabytes.  The speed of a hard drive is measured in terms of average 
access time, the speed at which the hard drive finds data. The average access time is 
measured in milliseconds (1/1000 of a second). 

The other Secondary Storage devices are floppy disk, CD /DVD etc. 
 

Input Devices 
Input devices enable data to be fed into the computer in a form that the computer can use. 
Input devices are categorized into two types:  keyboard entry devices and direct entry 
devices. A device through which data can be entered in the computer by pressing keys is 
called a keyboard entry device whereas all the other types of input devices are called direct 
entry devices. 

Output Devices 
Output devices translate information processed by the computer into a form that either 
humans or other machines can understand.  
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Competency Level 2.5:  Investigates benefits and concerns of computer networks for 
   optimal communication 
 
Activity 2.5 :   Let’s find the advantages and disadvantages of networking  

Time :  90 minutes. 

Quality inputs : • Three copies of the reading material in  Annexe 2.5.1 

                              •   Three copies of the group exploration instructions  in  

       Annexe 2.5.2 

  •   Demy sheets and markers    
Learning – Teaching Process: 

Step 2.5.1 :    •    Get a volunteer to explain the process of withdrawing  money from 
an ATM.   

  •   Ask another student to explain the advantages of the above 

system and a third student to explain its disadvantages.  

  •   Conduct a discussion to highlight the following. 

 

 

 

 
 
 
 

(15 minutes) 

Step 2.5.2 : • Divide the class into three groups.    

  •    Distribute copies of the group exploration instructions and reading 

            material among   the groups. 

• Involve the groups in the exploration. 

   •    Prepare them for a presentation at the plenary session. 

(45 minutes) 

 

• A network consists of two or more objects communicating 

with each other. 

•  Some advantages of ATM system are 

o Many can be withdrawn money without visiting the 

bank. 

o The risk of carrying money is reduced. 

o Saves time. 

 
 Competency 2: Selects and uses computer hardware                          
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Step 2.5.3 : • Get groups to present their findings. 

  • Request others to submit constructive comments.  

  •  Conclude the activity by highlighting the following. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

(30 minutes) 

Criteria for Assessment and evaluation 

• Names the advantages of computer networks.  

• Accepts the need for computer networks.    

• Uses Computer networks for communication purposes  

• Gives reasons to justify own ideas. 

• Enriches discussions through constructive comments.  

 

 

 

• Exchange of information is known as communication. 
• Data Communication involves the use of communication 

equipment to transfer coded data. 
• A network is a group of computers connected to each other. 
• The three components in a Computer Network are 

o Transmission Media 
o Network Stations and Interface adapters 
o Network Operating Systems 

• The three types of Computer Networks are 
o Local Area Networks (LAN) 
o Metropolitan Area Networks (MAN) 
o Wide Area Networks (WAN) 

• Some advantages of computer networks are  
o Connectivity and Communication 
o Data Sharing 
o Hardware Sharing 
o Data Security and Management 

• Disadvantages in computer networks are:  
o Saver faults stop applications being available. 
o Network faults can cause loss of data. 
o Network faults could lead to loss of resources 
o User work dependent upon network. 
o System open to hackers 
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                                                                                                            Annexe  2.5.1     
Reading material 

DATA COMMUNICATION AND NETWORKS 
What is communication?  Exchange of information between two or more parties is 
known as communication. 
Speech, written materials, signals and symbols are the day-to-day normal methods of 
communication. 
 
Basic requirements for a successful communication session: 

1. There should be two or more parties. 
2. There should be a common medium, which connects the parties involved. 
3. The use of common grounds 

 
These requirements are applicable to communication equipment (data communication) also.   
 
Data Communication 
The use of communication equipment to transfer coded data by telephone, telegraphs, or 
radio communication circuits etc. 

Introduction to Network 
A network is a group of computers and associated peripheral devices connected by 
communication channels capable of sharing files and other resources between several 
users.  
 
Components of a Computer Network 
1. Transmission Media 
2. Network Stations and Interface adapters 
3. Network Operating Systems 
4. Other Equipments 
 
1. Transmission Media  

The transmission of an electrical signal between two pieces of equipment requires the 
use of a transmission line.  

Twisted pair is the same type of cables as used by the telephone systems. 
• Inexpensive 
• Flexible 
• Immune to noise 

 
Coaxial Cables are a high-capacity cable used in networking. It contains an inner copper 
conductor surrounded by plastic insulation, and an outer braided copper or foil shield.  

• Free of external interference 
• High transmission rates 

 
Optical Fiber carries data in the form of a fluctuating beam of light in glass fiber. 

• High bit rates 
• High level of security 
• Very costly 
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Micro Wave  data is transferred by microwave beams. This medium has a very high 
bandwidth.  

• For satellite communication 
• Locations where it is impracticable to lay physical lines (hills etc.) 

The range of frequencies, that can be handled by equipment or a transmission link, is known 
as its Band Width 
 
2. Network Stations and Interface adapters 

• Workstation - In communication, any device attached to the network, other 

than the server. 

• File Server - Network computer used to store files for access by other 

client computers on the network. 

• Network interface card - The interface card is connected to the  network 

cabling which in turn connects all the network interface cards in the 

network. 

Client/ Server 
A computer system or process that requests a service of another computer system or 
process (a "server") using some kind of protocol and accepts the server's responses. A client 
is part of a client-server software architecture.  
For example, a workstation requesting the contents of a file from a file server is a client of 
the file server.  
 
3. Network Operating Systems 

NOS consist of two parts - The System software running on the file server & 
Running on each of the networked PCs. 
eg: Novell Netware, Windows NT 

4.Other Equipments 
Hub 
A device connected to several other devices 
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Modem 
 
 
 
 
 
              External Modem                     Internal Modem 
(Modulator/demodulator) An electronic device for converting between serial data from a 
computer and an audio signal suitable for transmission over a telephone line connected to 
another modem.  
 
 
Types of computer Networks 
 

1. LAN 
2. MAN 
3. WAN 
 

1. LAN (Local Area Networks)  
A LAN is two or more computers directly linked within a small well defined area such as a 
room, office building or university. A LAN can be made up of only microcomputers or any 
combination of microcomputers and large systems 

Intranet   
An intranet is a private network that is contained within an enterprise. It may consist of many 
interlinked local area networks and also uses leased lines in the wide area network 

 
2. MAN (Metropolitan Area Network) 
MAN connects users across large distances. This is ideal for any company or firm to link 
together their branches within a city.  

 
3. WAN (Wide Area Network) 
A network that connects users across large distances, and often crosses the geographical 
boundaries of cities or states. Ex: - To link computers in Colombo +and London 
 
Internet 
An internet is a group of networks connected together. The Internet refers to the global 
connection of networks around the world 
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The Advantages (Benefits) of Networking 

Here are some of the specific advantages generally associated with networking: 

o Connectivity and Communication: Networks connect computers and the users of 
those computers. Individuals within a building or work group can be connected into 
local area networks (LANs); LANs in distant locations can be interconnected into 
larger wide area networks (WANs). Once connected, it is possible for network users 
to communicate with each other.  

o Data Sharing: One of the most important uses of networking is to allow the sharing 
of data.  

o Hardware Sharing: Instead of giving each of 10 employees in a department an 
expensive color printer, one printer can be placed on the network for everyone to 
share.  

o Internet Access:  whenever you access the Internet, you are using a network.  

o Internet Access Sharing: Small computer networks allow multiple users to share a 
single Internet connection. Special hardware devices allow the bandwidth of the 
connection to be easily allocated to various individuals as they need it, and permit an 
organization to purchase one high-speed connection instead of many slower ones.  

o Data Security and Management: Data can be centralized on shared servers. This 
makes it easy for everyone to find the data, makes it possible for the administrators 
to ensure that the data is regularly backed up, and also allows for the implementation 
of security measures to control who can read or change various pieces of critical 
information.  

o Entertainment: The Internet itself offers many sources of entertainment, of course. 
In addition, many multi-player games exist that operate over a local area network. 
Many home networks are set up for this reason, and gaming across wide area 
networks (including the Internet) has also become quite popular. Of course, if you are 
running a business and have easily-amused employees, you might insist that this is 
really a disadvantage of networking and not an advantage!  

 
o Disadvantages of Networks 
1. Server faults stop applications being available. 
2. Network faults can cause loss of data. 
3. Network fault could lead to loss of resources. 
4. User work dependent upon network. 
5. System open to hackers. 
6. Decisions tend to become centralized. 
7. Could become inefficient. 
8. Could degrade in performances. 
9. Resources could be located too far from users. 
10. Network management can become difficult. 
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Annexe 2.5.2 
Instructions for the group exploration 

• Discuss with your group and define a network. 
• On the basis of the items assigned to you, find answers to the following 

 
Group Components of a network Types of networks 

1 Transmission Media 
 

Local Area Networks (LAN) 

2 Network Stations and interface adaptors 
 

Metropolitan Area Network (MAN) 

3 Network Operating Systems 
 

Wide Area Network (WAN) 

 
• Identify the main characteristics of the component to your group. 
• Name its major functions. 
• Try to define the network types assigned to your group. 
• Check to see whether it is Internet or Intranet. 
• Go through the reading material and compare the advantages and disadvantages of 

the networks. 
• Be prepared to present your findings at the plenary session. 
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Competency Level 3.1:  Uses the Binary number system to represent data in computer  
      systems.  

Activity 3.1   : Let’s investigate how the computer memory functions and how 

computers handle data. 

Time  :  60 Minutes 

Quality Input   :   ●  Four flash cards developed from the material in Annexe 3.1.1   

     ●  Three copies of Reading Material in Annexe 3.1.2 

  ●   A counting frame to denote the decimal number 125.  
Learning – teaching process: 

Step 3.1.1            :     ●  Display the flash cards, one at a time, to the class.  

     ●  Get students to name the items that they have seen. 

 ●    Let students arrange the beads on a counter frame to denote   

            the  decimal number 125.  

  ●  Lead a discussion to highlight the following.           

 

  

 
 
 
     

 

 

 

 

 

 

 

 

 

 

 
 

 

 
Competency 3 :  Investigates the methods used for data representation in  

       computer systems.  

• Flash cards carry the same information in different forms.  

• Human memory does not retain all types of information 

equally well. 

• Symbols, which are short and simple, are remembered 

easily when compared to other forms.  

• The computer uses the symbols 1 and 0 to represent 

current Flow and absence of Current Flow. 

• The number system used by the computer is made up of 1 

and 0. 

• The decimal number system is the most familiar number 

system. 

• The number 125 is a decimal number consisting of 1x100, 

2 x10, and 5x1. 

                                        
 125 

                           104 103 102 101  100 

                               1000 100 10   1 
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(15 minutes) 

 
 
 

 

(10 minutes) 

 
Step 3.1.2         : ●    Divide the class into three groups. 

  ● Distribute copies of the reading materials and group exploration 

instruction sheets to the groups. 

 ● Assign the three topics randomly among groups. 

  ● Provide groups with demy sheet and makers. 

  ● Involve the groups in the exploration. 

  ● Prepare them for a presentation.    

(30 minutes)  

 Step 3.1.3            :   ●    Get the groups to present their findings.  

●     Request constructive comments from other groups. 

   ●    Conclude the session by highlight the following. 

 

 

 

 

 

 

 

 

 

 

 

● Binary Number System 

o Base (B) is two. 

o The binary number system consists of two digits. 

o The formula to find the last digit is B-1 

o Each string of the counting frame can contain only one 

bead. 

o Each string has its own place value  

o The string from the rightmost string in the diagram. 

● Octal Number System 

o Base (B) is eight. 

o The number of the digits is eight. 

o Formula to find the last digit is B-1 

o Each string of the counting frame can contain only seven 

beads. 

o Each string has its own place value  

o The string from the rightmost string in the diagram. 

• This number has three place values.  

• The base value of this number system is 10 and it consists 

of ten digits ranging from 0 through 9. 

• Counting frame can be used to denote number 125. 



G.C.E.(O/L) IT Teacher Instructional Manual 
 

 
 

 
National Institute of Education- 2007 

 
98

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

(20 minutes) 

 

•  Hexadecimal Number System 

o Base (B) is sixteen. 

o Number of digits is sixteen. 

o Formula to find the last digits is B-1. 

o Each string of the counting frame can contain only fifteen 

         beads. 

o Each string has its own place value.  

o String from the rightmost string in the diagram. 

 

               

 

 
            106   105  104   103   102    101    100 

 

 
 
 
          27   26    25    24   23   22   21   20 

                64    32   16   8    4    2    1 

 
             
 
 
 
            87  86    85    84   83   82   81   80 
                               512  64  8    1     
 

           

 

        
          166 165 164 163 162  161 160 

                                   256  16   1 
• The Hexadecimal number System has six digits exceeding 9 

      These are represented by A,B,C,D,E,F  

 
 
 

Octal Number System 

Hexadecimal number 

Binary Number System

Decimal Number System 
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Criteria for Assessment and evaluation 

● Names the number system and describes them. 

● Accepts the value of number systems in representing the same data in various 

ways. 

● Denotes given numbers on the counting frame. 

● Demonstrates ability to think logically in different situations. 

● Draws diagrams to clarify an idea.    
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Annexe 3.1.1 
 

 
Material for developing flash cards 

 
               

IIIIIIIII IIIIIIIII IIIIIIIII 
IIIIIIIII IIIIIIIIII IIIIIIIII 
IIIIIIIII IIIIIIIII IIIIIIIII 
IIIIIIIII IIIIIIIII IIIIIIIII  
IIIII 

------------------------------- 

One hundred and twenty five 
---------------------------------- 

 

100+25 
-------------------------- 

125 
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Annexe 3.1.2 
 

Reading material I 
 

Use the counting frame to denote the number 125. 
 
 
 
 
 
 
 
 
 
 
 
        1000   100      10         1 
 
 
 
 
 
 
 
Decimal Number 125  
 
         5 x 1( 100 )   =   5     
    
         2 x 10( 101 ) =  20   
 
            1 x 100( 102 )=100  
           125 
 
 
All decimal numbers can be represented as above.  
 
Base Value of the decimal number system is 10. 
 
Digits of the decimal number are 0,1,2,3,4,5,6,7,8,9 
  
Place Values are 103, 102, 101, 100 or 1000, 100, 10, 1 
 
 
 
 
 
 
 

103       102      101      100 

Digits 

Place Value 

Digits 
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Instructions for the Group Exploration 

•    You will be working in three groups on the following three topics.  

o Binary Number System 

o Octal Number System 

o Hexadecimal Number System 

•  Go through the reading materials to become familiar with the decimal number     

    system given. 

•  Use the knowledge gained to find the answer to the following question on the basis 

of the number system assigned to your group. 

• What is the base of the Number System? 

• How many digits are there in the Number System? 

• What are they? 

• Develop the formula using the base to find out the last digits of the number  
 system. 
 
• Set up the counting frame to denote number 25. 
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Reading material-  2 
 

1. 25 
2. 45 
3. 12 
4. 65 
5. 37 

 

• Use the counting frame and denote the above numbers 

• Fill in the following table ( Fill in the column header ) 

 
Binary Number System 
 
 
 
 
 
 
 
 
 
 
 
Decimal 
number 

      Binary Number 
System 

        

        

        

        

        

        

        

 
 
Octal Number System 
 
 
 
 
 
 
 
 
 
  
 

24      23       22       21        20 

84      83       82       81        80 
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Decimal 
number 

      Octal Number 
System 

        

        

        

        

        

        

        

 
 
Hexadecimal Number System 
 
 
 
 
 
 
 
 
 
 
Decimal 
number 

      Hexadecimal 
Number System 

        

        

        

        

        

        

        

 
 
 
 

 

 

  

164    163     162     161     160 
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Competency Level 3.2:  Converts Decimal numbers into Binary, Octal and Hxadecimal  
Activity 3.2 :     Let’s have fun with number conversion.  

Time :     90 Minutes. 

Quality inputs :    •    Graded directions on number conversion  in Annexe 3.2.1  

                                   •    Three copies of the group exploration instructions in Annexe 3.2.2 

Learning – Teaching Process: 

Step 3.2.1 :    •    Display to the class the following two counting frames that   
 denote number 13.        

                                           

 

 

 

 

 

 

 

                                      100               10                  1            8             4             2           1 

 

                                   •   Get the class to identify the number denoted and explain same.  

•   Conduct a discussion to highlight the following. 

 

 

 

 

 

 
 

 

• Counting frame 1 denotes the decimal number 13.  

• Counting frame 2 denotes 13 in binary numbers. 

• The same number can be represented in both number 

systems. 

• Base values of binary and decimal number systems are 2 and 

10, respectively. 

• The maximum number of balls possible on one bar of counting 

frame1 is 9 while this is 1 on counting frame 2. 

1 2 

 
Competency 3 :  Investigates the methods used for data representation 

in computer systems. 
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Step 4.2.2 :    •    Divide the class into three groups.    

•  Distribute copies of group exploration instructions and Graded 

Directions to the  groups. 

  •  Involve the groups in the assignment. 

  •    Prepare them for presentations at the plenary session. 

(40 minutes) 

Step 4.2.3 :   •    Get groups to present their completed grids. 

•     Request others to submit constructive comments.  

•     Conclude activity highlighting the following. 

 

 

 

 

 

 

 

 

(30 minutes) 

Criteria for Assessment and evaluation 

● Describes the methods used in converting numbers from one number system to 

   another.  

● Accepts the need to convert numbers in the decimal number system to other number 

   systems, in computing.  

● Converts decimal numbers to binary, octal and hexadecimal. 

● Presents ideas with confidence. 

● Demonstrates ability to represent information in different forms. 

 

 

 

• Conversion facilitates human action in terms of representation. 

●    A set of rules have to be followed in converting a number from   

one system to another. 

• A standard procedure is available to present the digits of the       

converted number. 

•   The topmost column headings of the grid denote place values 

while the second column denotes the same in a different form. 

•   A grid enables a number conversion to be accomplished 

without division. 
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Annexe 3.2.1 

Graded Directions for Number Conversion 
 
Decimal to Binary 
Mainly there are two methods for converting decimal numbers to binary. These are repeated 

division by 2, and repeated subtraction by the weighted position value. 

 
Repeated Division By 2 
 
In this method we divide the decimal number by 2.  If the remainder is 0, on the side we write 
down 0. If the remainder is 1, we write down 1. This process is continued by dividing the 
quotient by 2 and dropping the previous remainder until the quotient is 0. The table below 
indicates how a binary number is derived for 2671. Note the start and the sequence of the 12 
digits 1010 0110 1111. The Leftmost digit is called the Most Significant Digit (MSD) and the 
rightmost digit is called the Least Significant Digit (LSD). 

Division Quotient Remainder Binary Number 

2671 / 2 1335 1 1 

1335 / 2 667 1 11 

667 / 2 333 1 111 

333 / 2 166 1 1111 

166 / 2 83 0 0 1111 

83 / 2 41 1 10 1111 

41 / 2 20 1 110 1111 

20 / 2 10 0 0110 1111 

10 / 2 5 0 0 0110 1111 

5 / 2 2 1 10 0110 1111 

2 / 2 1 0 010 0110 1111 

1 / 2 0 1 1010 0110 1111 

 

Decimal to Octal  
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Converting decimal numbers to octal is slightly more difficult. The typical method for this is 

repeated division by 8. Although repeated subtraction by the weighted position value 

provides another method, this is difficult for large decimal numbers. 

Repeated Division By 8 

In this method we first divide the decimal number by 8, and write the remainder on the side. 

This becomes the least significant digit in the octal number finally obtained. The process is 

continued by dividing the quotient by 8 and writing the remainder until the quotient is 0.  

When performing the division, the remainders which represent the octal equivalent of the 

decimal number are written from the right to left beginning with the least significant digit and 

moving gradually to reach the most significant digit. The table below shows how the decimal 

number 44978 is converted to octal. 

Division Quotient Remainder Octal Number 

44978 / 8 5622 2 2 

5622 / 8 702 6 62 

702 / 8 87 6 662 

87 / 8 10 7 7662 

10 / 8 1 2 27662 

1 / 8 0 1 127662 

 

 

 

Decimal to Hexadecimal 

Converting decimal numbers to hexadecimal is even more difficult. The typical method used 

for this is repeated division by 16. While we may also use repeated subtraction by the 

weighted position value, it is more difficult with large decimal numbers. 
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Repeated Division By 16 

In this method, we begin by dividing the decimal number by 16. We write the remainder on 

the side as the least significant digit. The quotient is divided by 16 and the process is 

continued until the quotient is 0. When performing the division, the remainders that represent 

the hexadecimal equivalent of the decimal number are written beginning at the least 

significant digit (right) and each new digit is written to the next more significant digit (the left) 

of the previous digit. Consider the number 44978. 

Division Quotient Remainder Hex Number 

44978 / 16 2811 2 2 

2811 / 16 175 11 B2 

175 / 16 10 15 FB2 

10 / 16 0 10 0AFB2 

 

 

 
 



G.C.E.(O/L) IT Teacher Instructional Manual 
 

 
 

 
National Institute of Education- 2007 

 
110

Annexe 3.2.2 
Instructions for the group exploration 

 
• You will be working in three groups with the following three conversions assigned 

to the three groups. 

o Decimal to binary 

o Decimal to octal 

o Decimal to hexadecimal 

• Go through the reading material to identify the methods available for the 

conversion assigned to your group. 

• Identify the grid relevant to your conversion and note with the column headings. 

• Try to complete the grid following the division method. 

• Identify the advantages of using the grid for the purpose. 

• Be prepared to explain the process that you adopted, to the whole class, at the 

plenary session. 

 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Powers of 2 27 26 25 24 23 22 21 20

Decimal 128 64 32 16  8  4  2  1 
TOTAL 

        1 

        3 
        14 
        177 
        180 
        255 
        128 

Binary 
number 

        129 

1.
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Powers of 8 84 83 82 81 80 

Decimal 4096  512   64   8  1 
TOTAL 

     1 

     3 
     14 
     177 
     180 
     255 
     579 

Octal 
number 

     4617 

Powers of 16 163 162 161 160 

Decimal  4096   256   16   1  
TOTAL 

    1 

    3 
    14 
    177 
    180 
    256 
    1000 

Hexadecimal 
number 

    4617 

2.

3.
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Competency Level 3.3 : Converts Binary numbers into Decimal, Octal and   

   Hexadecimal  numbers and vice versa 

Activity 3.3 :     Let’s have fun with number conversion.  

Time :     90 Minutes. 

Quality inputs :    •    Graded directions on number conversion in Annexe 3.3.1  

                                   •    Three copies of the group exploration instructions in Annexe 3.3.2 

Learning – Teaching Process: 

Step 3.3.1 :    •    Display to the class the following two counting frames that   
 denote number 13.        

                                           

 

 

 

 

 

 

 

                                      100               10                  1            8             4             2           1 

 

                                   •   Get the class to identify the number denoted and explain.  

•   Conduct a discussion to highlight the following. 

 

 

 

 

 

 
 

• Counting frame 1 denotes the decimal number 13.  

• Counting frame 2 denotes 13 in binary numbers. 

• The same number can be represented in both number 

systems. 

• Base values of binary and decimal number systems are 2 and 

10, respectively. 

• The maximum number of balls possible on one bar of counting 

frame1 is 9 while this is 1 on counting frame 2. 

1 2 

 
Competency 3 :  Investigates the methods used for data representation in 

computer systems.
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(20 minutes) 

 

Step 3.3.2 :    •    Divide the class into three groups.    

      •    Distribute copies of group exploration instruction and Graded 

                  Directions to the groups. 

  •  Involve the groups in the exploration. 

  •  Prepare them for presentations at the plenary session. 

(40 minutes) 

Step 3.3.3 :    •    Get groups to present their completed grids. 

•  Request others to submit constructive comments.  

•    Conclude activity highlighting the following. 

 

 

 

 

 

 

 

 

(30 minutes) 

Criteria for Assessment and evaluation 

● Describes the methods used in converting numbers from one number 

system to another.  

● Accepts the need to convert numbers in the decimal number system 

to other number systems, in computing.  

● Converts decimal numbers to binary, octal and hexadecimal. 

● Presents ideas with confidence. 

● Demonstrates ability to represent information in different forms. 

 
 

 

• Conversion facilitates human action in terms of representation. 

●    A set of rules have to be followed in converting a number from   

one system to another. 

• A standard procedure is available to present the digits of the       

converted number. 

•   The topmost column headings of the grid denote place values 

while the second column denotes the same in a different form. 

•   A grid enables a number conversion to be accomplished 

without division.
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Annexe 3.3.1 

Graded Directions for Number Conversion 
Decimal to Binary 
Mainly there are two methods for converting decimal numbers to binary. These are repeated 

division by 2, and repeated subtraction by the weighted position value. 

 
Repeated Division By 2 
 
In this method we divide the decimal number by 2.  If the remainder is 0, on the side we write 
down 0. If the remainder is 1, we write down 1. This process is continued by dividing the 
quotient by 2 and dropping the previous remainder until the quotient is 0. The table below 
indicates how a binary number is derived for 2671. Note the start and the sequence of the 12 
digits 1010 0110 1111. The Leftmost digit is called the Most Significant Digit (MSD) and the 
rightmost digit is called the Least Significant Digit (LSD). 
 

Division Quotient Remainder Binary Number 

2671 / 2 1335 1 1 

1335 / 2 667 1 11 

667 / 2 333 1 111 

333 / 2 166 1 1111 

166 / 2 83 0 0 1111 

83 / 2 41 1 10 1111 

41 / 2 20 1 110 1111 

20 / 2 10 0 0110 1111 

10 / 2 5 0 0 0110 1111 

5 / 2 2 1 10 0110 1111 

2 / 2 1 0 010 0110 1111 

1 / 2 0 1 1010 0110 1111 

 



G.C.E.(O/L) IT Teacher Instructional Manual 
 

 
 

 
National Institute of Education- 2007 

 
115

Decimal to Octal  

Converting decimal numbers to octal is slightly more difficult. The typical method for this is 

repeated division by 8. Although repeated subtraction by the weighted position value 

provides another method, this is difficult for large decimal numbers. 

Repeated Division By 8 

In this method we first divide the decimal number by 8, and write the remainder on the side. 

This becomes the least significant digit in the octal number finally obtained. The process is 

continued by dividing the quotient by 8 and writing the remainder until the quotient is 0.  

When performing the division, the remainders which represent the octal equivalent of the 

decimal number are written from the right to left beginning with the least significant digit and 

moving gradually to reach the most significant digit. The table below shows how the decimal 

number 44978 is converted to octal. 

Division Quotient Remainder Octal Number 

44978 / 8 5622 2 2 

5622 / 8 702 6 62 

702 / 8 87 6 662 

87 / 8 10 7 7662 

10 / 8 1 2 27662 

1 / 8 0 1 127662 

 

Decimal to Hexadecimal 

Converting decimal numbers to hexadecimal is even more difficult. The typical method used 

for this is repeated division by 16. While we may also use repeated subtraction by the 

weighted position value, it is more difficult for large decimal numbers. 
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Repeated Division By 16 

In this method, we begin by dividing the decimal number by 16. We write the remainder on 

the side as the least significant digit. The quotient is divided by 16 and the process is 

continued until the quotient is 0. When performing the division, the remainders that represent 

the hexadecimal equivalent of the decimal number are written beginning at the least 

significant digit (right) and each new digit is written to the next more significant digit (the left) 

of the previous digit. Consider the number 44978. 

Division Quotient Remainder Hex Number 

44978 / 16 2811 2 2 

2811 / 16 175 11 B2 

175 / 16 10 15 FB2 

10 / 16 0 10 0AFB2 
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Annexe 3.3.2 

Instructions for the Group Exploration 
 
• You will be working in three groups with the following three conversions assigned to 

the three groups. 

o Decimal to binary 

o Decimal to octal 

o Decimal to hexadecimal 

• Go through the reading material to identify the methods available for the conversion 

assigned to your group. 

• Identify the grid relevant to your conversion and become familiar with the column 

headings. 

• Try to complete the grid following the division method. 

• Identify the advantages of using the grid for the purpose. 

• Be prepared to explain the process that you adopted, to the whole class, at the plenary 

session. 

 
 
1. 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 

Powers of 2 27 26 25 24 23 22 21 20

Decimal 128 64 32 16  8  4  2  1 
TOTAL 

        1 
        3 
        14 
        177 
        180 
        255 
        128 

Binary 
number 

        129 
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2 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 

3. 
 
 
 
 
 
 
 

 
 
 
 

Powers of 8 84 83 82 81 80

Decimal 4096  512  64  8  1 
TOTAL

     1 
     3 
     14 
     177 
     180 
     255 
     579 

Octal 
number 

     4617 

Powers of 16 163 162 161 160

Decimal  4096  256  16  1  
TOTAL

    1 
    3 
    14 
    177 
    180 
    256 
    1000 

Hexadecimal
number 

    4617 
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Competency Level 3.4 :  Determines the capacity of computers in terms of data  
         storage  
 
Activity 3.4 :    Let’s measure data storage 

Time  :    90 Minutes 

Quality Input  :    •    Reading materials.on measuring units. in Annexe 3.4.1 

       •    Four copies of group exploration instruction in Annexe 3.4.2 

Learning – Teaching Process:  

Step 3.4.1 :   •   Display the two diagrams in Annexe 3.4.1 to the class  

• Get students to match the two sets in Annexe 3.4.1 

• Ask students how and why they match 

• What is the measuring unit of the capacity of a digital device? 

• What is a byte? 

• Conduct a discussion to highlight the following.  

 

 

 

 

 

 

 

(20 minuets) 

• Most things have measurable features 

• Measuring units are used to measure them. 

• Measuring units have multiples and sub-divisions.  

• The measuring unit “byte” is used to measure the storage 

capacity of digital devices. 

• A byte consist of eight places in binary digits (bits) 

• The combination of two bytes is called a “word”. 

• Half a byte (4 bits) is called a “bin“ 

 
 Competency 3 :  Investigates the methods used for data representation in 

computer systems. 
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Step 3.4.2 :    •    Divide the whole class into four groups  

  • Distribute graded directions  and group exploration instruction to 

each group  

 • Lead them to read the graded directions and identify byte, sub 

division of byte and multiples of byte.  

  • Ask students to go through the graded directions and trace the 

specifications in the assignment using the computer that he/she is 

working with. 

  • Ask the students to list out how performance increases as the 

capacity increases in digital devices  

  • Ask each group to complete the assignment. 

(40 minutes) 

Step 3.4.3 :    •   Let each group present its experiences.  

•    Conduct discussion to highlight the following 

 

 

 

 

 

 

 

 

 

 
 
 
 
 

 

(30 minutes) 

 

• Byte is the measuring unit of the capacity of digital devices. 

• A byte consists of 8 bits. A word consists of 2 bytes 

  8 bits = 1 byte 

  2 bytes  = 1 word 

• Multiples of byte as follows 

1,024 bytes  = 1 kilobyte 

1,024 kilobytes  = 1 megabyte 

1,024 megabytes = 1 gigabyte 

1,024 gigabytes  = 1 terabyte  

• We can check the Capacity of Some devices on the computer  

Capacity of RAM  

Capacity of VGA 

Capacity of hard disk 

Capacity of removable disks 

• There are digital devices with a variety of capacities in the 

market.  
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Criteria for Assessment and evaluation 

• Describes the multiples of bytes and their decimal representations.   

• Accepts the existence of different storage devices of different sizes. 

• Distinguishes between the performance of digital devices according to their storage 

      capacity. 

• Chooses a suitable device of appropriate size for activities in day to day life 

• Works co-operatively in-group. 
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Annexe 3.4.1 

Reading Material  
• Byte is the measuring unit of the capacity of digital devices. 

• A byte consists of 8 binary digits (bit). A word consists of 2 bytes 

8 bits   = 1 byte 

2 bytes    = 1 word 

• Multiples of byte: 

1,024 bytes   = 1 kilobyte 

1,024 kilobytes   = 1 megabyte 

1,024 megabytes = 1 gigabyte 

1,024 gigabytes   = 1 terabyte  

Two Different Systems of Measurement  

Name Abbreviation Binary 
Power 

Binary Value 
(represented in 
Decimal) 

Decimal 
Power 

Decimal 
(Equivalent) 

kilobyte Kbyte 210 1,024 103 1,000 

megabyte Mbyte 220 1,048,576 106 1,000,000 

gigabyte Gbyte 230 1,073,741,824 109 1,000,000,000 

terabyte Tbyte 240 1,099,511,627,776 1012 1,000,000,000,000 

 

Name Abbr. Size 

Kilo K 2^10 = 1,024 

Mega M 2^20 = 1,048,576 

Giga G 2^30 = 1,073,741,824 

Tera T 2^40 = 1,099,511,627,776 

Peta P 2^50 = 1,125,899,906,842,624 

Exa E 2^60 = 1,152,921,504,606,846,976 

Zetta Z 2^70 = 1,180,591,620,717,411,303,424 

Yotta Y 2^80 = 1,208,925,819,614,629,174,706,176  

 

• We can find the Capacity of RAM on a computer by going through the following steps. 
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      Capacity of RAM 

o C:\ windows \ system32 \direct x 

o Control panel system general 

 

• We can find the Capacity of VGA on a computer by going through the following steps. 

      Capacity of VGA 

o Display properties settings advanced adopter 

o C windows  system32 direct x 

 

 

• We can find the Capacity of the hard disk on a computer by going through the following 

steps. 

      Capacity of hard disk 

o My computer select drive click file properties 

o C:\ windows \ system32 \direct x  

• We can find the Capacity of removable disks on a computer by going through the 

following steps. 

      Capacity of removable disks 

      Insert disk in to drive 

o My computer - select drive - click file - properties 

o C windows  -  system32 - direct x 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 



G.C.E.(O/L) IT Teacher Instructional Manual 
 

 
 

 
National Institute of Education- 2007 

 
124

Annexe 3.4.2 

Assignment 1 
 

1. Match the features in A with the units in  B  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Assignment 2 
 

1. Find the storage capacity of the hard disk on your computer. 
2. List the storage capacity of hard disks available. 
3. Write two advantages of high hard disk capacity. (provided other hardware  

specifications are of high standard, only) 
 

Assignment 3 
 

1. Find the RAM size of your computer. 
2. List RAM sizes available. 
3. Write two advantages of high RAM size.  (Provided other hardware specifications are 

of high standard, only) 
 

 
Assignment 4 
 

1. Find the VGA size of your computer. 
2. List VGA sizes available. 
3. Write two advantages of high VGA size.  (Provided other hardware specifications are 

of high standard, only) 
 
Assignment 5 
 

1. Find the storage capacity of removable devices of your computer. 
2. List the storage capacities of removable devices (floppy disks, CD, Flash drive) 

available. 
3. Write two advantages, when the hard disk capacity is high. (if other hardware  

specifications are of high standard only) 
 

A 

Weight 

Volume 

Distance 

Time 

Temperature 

Storage capacity of electronic device 

 

B 

Degrees of Celsius 

gram  

Meter 

Byte 

Second 

Liter 

Celsius  
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Competency Level 3.5:  Uses coding systems in Computers   
                    
Activity 3.5 :   Let’s learn the different codes used in computer systems. 

Time :   90 minutes. 

Quality inputs : • Three copies Reading materials in Annexe 3.5.1  

                              •    Three copies of the group exploration instructions in  

         Annexe 3.5.2 

 

Learning – Teaching Process: 

Step 3.5.1 :    •    Displayed below is, the code for “Codes used in computer”   

     in numeric when the letters of the alphabet are numbered in   

        order. 

                                           3 15 4 5 19      21 19 5 4     9 14     3 15 13 16 21 20 5 18 

  •   Get the class to identify the text relevant to the above codes.  

  •   Conduct a discussion to highlight the following. 

 

 

(15 minutes) 

Step 3.5.2 : • Divide the class into three groups.    

  • Distribute copies of group exploration instructions and reading 

             material among the groups. 

  • Involve the groups in the exploration. 

  • Prepare them for presentation at the plenary session. 

(40 minutes) 

Step 3.5.3 : • Get groups to present their findings. 

  •  Request others to submit constructive comments.  

 •  Conclude the activity by highlighting the following. 

 

• Information can be represented in codes   

• To represent data the computer uses only two symbols. 

 
Competency 3 :  Investigates the methods used for data representation in 

computer systems. 
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(35 minutes) 

Criteria for Assessment and evaluation 

• Describes the methods used for converting characters to ASCII, EBCDIC and       

   decimal numbers to BCD.  

• Accepts the need for coding systems employed in computers.    

• Converts characters to ASCII, EBCDIC and decimal numbers to BCD. 

• Expresses one’s own ideas in different forms.    

• Uses simple ways to perform complicated task. 

 

•   The most common coding system is ASCII 

      (Pronounced ass-key) 

•    ASCII stands for American National Standard Code for  

      Information Interchange 

•    In ASCII 

o Each character is coded as a byte 

o 7-bit code 

o 8th bit is unused 

o 27 = 128 codes 

•    EBCDIC stands for Extended BCD Interchange Code 

     (pronounced ebb’-se-dick)   

•    EBCDIC is 

o 8-bit code 

o Developed by IBM 

o Used for IBM mainframes only 

•    BCD stands for Binary-Coded Decimal. 

•    BCD is a system for storing decimal numbers in binary form. 

     •    To convert a decimal number to BCD each digit of the 

          decimal number is converted to a 4 bit binary number.   
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Anexe 3.5.1 

Reading Material  

Coding systems are employed by computers in order to represent various characters, 

numbers, and control keys that the computer user selects on the keyboard. Three of the 

more popular coding systems are:  

1. ASCII (American Standard Code for Information Interchange)  

2. EBCDIC (Extended Binary Coded Decimal Interchange Code)  

3. BCD (Binary Coded Decimal) 

They differ in how many digits or bits they use to represent a character.  

In each system the character or number is represented by a sequence of binary digits which 

can only have the values 0 or 1. The ASCII system uses seven 0 or 1 digits or bits to 

represent the letters of the alphabet, while EBCDIC uses eight bits. BCD uses four bits to 

represent the numbers 0 to 9. 

 

ASCII (American Standard Code for Information Interchange)  

ASCII (pronounced "askee") is the short form for American Standard Code for Information 

Interchange. ASCII is a standard developed by the American National Standards Institute 

(ANSI)to define computer intelligible values for characters used in text.  

The ASCII set of 128 characters includes upper and lower case letters of the English 

alphabet, numbers, punctuation marks, and 33 control codes (such as tab, bell , carriage 

return.) ASCII uses 7 bits to represent each character. You may see ASCII characters 

identified by a decimal number from 0 to 127. 65, for example, identifies uppercase A; 122 is 

lowercase z. Alternatively, you may see hexadecimal numbers used. In this system A is 41, 

z is 7A. The ASCII coded set is the one used by most operating systems.  

ASCII 
7 bit 

1000001 = A 
1000010 = B 
1000011 = C 
1000100 = D 
1000101 = E 

etc. 
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EBCDIC (Extended Binary Coded Decimal Interchange Code)  
EBCDIC (generally pronounced "Ebb see Dick") is the character encoding scheme used by 

IBM mainframe systems since the 1960s. In that decade it lost to ASCII a competition to 

become the official national standard. EBCDIC uses an 8-bit character set whose code 

values are entirely different from those of ASCII.  

 
EBCDIC 

8 bit 
11000001 = A 
11000010 = B 
11000011 = C 
11000100 = D 
11000101 = E 

etc. 
 
 
 
 

ASCII  
Hex 

 
Symbol 

0 
1 
2 
3 
4 
5 
6 
7 
8 
9 

10 
11 
12 
13 
14 
15 

0 
1 
2 
3 
4 
5 
6 
7 
8 
9 
A 
B 
C 
D 
E 
F 

NUL 
SOH 
STX 
ETX 
EOT 
ENQ 
ACK 
BEL 
BS 

TAB 
LF 
VT 
FF 
CR 
SO 
SI 

 
ASCII 

 
Hex 

 
Symbol

16 
17 
18 
19 
20 
21 
22 
23 
24 
25 
26 
27 
28 
29 
30 
31 

10 
11 
12 
13 
14 
15 
16 
17 
18 
19 
1A 
1B 
1C 
1D 
1E 
1F 

DLE 
DC1 
DC2 
DC3 
DC4 
NAK 
SYN 
ETB 
CAN 
EM 
SUB 
ESC 
FS 
GS 
RS 
US 

 
ASCII 

 
Hex 

 
Symbol

32 
33 
34 
35 
36 
37 
38 
39 
40 
41 
42 
43 
44 
45 
46 
47 

20 
21 
22 
23 
24 
25 
26 
27 
28 
29 
2A 
2B 
2C 
2D 
2E 
2F 

(space)
! 
" 
# 
$ 
% 
& 
' 
( 
) 
* 
+ 
, 
- 
. 
/ 

ASCII  
Hex 

 
Symbol 

48 
49 
50 
51 
52 
53 
54 
55 
56 
57 
58 
59 
60 
61 
62 
63 

30 
31 
32 
33 
34 
35 
36 
37 
38 
39 
3A 
3B 
3C 
3D 
3E 
3F 

0 
1 
2 
3 
4 
5 
6 
7 
8 
9 
: 
; 
< 
= 
> 
? 

ASCII  
Hex 

 
Symbol 

64 
65 
66 
67 
68 
69 
70 
71 
72 
73 
74 
75 
76 
77 
78 
79 

40 
41 
42 
43 
44 
45 
46 
47 
48 
49 
4A 
4B 
4C 
4D 
4E 
4F 

@ 
A 
B 
C 
D 
E 
F 
G 
H 
I 
J 
K 
L 
M 
N 
O 

ASCII  
Hex 

 
Symbol

80 
81 
82 
83 
84 
85 
86 
87 
88 
89 
90 
91 
92 
93 
94 
95 

50 
51 
52 
53 
54 
55 
56 
57 
58 
59 
5A 
5B 
5C 
5D 
5E 
5F 

P 
Q 
R 
S 
T 
U 
V 
W 
X 
Y 
Z 
[ 
\ 
] 
^ 
_ 

ASCII  
Hex 

 
Symbol

96 
97 
98 
99 

100 
101 
102 
103 
104 
105 
106 
107 
108 
109 
110 
111 

60 
61 
62 
63 
64 
65 
66 
67 
68 
69 
6A 
6B 
6C 
6D 
6E 
6F 

` 
a 
b 
c 
d 
e 
f 
g 
h 
i 
j 
k 
l 

m 
n 
o 

ASCII  
Hex 

 
Symbol 

112 
113 
114 
115 
116 
117 
118 
119 
120 
121 
122 
123 
124 
125 
126 
127 

70 
71 
72 
73 
74 
75 
76 
77 
78 
79 
7A 
7B 
7C 
7D 
7E 
7F 

p 
q 
r 
s 
t 
u 
v 
w 
x 
y 
z 
{ 
| 
} 
~ 
�  
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Dec Hex Code Dec Hex Code Dec Hex Code Dec Hex Code

0 00 NUL 32 20   64 40 space 96 60 - 
1 01 SOH 33 21   65 41   97 61 / 
2 02 STX 34 22   66 42   98 62   
3 03 ETX 35 23   67 43   99 63   
4 04   36 24   68 44   100 64   
5 05 HT 37 25 LF 69 45   101 65   
6 06   38 26 ETB 70 46   102 66   
7 07 DEL 39 27 ESC 71 47   103 67   
8 08   40 28   72 48   104 68   
9 09   41 29   73 49   105 69   
10 0A   42 2A   74 4A [ 106 6A | 
11 0B VT 43 2B   75 4B . 107 6B , 
12 0C FF 44 2C   76 4C < 108 6C % 
13 0D CR 45 2D ENQ 77 4D ( 109 6D _ 
14 0E SO 46 2E ACK 78 4E + 110 6E > 
15 0F SI 47 2F BEL 79 4F | ! 111 6F ? 
16 10 DLE 48 30   80 50 & 112 70   
17 11   49 31   81 51   113 71   
18 12   50 32 SYN 82 52   114 72   
19 13   51 33   83 53   115 73   
20 14   52 34   84 54   116 74   
21 15   53 35   85 55   117 75   
22 16 BS 54 36   86 56   118 76   
23 17   55 37 EOT 87 57   119 77   
24 18 CAN 56 38   88 58   120 78   
25 19 EM 57 39   89 59   121 79 ‘ 
26 1A   58 3A   90 5A ! ] 122 7A : 
27 1B   59 3B   91 5B $ 123 7B # 
28 1C IFS 60 3C   92 5C * 124 7C @ 
29 1D IGS 61 3D NAK 93 5D ) 125 7D ‘ 
30 1E IRS 62 3E   94 5E ; 126 7E = 
31 1F IUS 63 3F SUB 95 5F ^ 127 7F " 

 
 
 
 
 



G.C.E.(O/L) IT Teacher Instructional Manual 
 

 
 

 
National Institute of Education- 2007 

 
130

 
 

Dec Hex Code Dec Hex Code Dec Hex Code Dec Hex Code
128 80   160 A0   192 C0 { 224 E0 \ 
129 81 a 161 A1 ~ 193 C1 A 225 E1   
130 82 b 162 A2 s 194 C2 B 226 E2 S 
131 83 c 163 A3 t 195 C3 C 227 E3 T 
132 84 d 164 A4 u 196 C4 D 228 E4 U 
133 85 e 165 A5 v 197 C5 E 229 E5 V 
134 86 f 166 A6 w 198 C6 F 230 E6 W 
135 87 g 167 A7 x 199 C7 G 231 E7 X 
136 88 h 168 A8 y 200 C8 H 232 E8 Y 
137 89 i 169 A9 z 201 C9 I 233 E9 Z 
138 8A   170 AA   202 CA   234 EA   
139 8B   171 AB   203 CB   235 EB   
140 8C   172 AC   204 CC   236 EC   
141 8D   173 AD   205 CD   237 ED   
142 8E   174 AE   206 CE   238 EE   
143 8F   175 AF   207 CF   239 EF   
144 90   176 B0   208 D0 } 240 F0 0 
145 91 j 177 B1   209 D1 J 241 F1 1 
146 92 k 178 B2   210 D2 K 242 F2 2 
147 93 l 179 B3   211 D3 L 243 F3 3 
148 94 m 180 B4   212 D4 M 244 F4 4 
149 95 n 181 B5   213 D5 N 245 F5 5 
150 96 o 182 B6   214 D6 O 246 F6 6 
151 97 p 183 B7   215 D7 P 247 F7 7 
152 98 q 184 B8   216 D8 Q 248 F8 8 
153 99 r 185 B9   217 D9 R 249 F9 9 
154 9A   186 BA   218 DA   250 FA   
155 9B   187 BB   219 DB   251 FB   
156 9C   188 BC   220 DC   252 FC   
157 9D   189 BD   221 DD   253 FD   
158 9E   190 BE   222 DE   254 FE   
159 9F   191 BF   223 DF   255 FF   
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BCD (Binary Coded Decimal) 

BCD is a system for storing decimal numbers in binary form. Each digit of the decimal 

number is converted to a 4 bit binary number:  

Decimal 0 1 2 3 4 5 6 7 8 9 

BCD 0000 0001 0010 0011 0100 0101 0110 0111 1000 1001 

All numbers in decimal can be represented in BCD with four bits that can easily represent 

numbers from 0 to 9. 

For example: To represent the decimal number 312 in BCD form:  

 

Decimal 3 1 2 

BCD 0011 0001 0010 

Note: Each digit of the decimal number (3,1,2) is separately converted to a binary number 

instead of converting the number 312 as a whole to the binary number 100111000. 
You can see that the pure binary number takes up 9 bits while the three BCD numbers take 

up 12 bits, requiring more computer memory space. 
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Annexe 3.5.2 
Instructions for the group exploration 

• You will be working in three groups with the three group exploration instruction 

related to the following coding systems employed in computers. 

o ASCII 

o EBCDIC 

o BCD 

• Go through the reading material to identify the methods available for the group 

exploration instruction assigned to your group. 

• Be prepared to explain the process that you adapted, to the whole class, at the 

plenary session. 
 

1. Write the ASCII code to represent text strings “Hello, world”. 

2. How do you represent text string “Hello, world” in EBCDIC code? 

3. a. What are the bit patterns not used in the 4 bit BCD coding system? 

b. Convert the following decimal numbers to BCD. 

1) 321  

2) 564  

3) 9082  

4) 7093  

5)  2857 
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Competency Level 4.1:  Identifies basic logic operators and draws truth tables to  
      illustrate their functions  

Activity 4.1  :   Let’s draw truth tables for basic logic operators. 

Time  :    90 minutes  

Quality inputs : • A demy sheet  containing the two circuits in Annexe 4.1.1 
  • Four copies of reading material in Annexe 4.1.2 

                              •    Four copies of group exploration instructions in Annexe 4.1.3.   

Learning – Teaching Process: 

Step 4.1.1 :    •    Expose the two circuits on demy sheet to the class. 

  •   Get students to discuss how the bulb lights up in relation to the on 

/ off positions of the switches. 

  •   Conduct discussion to highlight the following. 

 

 

 

 

 

 

 

                  (15minutes)         

  Step 4.1.2 : •   Divide class into four groups.    

  • Distribute the group exploration instructions and reading material 

among the four groups     

 • Involve groups in the exploration.  

  • Prepare groups for a presentation at the plenary. 
        (50 minutes) 

• The two diagrams represent the two types of circuits -parallel 

and series   

•   In series circuits the bulb lights only if switches A and B are     

     in “on” position 

• In parallel circuits the bulb lights when either switch A or B  or 

both A and B are in the “on” position: 

• These two circuits illustrate the two logical operations in     

     computers 

 
Competency 4 :  Uses Boolean Algebra to work effectively with logic gates 
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Step 4.1.3 : • Get each group to present its findings. 

• Request the presenters themselves to fill gaps, if any. 

• Seek for constructive comments of other groups  

  •  Conclude the session by highlighting the following.  

  

 

 

 

 

 

 

 

 

 

 

 
(25 Minutes) 

 
 
Criteria for assessment and evaluation 
 

• Names and describes the basic logical operations  

• Accepts the need to combine different operations appropriately in designing simple     

      circuits to meet user needs  

• Develops truth tables using different input combinations to arrive at the desired 

      output.    

• Uses reading as a tool for self-learning.   

• Demonstrates ability to think logically. 

 
 
 

•    The AND operations gives an output 1 only if all the inputs 

are 1.  The output will be 0 if any one of the inputs is 0. 

•    The OR operation gives the output 1 if any input is one. 

•    In an OR operation, If all the inputs are 0 then the output will  

be 0. 

•    The NOT operation gives the inverse of the input, that is, if 

the input is 0, the output is 1 and vice versa. 

•    A Truth table is a graphical representation, which shows how 

a logic circuit responds to various combinations of inputs 

using 1 for true and 0 for false. 

•    In a truth table if there are two inputs there will be four 

combinations and if there are three inputs there will be eight 

combinations. 
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Annexe 4.1.1 
Figure 1 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 2 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Bulb 

Switch A 

Switch B 

Switch A Switch B Bulb 

Battery 

Battery 
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Annexe 4.1.2 

Everything in the digital world is based on the binary number system. Numerically, this 
involves only two symbols: 0 and 1. Logically, we can use these symbols or we can equate 
them with others according to the needs of the moment. Thus, when dealing with digital 
logic, we can specify that: 

0 = false = no  
1 = true  = yes 

Using this two-valued logic system, every statement or condition must be either "true" or 
"false;" it cannot be partly true and partly false.  

One essential reason for basing logical operations on the binary number system is that it is 
easy to design simple, stable electronic circuits that can switch back and forth between two 
clearly-defined states.  

Some common representations of 0 and 1 are shown in the following diagram. 

Logic 0 Logic 1 
False True 
Off On 
Low  High 
No Yes 
Open Switch Close Switch 

 

Truth Tables 

In algebra, it is rarely possible to guess the numerical solution to a problem, and because 
there are an infinite number of numbers it is obvious that one cannot try all possible solutions 
in order to find one that solves the problem. But in logic, we only have two "numbers": True 
and False. Therefore, any logical statement which contains a finite number of logical 
variables (which of course covers any problem we have to deal with) can be analyzed using 
a table which lists all possible values of the variables: a "truth table". Since each variable 
can take only two values, a statement with "n" variables requires a table with 2 n rows. Using 
the letters "p", "q", "r", etc., to represent logical variables, we can construct truth tables for 
statements involving any number of variables (although we will usually limit ourselves to at 
most three variables per statement to simplify the matter): 
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OR Operation 

In the following two-inputs logic circuit, the table lists all possible combinations of logic levels 
present at inputs A and B along with the corresponding output level X. 

 

When either input A OR B is 1, the output X is 1.  

The expression X = A + B is read "X equals A OR B".  
The + sign stands for the OR operation, not for ordinary addition. 

The OR operation produces a result of 1 when any of the input variable is 1. 

The OR operation produces a result of 0 only when all the input variables are 0. 

Truth table for 3 input logic circuit (OR operation) 

 

 

 

 

 

 

AND Operation 

The expression X = A * B is read "X equals A AND B".  
The multiplication sign stands for the AND operation, the same as for ordinary 
multiplication of 1s and 0s. 

The AND operation produces the result 1 only for the single case where all the input 
variables are 1. 

The output is 0 for any case where one or more inputs are 0 
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Truth table for three input logic circuit 

 

 

 

 

 

 

NOT Operation 

The NOT operation is unlike the OR and AND operations in that it can be 
performed on a single input variable. For example, if the variable A is 
subjected to the NOT operation, the result x can be expressed as 

x = A' 

where the prime (') represents the NOT operation. This expression is read as: 
x equals NOT A  
x equals the inverse of A  
x equals the complement of A  

Each of these is in common usage and all indicate that the logic value of x = 
A' is opposite to the logic value of A.  

The truth table of the NOT operation is as follows: 

 

1' = 0 because NOT 1 is 0 
0' = 1 because NOT 0 is 1 

The NOT operation is also referred to as the inversion or complementation, 
and these terms are used interchangeably.  
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Annexe 4.1.3 

Instructions for the Group Exploration 
 

• Each group will be assigned one of the following sets containing four truth tables.  
• Focus on the truth tables assigned to your group.  
• Identify the number of variables in table one and two. 
• Identify and name the number of possible combinations that can be formed from the 
      above variables. 
• Discuss the relation between the combinations 
• Study table 3 and state how it is related to the second table  
• Identify and describe the meaning of A’ and B’ (bar) 
• Understand the different variables correctly and complete all the tables   

 
First set of tables 
 

A B A.B B.A 
0 0 0  
0 1  0 
1 0 0  
1 1  1 

 
A B C A.B (A.B).C 
0 0 0   
0 0 1 0 0 
0 1 0   
0 1 1   
1 0 0   
1 0 1  0 
1 1 0   
1 1 1   

 
A B C B.C (B.C).A 
0 0 0   
0 0 1 0 0 
0 1 0   
0 1 1   
1 0 0   
1 0 1 0  
1 1 0   
1 1 1   

 
 
 
 
 
 
NOT operation  
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A B A B 
A.B 

A.B A.B 

0 0 1  1 0  
0 1      
1 0  1   1 
1 1      

Second set of tables 
 

 
A 

 
B 

 
A+B 

 
B+A 

0 0 0  
0 1  1 
1 0 1  
1 1  1 

 
 

A 
 

B 
 

C 
 

A+B 
 

(A+B)+C 
0 0 0  0 
0 0 1 1  
0 1 0   
0 1 1   
1 0 0   
1 0 1  1 
1 1 0 1  
1 1 1   

 
 

A 
 

B 
 

C 
 

B+C 
 

(B+C)+A 
0 0 0   
0 0 1 1  
0 1 0   
0 1 1  1 
1 0 0   
1 0 1 1  
1 1 0   
1 1 1  1 

 
 

A 
 

B 
 

A 
 

B 
 

     A+B 

 
A+B 

 
A+B 

0 0 1  1 0  
0 1      
1 0  1   0 
1 1      

 
 
 
 
 
 

 
Competency 4 :  Uses Boolean Algebra to work effectively with logic gates 
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Competency 4.2: Assesses the suitability of basic logic gates to illustrate  logic  

      Operations 
   

Activity 4.2 :    Let’s find out the functions of basic logic gates 

Time :    90 Minutes  

Quality inputs :    • A demy sheet containing the situations in Annexe 4.2.1 

  •    Five copies of the reading material in Annexe 4.2.2 

  • Five copies of the group exploration instruction sheet in 

    Annexe 4.2.3 

Learning – Teaching Process: 

Step 4.2.1 :    •    Draw the attention of the class to the situations shown on the 

demy sheet. 

  • Ask students to state the conditions that need to be satisfied to 

obtain the necessary outcome.  

  • Conduct a discussion to highlight the following. 

 

 

 

 

 

 

 

 

 

 

 

          (15 minutes) 

 
 
 

Step 4.2.2 : • Divide the class into five groups.    

• When both the key and the door are open the buzzer in the car 

sounds. The condition is AND and the output is sound. 

• The fire alarm sounds when it senses either heat or smoke.  

The condition is OR. 

• People in our country are allowed to vote at the elections if they 

are Sri Lankans who are 18 or above. The condition is AND. 

• To complete the assignment the students must do a 

presentation or write an essay. The condition is OR. 

• To follow the course at the University the student must have A 

passes in Math, English and Science or ICT.  The combined 

conditions are AND & OR.  

• If the door is not locked you can enter the building.  If the door 

is locked you cannot enter.  The condition is NOT.   
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  • Provide each group with a copy of the reading material and group 

exploration instruction 

  • Distribute five logic gates among the five groups 

  • Involve the groups in the exploration. 

 • Prepare groups for a presentation at the plenary. 

(45 Minutes) 
 

Step 4.2.3         : • Get each group to present its findings. 

• Request the presents themselves to fill gaps, if any. 

• Seek for constructive comments of other groups  

•  Conclude the session by highlighting the following.  
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 • If the input variable is A, the inverted output is known as 
Not A.  This is shown as A’ or⎯A  - a bar over the top. 

 

•    NAND – Not AND gate is equal to an AND gate followed by a 

NOT gate.  The symbol is an AND gate with a small circle on 

the output side. 

• The outputs of all NAND gates are high (1) if any of the

• Gates in a circuit are represented by specific delta-shaped 

standard symbols prescribed by the ASA – American 

Standard Association.   

• A Logic Gate in an electronic device is a logic circuit, which 

makes basic logical decisions such as AND, OR, NOT 

operations. 

•    Logic gates in digital systems are AND, OR, NOT, NAND, 

NOR  

•   The high output in a circuit, that is current flow, is denoted by 1 

and the low output where there is no current flow, is denoted  

by 0. 

•   The AND gate is an electronic circuit that gives a high output -1 

only if all its inputs are high-1.  A dot (.) is used to show the 

AND operation. 

•    The OR gate is an electronic circuit that gives a high output-1 

if one or more of its inputs are high.  A plus (+) is used to 

show OR operation. 

•    The NOT gate is an electronic circuit that produces an 

inverted version of the input as its output.  It is also known as 

inverter. 
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(30 minutes) 

 
Criteria for assessment and evaluation 

• Names the basic logic gates and describes their functions.  

• Accepts the value of gates in decision-making. 

• Uses appropriate gates in circuits to meet user needs.    

• Uses symbols and graphical representations. 

• Demonstrates logical thinking ability. 

 

 

 

 

 

 

 

 

 

 

Annexe 4.2.1 
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Logic operations and Gates 

Situations: 

1. You have a buzzer in your car that sounds when your keys are in the ignition and the 

door is open.  

2. You have a fire alarm installed in your house. This alarm will sound if it senses heat 

or smoke.  

3. There is General election coming up. People are allowed to vote if they are a Sri 

Lankan citizen and they are 18.  

4. Mr. Sydney is giving his students an assignment. To complete the assignment the 

students must do a presentation or write an essay.  

5. Ranjani is applying to a university course on Mathematics in Australia. She must 

have A passes in Math, English and Science or ICT. 

6. You have reached the main entrance of the building and the door is not locked. So 

you can enter the building. 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

Annexe 4.2.2 

Logic gates and circuits 
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Logic Gates 

A logic gate is an arrangement of switches used to calculate operations in Boolean algebra. 
It is an elementary building block in a digital circuit. Most logic gates have two inputs and 
one output. At any given moment, every terminal is in one of the two binary conditions low 
(0) or high (1), represented by different voltage levels. The logic state of a terminal can, and 
generally does, change often, as the circuit processes data.  

In most logic gates, the low state is approximately zero volts (0 V), while the high state is 
approximately five volts positive (+5 V). 

Computers operate on the principle of logic and use the TRUE and FALSE logic conditions 
of a logical statement to make a programmed decision. The conditions of a statement can be 
represented by symbols or variables.  

In computers, electronic circuits operating in two LOGIC STATES represent these two 
conditions. These logic states are 0 (zero) and 1 (one). 0 and 1 represent the FALSE and 
TRUE conditions of a statement, respectively. 

There are five basic logic gates: AND, OR,  NOT, NAND and NOR. 

The AND gate 

The AND gate has two or more inputs. The output from the AND gate is  1 if and only if all of 
the inputs are 1, otherwise the output from the gate is 0. The AND gate is drawn as follows  

 

 

The output from the AND gate is written  .  

Truth table 

A table that defines a logic circuit by listing all combinations of input values, and indicating 
the  true output values for each combination. 

 

The truth table for a two-input AND gate looks like  

   

0  0  0 

0  1  0 

1  0  0 
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1  1  1 

It is also possible to represent an AND gate with a simple analogue circuit, where a bulb is lit 
when A and B are closed. 

 

The OR gate 

The OR gate has two or more inputs. The output from the OR gate is 1 if any of the inputs is 
1. The gate output is 0 if and only if all inputs are 0. The OR gate is drawn as follows  

 

 

The output from the OR gate is written  .  

The truth table for a two-input OR gate looks like  

   

0  0  0 

0  1  1 

1  0  1 

1  1  1 

 

The following diagram represents a OR gate with a simple analogue circuit, where a bulb is 
lit when A or B is closed. 
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The NOT gate 

The NOT gate is unique in that it has only has one input. This is how it looks   

 

 

The input to the NOT gate is inverted i.e the binary input state of 0 gives an output of 1 
and the binary input state of 1 gives an output of 0.  

is known as "NOT A" or alternately, the complement of .  

The truth table for the NOT gate appears as below  

 

0  1 

1  0 

 

 

 

 

COMBINATION OF GATES  
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These three gates are adequate to accomplish all possible logical functions and operations 
in the microprocessor. 

Some combinations of the three basic AND, OR and NOT gates are used so commonly that 
they have been given names and logic symbols of their own. i.e. NAND, NOR, these gates 
are constructed using basic AND, OR and NOT gates. 

The NAND (NOT AND) Gate  

A simple circuit consisting of an AND gate in series with an inverter is illustrated below.  

  

 
              . 

This simple circuit is referred to as a NAND gate because the output is a NOT AND output. 
The circuit  has its own symbol as illustrated below. 

 

 

A NAND gate is cheaper to manufacture as a single circuit on a chip compared to the cost of 
manufacturing an AND gate and a NOT gate using separate circuits on separate chips. In 
fact microprocessors mostly use NAND gates because of their relatively low cost.  

 
 
Truth Table for a NAND Gate 
 

A B   AB 

0 0 1 

0 1 1 

1 0 1 

1 1 0 

The NAND gate can be considered to have the NOT AND function. The outputs for a NAND 
gate are the complements or inversions of the corresponding outputs for an AND gate. 
   
As with an AND gate, there is no limit to the number of inputs that may be applied to a 
NAND function, as such, there is no functional limit to the number of inputs a NAND gate 
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may have. However, for practical reasons, commercial NAND gates are most commonly 
manufactured with 2, 3, or 4 inputs, to fit in a 14-pin or 16-pin package. In the diagram 
below, four separate 2 input NAND gates are wired in a chip containing 14 pins. 

 
 
Note that there is no separate symbol for NAND in Boolean logic.  Using symbols, the AND 
function is designated with a multiplication sign (.), or usually no sign, with an overbar over 
the entire expression to indicate the NAND function. 
 
For example, using symbols, can be read as NAND AB, although this is usually read as 
NOT AB or NOT A AND B. 
Here is a 14 pin integrated circuit chip containing three input NAND gates.  The truth table 
for a          3-input NAND gate is also listed below. 

 
14-pin IC chip 

 
A B C ABC  
0 0 0 0 1 
0 0 1 0 1 
0 1 0 0 1 
0 1 1 0 1 
1 0 0 0 1 
1 0 1 0 1 
1 1 0 0 1 
1 1 1 0 1 

The truth table for a  3-input NAND gate for the circuit above. 
The NOR (NOT OR) Gate 
We saw above that an AND gate in series with an inverter [NOT gate] is referred to as a 
NAND gate. 
Similarly, an OR gate in series with an inverter [NOT gate] is referred to as a NOT OR or 
simply, NOR gate.  



G.C.E.(O/L) IT Teacher Instructional Manual 
 

 
 

 
National Institute of Education- 2007 

 
150

An OR gate in series with an inverter: is called a NOR gate which has its own special 
symbol: 

 
 

 
The NOR gate is an OR gate where the output is inverted. There is no separate Boolean 
symbol for NOR. 
In symbols, the NOR function is designated by a plus sign (+), with an overbar over the 
entire expression to indicate the inversion. In logical diagrams, the symbol read as 
NOT A OR B or simply A NOR B which represents the output of a 2-input NOR gate. 
 
A NOR gate can have any number of inputs, but practical commercial NOR gates are mostly 
limited to 2, 3, and 4 inputs, as with other gates at this level, to fit into standard IC packages.  
The Motorola MC14025B 14 pin chip is shown below. This chip contains three 3-input NOR 
gates. The truth table for each gate has also been completed as shown below. 
 

 
 

A B C A + B + C  
0 0 0 0 1 
0 0 1 1 0 
0 1 0 1 0 
0 1 1 1 0 
1 0 0 1 0 
1 0 1 1 0 
1 1 0 1 0 
1 1 1 1 0 

 
 
These gates, as with the other derived logic gates, can be formed from a combination of the 
three basic gates: AND, OR and NOT. However, because of their functional importance, 
these gates again are treated as basic gates along with their own unique symbols. 
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Annexe 4.2.3 
 

Instruction for the Group Exploration 
 
• You will be working in five groups with the following five gates distributed randomly 

across the groups. 

 

Group Gate and the operation 

1 AND 

2 OR 

3 NOT 

4 NAND 

5 NOR 

 

• Identify the function of the gate along with the symbol. 

• Draw a three input truth table. 

• Identify the logic operation manipulated by the gate.  

• Assess the suitability of the gate for the logic operation identified. 

• Be prepared to present your findings at the plenary session.  
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Competency 4.3:  Uses basic laws of Boolean Algebra to handle logic  
                               gates 
 
Activity 4.3 :    Let’s identify the basic laws of Boolean algebra. 

Time :    90 Minutes  

Quality inputs : • Four copies of reading material in Annexe 4.3.1 

  •    Four copies of group exploration instructions in Annexe 4.3.2   

Learning – Teaching Process: 

Step 4.3.1 :    •    Display the following equation to the whole class 

   2{4+3(6- 4/2)} 

  • Ask the students to explain how they would solve the above 

equation 

  •   Conduct a discussion to highlight the following. 

 

 

 

 

(10 minutes) 

Step 4.3.2 : • Divide the class into four groups.    

  • Distribute group exploration instruction and reading material 

between the four groups 

  • Involve the groups in the exploration. 

 • Prepare groups for a presentation at the plenary 

(50 Minutes) 

Step 4.3.3            : • Get each group to present its findings. 

• Request the presents themselves to fill gaps, if any. 

• Seek for constructive comments of other groups 

• Conclude the session by highlighting the following.          

• We follow rules and use operators when solving equations 

• The result depends on the operators  

•    Boolean algebra, that has certain rules and operators, is    

      used in Computing 

 
Competency 4 :  Uses Boolean Algebra to work effectively with logic gates 
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(30 minutes) 

Criteria for Assessment and evaluation 

• Names the basic laws associated with Boolean algebra.  

• Accepts that the rules are to be adhered to when solving the mathematical equations. 

• Uses basic laws of Boolean algebra to simplify logical expressions.    

• Follows rules in solving problems. 

• Builds mathematical models for logical thinking 

 

 

•    There are basic laws and axioms in Boolean Algebra. 

•    The basic operators used in Boolean Algebra are 

o AND 

o OR 

o NOT. 

•    Here we use + to denote OR, . to denote AND,  ‘ or⎯  (Bar) to 

denote NOT. 

•    The laws used in Boolean Algebra are  

o Commutative law 

o Associative law 

o Distributive law 

o Identity law 

o Redundancy law. 

•    In conjunction with Boolean algebra a formalized set of 

logical operations have been formed. They are called De 

Morgan’s theorem. 

•    In general algebra a variable can have any value. In Boolean 

the variable, however has two states either 0 or 1. 

•   Truth tables can be used to check the outcome of the 

Boolean expression 
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Annex 4.3.1 

Boolean Algebra 

Boolean algebra is the algebra of logic. One of the earliest investigators of symbolic logic 
was George Boole (1815 –1864) who invented a systematic way of manipulating logic 
symbols, which came to be known as Boolean algebra. Till 1939, there was no practical 
application for Boolean algebra. In 1938, Shanon’s work gave an idea that Boolean algebra 
could be applied to digital electronics. Indeed, it has now become an indispensable tool for 
computer scientists because of its direct applicability to switching theory and the logical 
design of digital computers 

In ordinary algebra, operators like +, -, x,  are used to perform mathematical operations 
on any number on the number line.  

But Boolean algebra differs radically from ordinary algebra in that Boolean constants and 
variables are allowed to have only two possible values, 0 or 1. These variables are referred 
to as logical (binary) variables. Like other mathematical variables English letters can also 
represent these variables.  

Boolean 0 and 1 do not represent actual numbers but instead, represent the state of a 
voltage variable, or what is called its logic level. 

Some common representations of 0 and 1 are shown in the following diagram. 

Logic 0 Logic 1 
False True 
Off On 
Low  High 
No Yes 
Open Switch Close Switch 

Logical operations & Truth Tables 

One of the primary requirements when dealing with digital circuits is to find ways to make 
them as simple as possible. This constantly requires that complex logical expressions are 
reduced to simpler expressions that nevertheless produce the same results under all 
possible conditions. The simpler expression can then be implemented with a smaller, simpler 
circuit, which in turn saves the price of unnecessary gates, reduces the number of gates 
needed, and reduces the power and the amount of space required by these gates. 

The rules of Boolean Algebra 

The rules of Boolean Algebra are simple and straight-forward, and can be applied to any 
logical expression. The resulting reduced expression can then be readily tested with a Truth 
Table, to verify that the reduction was valid. 
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In Boolean algebra, there are three basic logic operations: 
OR, AND and NOT. 
 

The (axioms) rules of Boolean Algebra are:. 

AND Operations (·)  
 0·0 = 0      A·0  = 0 
 1·0 = 0      A·1  = A 
 0·1 = 0      A·A  = A 
 1·1 = 1      A·A' = 0 
OR Operations (+)  
 0+0 = 0      A+0  = A 
 1+0 = 1      A+1  = 1 
 0+1 = 1      A+A  = A 
 1+1 = 1      A+A' = 1 
NOT Operations (')  
 0' = 1       A''  = A 
 1' = 0 

Laws of Boolean Algebra 
 
Note that every law has two expressions, (a) and (b). This is known as duality. These are 
obtained by changing every AND(.) to OR(+), every OR(+) to AND(.) and all 1's to 0's and 
vice-versa.  
 
It has become conventional to drop the . (AND symbol) i.e. A.B is written as AB.  

Investigating the various Boolean theorems (rules) can help us to simplify logic expressions 

Commutative Law  
 A·B = B·A 

 A+B = B+A 
 
Associative Law  
 (A·B)·C = A·(B·C) = A·B·C 
 (A+B)+C = A+(B+C) = A+B+C 
  
Distributive Law  
  A·(B+C) = (A·B) + (A·C) 
  A+(B·C) = (A+B) · (A+C) 
  
Idempotent Laws 
     A.A= A 
     A+A=A 
 
DeMorgan's Theorem  
 

(A·B)' = A' + B'   (NAND) 
Not A and B is a combined operator which is called NAND 
(A+B)' = A' · B'   (NOR) 

 Not A or B is a combined operator which is called NOR 
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Annexe 4.3.2 
 

Instruction for the Group Exploration 
• You will be working in three groups with one of the following three equations 

distributed among the three groups. 
 

Group Equations 
1  

 
  A + B . C = A.(B+C) 
 

2  

  A .(B .C) = A + ( B . C ) 
 
 

3  
            A. (B +C) =  A . B . C 

 

 
• Develop two truth tables to indicate each side of the equation 

• Compare the outcome of the truth tables to prove that they are equal. 

• Now study the equation to familiarize yourselves with variables, operators and symbols 

• Follow the procedure adopted for the theorems to compare the two sides of the 

equations 

• Be prepared to present your findings at the plenary session. 
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Competency Level 4.4:  Integrates basic gates to develop simple circuits 
Activity 4.4  :    Let’s design simple circuits 

Time  :    90 minutes. 

Quality inputs : •  Four copies of Reading material in Annexe 4.4.1  
  

     •   Four copies of instructions for the group exploration in  

     Annexe 4.4.2 

     Learning – Teaching Process: 

Step 4.4.1 :    •    Expose the class to the circuit developed along with the underlined 

situation   

  •   Discuss with the students how the circuit works 

  •   Conduct discussion to highlight the following. 

 

 

 

 
 

(15 minutes) 

Step 4.4.2 : • Divide the class into four groups.    

  • Distribute the group exploration instruction and reading material 

between the four groups 

  • Involve the groups in the exploration. 

 • Prepare groups for a presentation at the plenary 
(45 minutes) 

Step 4.4.3 : • Get each group to present its findings. 

• Request the presents themselves to fill gaps, if any. 

• Seek for constructive comments of other groups 

• Conclude the session by highlighting the following. 

          

•   The given circuit has three inputs   

•   The two basic gates in the given circuit are 

o AND gate 

o OR gate 

•   The output depends on the selection of the current input 

 
Competency 4 :  Uses Boolean Algebra to work effectively with logic gates 
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  •  Circuits are combinations of gates  

•  The NAND gate is a combination of AND and NOT gates. 

• The NOR gate is a combination of OR and NOT gates 

•   A truth table can be used to show the output of the circuit 

      •  A logical expression of the circuit can be built using the truth

         table or circuit diagram 

•  Each circuit is used for a specific purpose on which a  

      situation can be developed.  
 

 
(30 Minutes) 

Criteria for assessment and evaluation 
 

• Names and explains different types of gates found in a circuit  

• Accepts the value of Boolean algebra in developing logical circuits for digital devices. 

• Explores day-to-day situations through simple circuits. 

• Uses diagrams to simplify understanding of day to day problems 

• Thinks logically. 
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Annex 4.4.1 

Reading Material 
Instructions on how to develop the circuit. 

 
Situation identified to develop the circuit 
 
Assume that there are three umpires in the cricket field; the chief umpire and two assistant 
umpires. This is how they take a decision. 

1. Any decision approved by a minimum of two umpires is accepted. 
2. Two assistant umpires cannot take any decision 
3. The chief umpire alone cannot take a decision. 
4. A decision to be accepted must necessarily be taken jointly by the chief umpire and 

at least one assistant umpire. 
 
The Circuit diagram for the above situation  
 
 
 
  
 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

A 
B
C
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Annex 4.4.2 

Instruction for the Group Exploration 
 
• You will be working in four groups with the following four circuit diagrams assigned to 
            the four groups. 
• Study the diagram and complete the following tasks. 
 

o Write Boolean expression 
o Draw the truth table 
o Identify the possibilities of receiving the same output 
o Create a situation that could represent the diagram given 

 
      Be prepared to present your findings at the plenary sassion. 

 

Circuit diagram 1 

 

Circuit diagram 2 
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Circuit diagram 3                   
 

                   
   

 
 
 
 
Circuit diagram 4 
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Activity  5.1 :    Let’s explore different types of operating systems 

 
Competency Level 5.1:  Explores operating systems by type, functions, benefits  
               and concerns 
Activity :   Lets explore different types of operating systems. 
Time : 60 minutes 

Quality inputs      : • Five copies of group exploration instructions in Annexe 5.1.1  

  • Five copies of the reading material in Annexe 5.1.2 

                                
Learning – Teaching Process: 

Step 5.1.1 :    •    Draw the attention of the class to a variety of machines like 

scrapers, graters, grinders, cassette recorders, washing machines 

and computers.   

  •   Let students describe how these machines work. 

  •   Conduct a discussion to highlight the following. 

 

 

 

 
 
 

(10 minutes) 

Step 5.1.2 : • Divide the class into five groups.    

  • Distribute group exploration instructions, demy sheets and 

markers across the groups.  

  • Assign tasks randomly and involve the groups in the exploration.  

  • Prepare groups for a whole class presentation.           
    (30 minutes) 

Step 5.1.3 : • Get each group to present its findings. 

  •    Get the presenters themselves to elaborate on their findings. 

• Request other groups to submit their constructive comments. 

  •  Conduct a discussion to develop the following chart on the board.  

•  Machines are operated either manually or automatically.  

•  Both operations above require some kind of a system. 

•  Different types of operating systems are available to run 

computers. 

•  These are called operating system. 

 
Competency 5 :  Works effectively with operating systems 
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(20 Minutes) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Criteria for assessment and evaluation 
 

• Names the five types of operating systems and describes them.  

• Accepts the value of selecting operating systems on the basis of processing needs.   

• Analyzes different types of operating systems by their functions, benefits and 

concerns. 

• Investigates needs as prerequisites for selection of digital devices. 

• Investigates parts to visualize the whole.  

 

 

 
 
 
 
 
 

  

Types of 
operating 
system 

Functions Benefits Disadvantages
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Annexe 5.1.1  
Instructions for the Group Exploration 

  
• You will be working in five groups with one of the following types of operating systems 

assigned randomly to each group. 

o Multi-user  

o Multiprocessing  

o Multitasking 

o Multithreading  

o Real time  

• Discuss the main features and functions of the type of operating system assigned to your 

group. 

• Identify its benefits and concerns. 

• Be prepared for a whole class presentation. 
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Annexe 5.1.2 

Reading material 
 

For All Groups 

Operating system 

 

 

 

 

 

 

 

 

The most important program that runs on a computer. Every general-purpose computer must 

have an operating system to run other programs. Operating systems perform basic tasks, 

such as recognizing input from the keyboard, sending output to the display screen, keeping 

track of files and directories on the disk, and controlling peripheral devices such as disk 

drives and printers. 

Operating systems can be classified as follows:  

� multi-user : Allows two or more users to run programs at the same time. 

Some operating systems permit hundreds or even thousands of 

concurrent users.  

� multiprocessing : Supports running a program on more than one CPU.  

� multitasking : Allows more than one program to run concurrently.  

� multithreading : Allows different parts of a single program to run concurrently.  

� real time : Responds to input instantly. General-purpose operating systems, 

such as DOS and UNIX, are not real-time.  
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Multi-user 
Refers to computer systems that support two or more simultaneous users. All mainframes 

and minicomputers are multi-user systems, but most personal computers and workstations 

are not. Another term for multi-user is time-sharing. 

 
Multiprocessing  
 Refers to a computer system's ability to support more than one process (program) at the 

same time. Multiprocessing operating systems enable several programs to run concurrently. 

UNIX is one of the most widely used multiprocessing systems, but there are many others, 

including OS/2 for high-end PCs. Multiprocessing systems are much more complicated than 

single-process systems because the operating system must allocate resources to competing 

processes in a reasonable manner. 

 

Multitasking 
The ability to execute more than one task at the same time, a task being a program The 

terms multitasking and multiprocessing are often used interchangeably, although 

multiprocessing implies that more than one CPU is involved.  

In multitasking, only one CPU is involved, but it switches from one program to another so 

quickly that it gives the appearance of executing all of the programs at the same time.  

There are two basic types of multitasking: preemptive and cooperative. In preemptive 

multitasking, the operating system parcels out CPU time slices to each program. In 

cooperative multitasking, each program can control the CPU for as long as it needs it. If a 

program is not using the CPU, however, it can allow another program to use it temporarily. 

OS/2, Windows 95, Windows NT, the Amiga operating system and UNIX use preemptive 

multitasking, whereas Microsoft Windows 3.x and the MultiFinder (for Macintosh computers) 

use cooperative multitasking.  

Multithreading 
The ability of an operating system to execute different parts of a program, called threads, 

simultaneously. The programmer must carefully design the program in such a way that all 

the threads can run at the same time without interfering with each other.  

 

Real time 
Occurring immediately. The term is used to describe a number of different computer 

features. For example, real-time operating systems are systems that respond to input 
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immediately. They are used for such tasks as navigation, in which the computer must react 

to a steady flow of new information without interruption. Most general-purpose operating 

systems are not real-time because they can take a few seconds, or even minutes, to react.  

 
DOS (Command Line Interface “CLI”) 

DOS stands for Disk Operating System. In the early 1980s, Microsoft got the right to QDOS 

(Quick and Dirty Operating System) developed by a small company, Seattle Computer, and 

then has been sold it under the name MS-DOS. Microsoft licenses a version called PC-DOS 

to IBM (International Business Machines) for its IBM personal computers, and its version, 

MS-DOS, to many other PC manufacturers.  

Advantages:  

● The advantages will be the reasons for learning DOS. DOS is the most 

popular microcomputer operating system for IBM computers and compatibles 

ever sold worldwide.  

● It runs thousands of applications, and is easy to use. DOS is easy for novices 

to use, and many publications and books are available for the operating 

system.  

● DOS runs on low- priced IBM computers and compatibles. DOS does not 

require an expensive computer system while some others still do.  

● DOS needs small space of the memories.   

Disadvantages  

● It will then slowly be replaced as the dominant operating system. The 

hardware has evolved in significant ways. New microcomputers have more 

capacity and faster electronics than the old IBM PC and compatibles. This 

makes DOS an old operating system. 

● DOS use more commands. So, it is more difficult to memories about 

command.     

● DOS has direct access to only 640 kilobytes of primary storage, although new 

microcomputers have much more primary storage. This restriction is an 

inherent limitation of DOS. Today's new software for word processing, 

graphics, spreadsheets, and database management requires more primary 

storage. In addition, DOS is a single tasking operating system. It can support 

only one user and one program at a time. 
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Another disadvantage is that DOS has a character-based interface. A 

graphical user interface is easier to the users than the character-based 

interface.  

Windows 3.x  

This is a graphics-based operating environment from Microsoft. This operating 

system runs under DOS. Thus, it is usually called "DOS with windows." Windows 3.x 

allows multiple tasking, allowing users to open several applications simultaneously 

and shift between them. Windows operating system is very similar to the Macintosh 

desktop environment. 

Advantages:  

● Windows allows multitasking capability and more primary memory. Windows 

provides a memory manager to allow users to access more than 640KB of 

conventional memory.  

● Another benefit of it is that it has a dynamic data exchange function. Dynamic 

data exchange allows one program (e.g., a word processing program) to 

request data or information from other programs (e.g., a spreadsheet program 

or a database program etc.) currently running and use those information. 

● A graphical user interface (GUI) against character- based approach is another 
advantage. This allows users to use Windows environment such as mouse, 
Disadvantages:  

● Windows 3.x can handle multitasking, but it is really switching between tasks.  
● Windows 3.x is not a multithreaded operating system. This works well for 

many applications, but for some information and data can be lost if Windows 

does not get back to a task soon enough.  

● Windows 3.x was not originally intended for networks and is not very efficient 

in that environment  

Windows 95  

Windows 95 upgrades its earlier versions (Windows 3.x) in many ways. It has a new 3-D 

interface. It is mostly a 32- bit system although it has 16-bit components included for 

compatibility with Windows 3.x. Windows 95 does not need to have a separate DOS. It 

integrates all DOS services. A Windows 95 system runs in protected mode. This means that 

it speeds up the processors and provides more safety. 

Windows 95 serves two purposes: It will move developers to the Win32 API and will ease 

the transition for users whose hardware is not yet ready to handle the demands of Windows 
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NT. 

Windows 95 offers better preemptive multitasking. Although for most things, cooperative 

multitasking is good. However, if users want to do several things simultaneously, they are 

going to find that preemptive multitasking provides smoother operation and better speed. 

Because Windows 95 is based on Win32 and has borrowed some of NT's features, some 

people are confused over which Windows to use. Windows 95 is for anyone who has a lower 

capability computer that does not enable to use Windows NT. Windows 95 is likely to 

perform better than NT as a desktop system, especially when running older 16-bit Windows 

applications.  

Advantages:  

● This operating system provides compatibility with existing Windows and DOS 

programs. It also offers compatibility with existing Windows and DOS device 

drivers. It works as in standalone computer and in networked environment for 

both desktop and mobile users.  

● It is easier to learn and use, gives users better performance, has more 

capacity, integrates applications better, connects better, and crashes less 

than its predecessor, Windows 3.x.  

Disadvantages:  

● Windows 95 still has limits from 16-bit components retained for backward 

compatibility with 16-bit application. It does not give much benefit to the 16-bit 

applications. To get benefits from Windows 95, users must upgrade their 

applications to 32-bit versions that support OLE and can interact directly with 

Windows 95's shell. It will cost users significantly.  

Windows NT (New Technology)  
Window NT is a platform for 32-bit Windows applications. This is a powerful and one of the 

most advanced operating systems available today. 

Windows NT was originally designed with big-system features. Beginning with version 3.5, 

Microsoft began repositioning Windows NT as a workstation and server operating system. It 

also has a sophisticated multiuser security system, so Windows NT performs excellently as 

a disk server. NT has support for network services useful to applications like client/server 

database engines. Still, all the features of Windows NT are suitable for use in demanding 

applications of desktop users.  
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OS/2  

OS/2 stands for Operating System 2. This is another operating systems for powerful 

microcomputers and networking. OS/2 was designed to avoid some of the most serious 

limitations of DOS. OS/2 runs in 4MB of memory, although it runs well in an 8MB system. It 

requires about 30MB of hard disk space. OS/2 WARP, the window version of OS/2, performs 

reasonably well in 4MB system and requires less disk space. 

Users do not need to abandon DOS and Windows to try out OS/2. OS/2 provides a dual boot 

feature that allows users to boot up in either DOS or OS/2. OS/2 uses folders much like 

those on the Macintosh and on some UNIX GUIs.  

Advantages:  

● It is not affected by requirements of DOS and Windows that certain device 

drivers live in the first 640KB of memory. Instead, OS/2 can load network 

adapter drivers, multimedia interfaces, CD-ROM software or video drivers into 

memory as required. While OS/2 works very nicely with the same FAT file 

system used by DOS, its HPFS has a number of benefits. It is significantly 

faster, it allows a long file name, and it supports disk drivers as large as 256 

gigabytes. 

● This operating system allows multitasking and dynamic data interchange. It 

also provides common graphical user interface with mainframes, 

minicomputers, and microcomputers by OS/2 WARP. OS/2 was developed to 

assist in the sharing of data and programs among several microcomputers. 

OS/2 solidly supports Novell Netware and TCP/IP. Most network interface 

cards are supported.  

Disadvantages:  

● OS/2 Shell or WARP is similar to Windows, but is not identical. It may take 

users a while to adjust to some of the differences. The application programs 

developed specifically for OS/2 are not as many as those for Windows, 

although more and more application developers are going to converting and 

developing programs for OS/2 these days.  

UNIX  
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This is a multi-user, multitasking operating system that runs on many different computer 

systems from microcomputer to mainframe, because UNIX is written in C programming 

language, which is a language designed for system-level programming. UNIX is consisted of 

a kernel, the file system, and the user interface. The kernel is the heart of the operating 

system. The file system has a hierarchical directory method for organizing files on the disk 

and the shell.  

Advantages:  

● UNIX is the portable operating system that can be used with many different 

computers from mainframe to microcomputer. The other operating systems 

such as DOS, Windows, Mac operating system, and OS/2 cannot be used for 

other systems. One of many strong features of UNIX is multitasking. UNIX 

allows users to run multiple programs simultaneously. 

● UNIX also shares it among multiple users. UNIX is not restrained by the 

computer systems such as conventional memory as the DOS and OS/2 

systems are. It can accomplish many operations that were formerly performed 

on minicomputers or mainframes. It is important, because industry can 

achieve the performance and benefits of large computers from 

microcomputers by using UNIX. 

● Networking is another strong feature of a UNIX operating system. UNIX can 

be connected through several different kinds of equipment. It can share files 

among them.  

Disadvantages:  

● UNIX was a minicomputer operating system used by programmers and 

computer science professionals some time before the rise of the 

microcomputer. This means that it has certain qualities making it useful to 

programmers - many supporting utility programs and documentation, for 

instance. Some of its features make it difficult for end users. 

● Limited application programs are another disadvantage for UNIX. UNIX off-

the-shelf programs for microcomputers are limited. However, this situation is 

going to change, because many software vendors are rewriting DOS and 

Windows applications for UNIX. 
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● There is not a standard for UNIX. This may be the biggest problem for the 

popularity of UNIX. An application program written for one version of UNIX 

may not run on other versions. 

● There is also not a standard GUI for many UNIXs. There were several 

attempts to combine the Sun, AT& T, and U.C. Berkeley versions of UNIX to 

produce a standard graphical user interface.  

Macintosh Operating Systems  

It uses a graphics screen that places familiar office objects on a display screen. Icons 

represent files, folders, programs, and disks. It has a hierarchical file system that lets users 

drag document icons into and out of folder icons. Folders can also contain other folders and 

so on. 

The Macintosh user interface style has been adapted to many other operating systems. For 

example, OS/2 Presentation Manager and WARP, New Wave, most UNIX systems, and 

Windows look very similar to the Macintosh graphics user interface. 

The Macintosh operating system has two major files. They are the System file and the 

Finder. The system file manages the user interface. Both files work together to achieve the 

operating system procedures such as formatting disks, copying files, erasing files, and 

running application programs.  

Advantages:  

● The ease of use is the primary charm of the Macintosh. The graphics 

interface such as menus, screen display, and dialog boxes are quite more 

consistent across applications than they are in Windows. It also offers easy 

plug and play. When install a board in a Mac, users need to plug it into a slot, 

drag its driver icon into the System Folder, and reboot the computer.  

● It provides long filenames, integrated program and file management, desktop 

icons, and shortcuts. It provides a high quality graphics processing that 

makes Macintosh popular for desktop publishing (Mac is the standard 

computer in the publishing industry).  

● It has a great video architecture that allows users to add multiple monitors to 

a computer by adding another video board and hook up another monitor. 

The later versions of Macintosh operating system (System 7.x series) enable 

users to do multitasking. That is, multiple programs can run simultaneously, 

each sharing the CPU (cooperative multitasking like Windows 3.x). System 
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7.x allows applications programs to exchange and share data and commands 

with other application programs.  

● It even provides built-in sound, SCSI, and Ethernet that allow users to work 

easily with multimedia. It has much better multimedia toolkit than Windows 

has. The IBM and compatible computers, PC, cannot match the Macintosh's 

toolkits for multimedia, and Windows multimedia applications do not work 

together as smoothly as their Macintosh counterparts.  

Disadvantages:  

● The first disadvantage of the Macintosh platform is the incompatibility with 

DOS and Windows (PC) applications. This has been made Macintoshes less 

attractive to corporate users that want to have compatibility and connectivity 

within company and between companies.  

●  Software (e.g., Insignia's SoftWindows) are now available for the Mac to 

allow it to run Windows on PowerMac although it runs slowly. This is a great 

utility for a Mac user who needs to run DOS or Windows applications 

occasionally.  

Real-Time Operating System 

A real-time operating system (RTOS) is a class of operating system intended for real-time 

applications. Such applications include embedded (programmable thermostats, household 

appliance controllers, mobile telephones), industrial robots, spacecraft, industrial control (see 

SCADA), and scientific research equipment. 

An RTOS facilitates the creation of a real-time system, but does not guarantee the final 

result will be real-time; this requires correct development of the software. An RTOS does not 

necessarily have high throughput; rather, an RTOS provides facilities which, if used properly, 

guarantee deadlines can be met generally (soft real-time) or deterministically (hard real-

time). An RTOS will typically use specialized scheduling algorithms in order to provide the 

real-time developer with the tools necessary to produce deterministic behavior in the final 

system. An RTOS is valued more for how quickly and/or predictably it can respond to a 

particular event than for the given amount of work it can perform over time. Key factors in an 

RTOS are therefore a minimal interrupt latency and a minimal thread switching latency. 
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An early example of a large-scale real-time operating system was the so-called "control 

program" developed by American Airlines and IBM for the Sabre Airline Reservations 

System. 
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Competency Level  5.2 :  Adopts Graphical User Interface to meet ones own needs. 
 
Activity 5.2 : Let’s explore the operating system.  
 
Time  : 120 minutes.  
 
Quality Inputs  : ● Four copies of instructions for group exploration in Annexe 5.2.1 

● Four copies of the reading material in Annexe 5.2.2 

Learning-Teaching Process: 
Step 5.2.1 : ●   Get three volunteers to explain how they  operate the following. 

o A Radio  

o A TV  

o A computer 

o An ATM 

   ●    Conduct a discussion to highlight the following.    

   

 
 
 
 
 

 
 
 

 
 
 

(15 minutes) 
 
Step 5.2.2 : ●    Divide the class into four groups. 

●    Provide each group with the screen layout of GUI desktop and  

      instructions for exploration.  

●    Involve the groups in the exploration. 

●    Prepare them for a presentation. 

 (45 minutes) 

 
 
 

● To use a system there should be an operating system. 

● An Operating system creates the user interface required to 

communicate with a system. 

● The user communicates with a computer through a graphical 

user interface (GUI). 

● The computer operating system links the user with computer 

hardware and software. 

 
Competency 5 :  Works effectively with operating systems 
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Step 5.2.3 : ● Get each group to present its findings. 

  ● Invite the presenters themselves to conduct the first elaboration. 

  ● Request other groups to submit their constructive comments. 

  ● Conduct a discussion to highlight the following 

   
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 

• Desktop contains the following items.  

o  Wallpaper 
o  Icons 
o  Task bar 
o  Start button 

• Icons represent files or programs, which can be arranged to 

meet user needs. 

• Icons related to programs can be opened by double clicking 

same. 

• Any program opens as a window. 

• Basically any window contains  

o Title bar, Menu bar, Tool bars and Scroll bars 

o Minimize, Maximize / Restore, Close buttons 

• Windows can be minimized, maximized, restored, moved, 

closed and resized. 

• A number of programs can be handled simultaneously. 

• Opened programs and files appear as buttons on the task 

bar.  

• Some windows cannot be maximized or resized. 

• Start button in the task bar is used to launch programs. 

• The control panel window provides several tools to customize 

the system settings and to elicit information about the 

following: 

o System date and time. 

o Operating System, Processor type, Processor speed and 

Memory capacity (RAM) 

o Wallpaper, screen saver, appearance and other settings. 

• Properties of any storage device contain its capacity, used 

space, free space, file system and volume label. 

• Windows explorer displays drives, folder structure and files.  
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(60 minutes) 

 
Criteria for assessment and evaluation 

●     Names the main features of a GUI and explains them.  

●     Accepts that a GUI can be adjusted according to user needs. 

●   Makes maximum use of computer operating system efficiently. 

●     Customizes ones working environment. 

●     Develops self-learning skills. 
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Annexe 5.2.1 
 

 
Instructions for the Group Exploration 

 
• You will be working in four groups with the following four topics distributed randomly 

across the groups. 

o Graphical User Interface and its components (for all groups) 

o Manipulating windows, changing the desktop properties 

o Changing the appearance of windows  

o Changing screen resolution & system date & Time, Regional Settings. 

o Customize the Start Menu and My Computer. 

• Go through the reading material and get a good idea of the assigned area. 

• Move to the computer lab, boot the computer and explore the components of GUI. 

• Carry out the practicals on the computer following the graded directions and view how 

changes take place. 

• Be prepared to share your experiences and findings with the class at the plenary session 
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Annexe 5.2.2 
Reading Material 

Graphical User Interface 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
What is a User Interface? 
 
The user interface is the junction between a user and a computer program. An interface 
is a set of commands or menus through which a user communicates with a program. The 
interface is how you interact with the computer.  
 
What is a graphical user interface (GUI) 
 
A user interface based on graphics (icons and pictures and menus) instead of text; uses a 
mouse as well as a keyboard as an input device 
 
 
Pointer 
 
A symbol that appears on the display screen which you move to select objects and 
commands. Usually, the pointer appears as a small angled arrow. Text -processing 
applications, however, use an I-beam pointer that is shaped like a capital I.  
 

Desktop 

Icons Window 

Menu 

Start Button 
Minimized Window 

Task Bar 
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Title Bar Menu Bar Tool Bar Minimize Button 

Maximize / 
 Restore 
Button 

Close  
Button 

Window 
Frame 

Pointing device 
  
A device, such as a mouse or trackball enables you to select objects on the display screen.  
 
Icons 
 
Icons are the small pictures that represent commands, files, or, windows. By moving the 
pointer to the icon and pressing a mouse button, you can execute a command or convert the 
icon into a window. You can also move the icons around the display screen as if they were 
real objects on your desk.  
 
Desktop 
 
The area on the display screen where icons are grouped is often referred to as the desktop 
because the icons are intended to represent real objects on a real desktop.  
 
Windows 
 
You can open several windows in different areas of the screen. In each window, you can run 
a different program or display a different file. You can move windows around the display 
screen, and change their shape and size at will.  
 
Menus 
 
Most graphical user interfaces let you execute commands by selecting an item of your 
choice from a menu.  

Manipulating Windows 

Let’s identify the components of a window 
 
Open my computer icon on the desktop. You will see the following window  
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Some windows contain scroll bars when the entire contents of the window cannot be shown 
at the same time. By scrolling you will be able to see the contents that are hidden. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Note:  Some windows cannot be maximized or resized. (E.g. Calculator) 
 Start  All programs  Accessories  Calculator 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Moving a Window 

Click and hold the left mouse button on the title bar and drag the mouse pointer to 
any location on the desktop and release mouse button. 

 
Closing a window 
 Click on the close button at the right hand end of the title bar. 
 
Minimizing a window 

Click on the minimize button, the first button on the right hand corner of the title bar 
 (When a window is minimized it can be seen in the task bar as an icon.) 
Maximizing a window 

Click on the maximize button, the second button at the right hand end of the title bar 
  Or 
 Double click on the title bar. 

Vertical Scroll Bar 

Horizontal scroll bar 
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(When a window is maximized it covers the entire desktop. Clicking the same button 
or double clicking on the title bar can restore a maximized window.). 

 
Resizing a window 
 
 Move the mouse pointer to the frame of the window. Now the mouse pointer changes 
its shape to a double-headed arrow. ( ) Click and hold the left mouse button and drag the 
mouse in any direction (up, down, left, right). 
 You can change the width and height of the window at the same time by clicking and 
dragging at the corner of the window. 
 

Changing the desktop and its properties 
 
Moving the icons on the desktop 
 

o Move the mouse pointer on to an icon,  
o Press and hold the left mouse button on the icon and drag the icon to a new location 

  
How to arrange the icons on the desktop 
 

o Right click on the desktop 
o Move the mouse pointer over Arrange 

Icons By and a submenu will appear; 
here you can sort your desktop icons by 
name, size, type and the last modified 
date. 

 
o Selecting the Auto Arrange option will 

automatically align your desktop icons 
every time you add one to the desktop.  

 
o The Desktop Cleanup Wizard will remove any desktop shortcuts that have never 

been used to a new folder on your desktop called Unused Desktop Shortcuts. 
 
How to change the desktop 
Start  Control Panel  Display 
  Or 
Right click on the desktop and click on properties in the 
shortcut menu 

Click on the Desktop tab, do one or more of the 
 following:  

o Click a picture in the Background list. In 
Position, click Center, Tile, or Stretch.  

o Select a color from Desktop color. (The 
color fills the space not used by a 
picture.) 

o Click Apply  Ok 
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How to change the screen saver 
Start  Control Panel  Display 

Or  
Right click on the desktop and click on properties in the shortcut menu 

Click on the Screen Saver tab,  
o Select a screen saver from the screen saver list 
o Click Apply  Ok 

 
How to change the screen resolution 

Start  Control Panel  Display 
Or  

Right click on the desktop and click on properties in the shortcut menu 
Click on the Settings tab,  

o Under Screen resolution, drag the slider, and then click Apply.  
When prompted to apply the settings, click OK. Your screen will turn black for 
a moment. Once your screen resolution changes, you have 15 seconds to 
confirm the change.  

o Click Yes to confirm the change; click No or do nothing to revert to your 
previous setting.  

 
 
How to change the appearance of windows 
 
Start  Control Panel  Display 
Or 
Right click on the desktop and click on properties in the shortcut menu 
 

Click on the Appearance tab,  
o Under windows and buttons, select Windows classic or Windows XP style 
o Select a color scheme  
o Select a suitable color scheme 
o Click Apply, Click Ok. 

 
Changing System Date 
 
Start  Control Panel  Date and Time 
Or  
Double click in the far right hand corner of the task bar 
where the time is shown 
 Click on the Date and Time tab, 
 

o To change the month, click the arrow in the month list, and then click the 
correct month.  

o To change the year, click the arrows in the year list.  
o To change the day, click the correct day on the calendar.  
o Click Apply, Click Ok. 

To change time 
o Click on the area where the hours are shown, click up arrow, to increase 

hours, click down arrow, to decrease hours 
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o Click on the area where the minutes are shown, click up arrow, to increase 
minutes; click down arrow, to decrease minutes. 

o Click on the area where the seconds are shown, click up arrow, to increase 
minutes; click down arrow, to decrease minutes. 

o Click on the area where AM is shown, click the arrows to switch between AM 
or PM. 

 
The Start Menu  
Click on the start button at the left end of the task bar 
 
Now you will see the following menu 

 
 
 
 
 
 
 
 
 
 
 
 
Log off -    Log off the current user.  
Turn Off Computer -  shutdown, restart and  
                                               standby.  
All Programs -   Access to installed  
                                               programs.  
Run -     Used to manually start      
                                               executable files (programs).  
Search -    Search your PC for pictures, music, documents, files and  

folders.  
Help and Support -   Opens the built-in Windows help including various help topics 
Printers and Faxes -  Access to your printers and faxes folder, allows you to add and  

configure printers/faxes.  
Control Panel -  The control panel is used to configure various Windows XP 

settings,  
My Computer -   Gives you access to your computer's disk drives and files 
My Music -    Links to a folder created by Windows XP which is used (by  

default) to store any music files on your hard drive.  
My Pictures -  Links to a folder (again created by Windows XP) used (by 

default)  
to store any pictures/images on your hard drive.  

My Recent Documents -  This folder contains any recently viewed documents.  
My Documents -   Gives access to a folder created by Windows XP used  

(by default) to store any documents on your hard drive.  
Tour Windows XP -   Starts the built-in tour of Windows XP's features.  
Windows Movie Maker - Opens Windows XP's movie editing software.  
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My Computer 
Gives you access to disk drives and files of your computer. 
(Double click on the my computer icon to open my computer window) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Let’s see the capacity of the hard disk (C)  
 

Right click on the icon (C) and click on properties 
You will see a window similar to this. 
In this window (General tab) you can see the following things 
 

o Capacity of the hard disk 
o Used space 
o Free space 
o File system 
o Label of hard disk drive 
o (if label box is empty you can type a name for your 

hard drive, Click Apply  Ok) 
 
 

Let’s see what’s in drive C 
 
Double click on the icon, with label (C) 
 
 
 
 
 
 
 
 

File 

Folder 
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Changing the regional settings 
Changing the currency symbol 
 

o Start  Control Panel  Regional and language Options 
o Click on customize button in the Regional options tab 
o Click on Currency tab 
o Type or select the required currency symbol  
o Click Apply  Ok.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
Changing the date 

format 
 

o Start  Control Panel  Regional and 
Language Options 

o Click on customize button in the Regional 
options tab 

o Click on date tab 
o Select a suitable date separator ( / or – or . ) 
o Click Apply  Ok. 

 
 
 
 
 
 

 
 
 
 

How to view system properties  
Strart  Control Panel  System 
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In this window you can see the following: 
 

o Name of Operating System 
o Processor type 
o Processor speed 
o Memory capacity of computer (RAM) 
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Competency  5.3 : Handles files and folders in the Windows Operating System 
Activity 5.3 :   Let’s use files and folders to keep track of information.  

Time :   60 minutes. 

Quality Inputs :   ●   Two copies of the dialogue in Annexe 5.3.1 

     ●    Four copies of group exploration instructions in Annexe 5.3.2 

  ● Graded Directions on file and folder management in Annexe 5.3.3.  

  ●   Four computers containing a set of teacher created folders and  

   files.  

Learning – Teaching Process: 

Step 5.3.1 :   ●   Get two volunteers to present the dialogue to the class 

  ●   Conduct a discussion to highlight the following. 

 

 

 

 

 

 

 

 
 

(10 minutes) 

Step 5.3.2 :   ●   Divide the class into four groups. 

  ● Let the four groups to sit at the four computers. 

     ●   Distribute group exploration instructions and graded directions 
across the groups. 

     ●   Assign tasks and involve groups in the exploration. 

     ●    Prepare groups for a whole class presentation. 

 (30 minutes) 

Step 5.3.3     ●   Get each group to present its findings. 

  ●   Conduct a discussion to highlight the following. 

 
 

●    In normal life we prepare documents to keep track of 

information for future reference. 
●    Files help handle documents manually. 

●    Different files containing different documents are maintained 

for different purposes. 

● Files are stored safely in the file cabinet. 

●    Different shelves of a file cabinet are used to arrange files in 

some order.   

 
Competency 5 :  Works effectively with operating systems 
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(20 minutes) 

 
 
Criteria for assessment and evaluation  
 

●   Describes folders and files used in preparing documents. 

●   Accepts the importance of files and folders in organizing and ensuring security. 

●   Uses explorer and shortcut methods in handling files and folders 

●   Selects suitable methods in organizing tasks and activities.  

●   Asks questions to facilitate learning. 

 
 
 
 
 
 

● Files and Folders arranged in Windows Explorer are used to 

organize information. 

● Files store data or information in a computer  

● Each file is given a filename. 

● A Document is a file created in a Word Processor. 

● A folder can contain a number of files.  

●  Stored files can be seen in different views and can be 
arranged to suit ones convenience. 

  
●  A Folder or file can be 

o created 

o renamed 

o deleted 

o copied / moved from one location to another 

●  Deleted files and folders are temporarily stored in the 

Recycle Bin. 

●  Accidentally erased files or folders can be sent to their 

original location. 

●  Files and folders can be permanently deleted or removed 

from the Recycle Bin. 
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Annexe 5.3.1 
Dialogue 

 

Principal :  Mr. Wasantha! (Principal, summons clerk) 

Wasantha :  (Clerk enters the office) Yes sir,  

Principal :  Bring me the School Development Society file. 

Wasantha :  Here it is sir. 

Principal :  Let me have the letter summoning members to the last SDS meeting   

    (Clerk opens the file and produces the letter.) 

Wasantha :  Here it is sir. 

Principal :  Prepare a letter for this year’s meeting. Just make the necessary  

    alterations in this letter. 

Wasantha :  What are the adjustments to be made in this letter? 

Principal  :  Follow the standard system and left align the document.   

Wasantha  :  What about the date Sir? 

Principal  :  Make it 22 January, 2007.  

     Underline the subject SDS Meeting.  

Wasantha  :  What next, Sir?    

Principal  :  Print and file it.  

     Make sure it is in the post, tomorrow. 

Wasantha :  Very well,  Sir.   

 



G.C.E.(O/L) IT Teacher Instructional Manual 
 

 
 

 
National Institute of Education- 2007 

 
192

Annexe  5.3.2 

Instructions for the Group Exploration 

 

• You will be working in four groups with the following topics assigned randomly to four 

groups. (except first one) 

For all groups 

o Go through the graded directions to be familiar on opening the Windows 

Explorer and arranging of files, documents and folders   

 File management 

 Folder management 

 Document Handling 

 
o Use the Windows Explorer and become thorough with the following areas 

 Different views of Files & Folders 

 Arrange files & folders  

 Expand folder 

 Collapse folder 

 
o Carry out the following tasks  

 Create new folder 

 Rename folder 

 Move folder 

 Delete folder 

 
o Carry out the following tasks  

 Select file / Multiple files 

 Copy file / files 

 Move file / files 

 Delete file / files 

 
o Study the use of ‘Recycle Bin’.   

 Open Recycle Bin and look for the deleted files.   

 Send a file or folder deleted accidentally to the original location.  

 Delete the files permanently in the Recycle Bin. 
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Annexe  5.3.3 
Graded Directions 

 
For all groups 
 
It is essential for a computer user to manage files and folders in his/her computer. Windows 
Explorer has been around since Windows 95 and is a very handy tool for managing your 
files and folders.  
 
To Open Windows Explorer  
 Method 1  
         START  All Programs  Accessories  Windows Explorer.  
Method 2  
         START  run type explorer into the box and press enter.  
Method 3 
Right click on the start button  Click on Explore command in the shortcut menu that 
appears.  
 Now you will have a window similar to this 
You can see that Windows Explorer is split into two parts, the left hand side, which is called 
the folders list, and the right hand side, which is where you will be managing your files and 
folders.  

 
File 
A collection of data or information that has a name, called the filename. Almost all 
information stored in a computer must be in a file. There are many different types of files. 
 



G.C.E.(O/L) IT Teacher Instructional Manual 
 

 
 

 
National Institute of Education- 2007 

 
194

Document 
In computing, the term was originally used for a file created with a word processor. In 
addition to text, documents can contain graphics, charts, and other objects. 
 
Folder 
In graphical user interfaces such as Windows and the Macintosh, a folder is an object that 
can contain files. Folders are used to organize information. In the DOS and UNIX worlds, 
folders are called directories.  
 
 
How to change the view of files and folders in right pane 
Click View and select one of the following 
Large Icons, Small Icons, List, details or thumbnails.  
 
 

 
 
 
 
 
 
Thumbnails  

 
 
 
 
 
 
 

 
 
 
Details  
 
 
 
 
 
 
Large Icons  
 
 
 
 
. 
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Selecting a file or folder  
• Click on the file or folder  

 
How to arrange files or folders in the left pane 
In the details view  

• Click on Name button to arrange the files in ascending order of the file name. 
Clicking the name button again will arrange the files in descending order of the file 
name 

• Click on Type button to arrange the files in ascending order of the file type. Clicking 
the Type button again will arrange the files in descending order of the file type 

• Click on Size button to arrange the files in ascending order of the file size. Clicking 
the Size button again will arrange the files in descending order of the file size 

 
• Click on Modified button to arrange the files in ascending order of the file 

modification date. Clicking the Modified button again will arrange the files in 
descending order of the file modification date 

 
 

 
 
 
 
Expanding a folder 
In front of some folder icons in the left pane, you 
may have noticed the small plus sign (+). This 
indicates that the drive/folder has more folders 
inside it.  
 To see the folders inside, click on the plus 
sign. This is called expanding a folder. 
Collapsing a folder. 

 If a folder is expanded the plus sign changes to a (- ) sign. Clicking on this minus 
sign hides all the folders inside this folder. 
 
 
Creating a new folder 
Select the folder or drive in the left pane of the explorer window by clicking on it. 

• Select File  New  Folder 

Name  Size Type Modified 
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• Now you will have a icon in the right hand pane named new folder 
• Type a suitable name for the folder 
• Press enter 
 

Renaming a folder 
• Right click on the folder you want to rename 
• Click on Rename command in the shortcut menu 
• Type a new name  
• Press enter. 

Deleting a folder 
(Note: When you delete a folder all the files and sub folders inside it will also be deleted.) 

• Select the folder to be deleted 
• Press Delete Key. 
• Click Yes 

Moving a folder 
• Select the folder to be moved 
• Edit  Cut 
• Select the drive or folder under which you want to place the folder 
• Edit  Paste 

Renaming a file 
• Right click on the file you want to rename in the right pane of the explorer window 
• Click on Rename command in the shortcut menu 
• Type a new name  
• Press enter. 

 
Selecting multiple files 
To select adjacent files 

• Click on the upper file name of the file range you want to select 

• Holding down the shift key, click on the lower file name of the file name you want to 

select 
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To select non –adjacent files 

• Click on each file name while holding down CTRL key. 

 
Deleting a file or files 

• Select the file or files to be deleted 
• Press Delete Key. 
• Click Yes 

 
Copying a file or files  

• Select the file or files to be copied 
• Edit  Copy 
• Select the drive or folder under which you 

want to place the files 
• Edit  Paste 

 
Moving a file or files  

• Select the file or files to be moved. 
• Edit  Cut 
• Select the drive or folder under which you want to place the files 
• Edit  Paste 

 
To display file or folder properties.  
 

• Right click on the file or folder. 
• Click on Properties command in the shortcut command. 
• Now you will see a window similar to this. 
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. 
Recycle Bin 
 
An icon on the desktop that represents a directory where deleted files are temporarily stored. 
This enables you to retrieve files that you may have accidentally deleted.  
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Double click on the recycle bin icon in the desktop to view deleted files 
 

If you accidentally delete a file 

o Locate the file icon in the recycle bin 

o Right click on the icon and click on restore command in the shortcut menu. 

By clicking restore all button in the recycle bin window you can restore all the deleted files 

to their original locations.    

Deleting a file permanently 
o Select the file in the recycle bin 

o Press Delete Key. 

o Click Yes 

To remove all the files in the recycle bin 
o Click on Empty Recycle Bin button in the recycle bin window. 

o Click Yes. 

 
 

Recycle Bin 
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Competency Level  6.1 :  Explores the concept and features of Word Processing 
Activity 6.1 :   Let’s explore word processor. 

Time :   120 minutes. 

Quality Inputs :   ●   Four copies group exploration instruction in Annexe 6.1.1 

  ● Four copies of labeled diagram of starting window of word  

   processing application in Annexe 6.1.2  

  ● Four copies of labeled diagram of Keyboard layout and list of 

symbols in Annexe 6.1.3 

 ● Demy sheets and markers. 

Learning – Teaching process: 
 Step 6.1.1 :   ●   Initiate discussion of an invitation to a recent function/event   

   e.g. Year-end party. 

● Ask students to prepare an invitation for the weekly fair to be    

 held at 10a.m. the following day. 

● Lead a discussion to highlight the following. 

 

 

 

 

 

 

 

 

 

 

 

 

 

(20 minutes) 

 
Step 6.1.2 :   ●   Divide the class into four groups. 

● Distribute the copies of labeled diagram to the groups. 

  ●    Assign the 16 features equally to the groups. 

  ●    Get groups to study the features. 

 
Competency  6 :  Uses Word Processing Software To Solve Day-To-Day  
    Problems. 

● There are different handwriting styles, letter sizes and  

   colours, in each invitation.  

● Each format varies from the other. 

● Pictures drawn for the invitation by unskilled persons   

   look unattractive. 

● This manually prepared invitation is difficult to edit or   

   modify. 

● Depending on the number of invitations, each copy  

   needs to be duplicated manually.  

● Therefore this is time consuming. 

● The computer can help eliminate the difficulties above. 
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  ●    Help groups to start the word processing package and study  

   the features on the screen as well.  
  ●    Prepare groups for a whole class presentation.      

 (20 minutes) 
Step 6.1.3 :   ● Get each group to present its findings. 

       ●  Lead a discussion to highlight following. 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

(40 minutes) 
 
 
Step 6.1.4. : ● Provide copies of labeled diagram of keyboard. 

● Let the students do the activity.  

(20 minutes) 

 

 

   ●   Word Processing application can be used to create  

documents electronically.  

   ●   Title bar displays the title of the document 

   ●   There are a number of menus in the menu bar. 

   ●   Many tools are available in a word processor. 

o The Standard Tool bar and Formatting tool bar are very  
 important in creating documents. 
o The tools in the tool bars are available in the  
     menus also. 

   ●   The margins of the documents are displayed on the rulers. 

   ●   There are a number of buttons in the document window. 

o Minimize button is used to minimize the document. 
o Maximize/Restore button is used to Maximize and   
 Restore the document. 
o Close button is used to close the application. 
o Close button below the title bar is used to close  
 the document. 

   ●   Scroll bars are used to scroll the document. 

   ●   Drawing tools are available in the drawing tool bar. 

   ●   Status bar displays the status of the document. 

   ●   Editing (working) area is used to type and edit documents. 
   ●   The small blinking vertical bar in the editing area is called   

        cursor or insertion point which appears like an I, in the   

        editing area when the mouse pointer is moved. 
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Step 6.1.5 : ● Request each group to present its findings. 

  ● Lead a discussion to highlight following. 

  

 

 

 

 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 

 

 

(20 minutes) 

Criteria for assessment and evaluation 
● Names the components of the screen layout. 

● Accepts the need to produce documents electronically rather than manually. 

● Uses keyboard in word processing. 

● Expresses one’s own ideas freely, clearly and pleasantly. 

● Plans tasks for improved efficiency and effectiveness. 

 
 
 
 
 
 
 

• Enter key (or Return key) is used to move to the next 

line. 

• Caps Lock key is used to type Uppercase letters.  

• Shift is used with another key to capitalize a letter and 

print the characters on the top of the key.  

• Space bar is used to provide space. 

• Backspace is used to erase characters or reduce space 

to the left of the cursor. 

• Delete is used to erase the character or reduce space 

next to the cursor. 
• Tab key is used to move the cursor to a pre-determined 

position. 

• Arrow keys/Cursor keys move the cursor in the direction 

of the arrow, without deleting any characters or spaces. 

• Numeric keypad is easy to use when typing numbers 

continuously.  

• Insert key has two modes – insert mode and replace 

mode.  

• Function keys perform special functions according to   

application. 
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Annexe 6.1.1 
 

Instructions for the Group Exploration 
 

• You will be working in four groups with the following four sets of topics distributed 

randomly across the groups.  

 
° Title Bar 

° Menu Bar 

° Standard Toolbar 

° Formatting Toolbar 

 

° Vertical Ruler 

° Horizontal Ruler 

° Working Area 

° Margins 

  

° Minimize Button 

° Maximize/Restore Button 

° Word Close Button 

° Document Close Button  

 

° Vertical Scroll Bar 

° Horizontal Scroll Bar  

° Drawing Tool Bar 

° Status Bar 

 

• Move to the computer lab, explore the keyboard, compare same with diagram provided 

and identify keys.  

• Boot computer and load word processor. 

• Go through the reading material and get a good idea of the assigned area. 

• Practice typing your own words and symbols on the word processing application using all 

the keys.  

• Be prepared to share your experiences and findings with the class at plenary session. 
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Annexe 6.1.2 
 

Starting a word processing package (MS Word) 
Click START button from the task bar 

Move to programs  Microsoft Office  Microsoft Word( Click) 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
. 
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Screen layout (Start up window) of Microsoft Word 

 
 
 

 
 
 
 

1. Title Bar 

2. Menu Bar 

3. Standard Toolbar 

4. Formatting Toolbar 

5. Vertical Ruler 

6. Horizontal Ruler 

7. Working Area 

8. Margins 

9. Minimize Button 

10. Maximize/Restore Button 

11. Word Close Button 

12. Document Close Button  

13. Vertical Scroll Bar 

14. Horizontal Scroll Bar  

15. Drawing Tool Bar 

16. Status Bar 

8 

4 5 
76 3 2 1 

12 

13 14

9

10 

11 

15 16 
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Labeled diagram of Keyboard layout 
 

Annexe 6.1.3 
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Keyboard symbols 
 
 

~  Tilde 
!    Exclamation Point 
@  At 
#   Number or Hash  
$   Dollar 
%  Percent 
^   Caret or Hat  
&   Ampersand 
*   Asterisk 
(   Open or Left Parenthesis 
)   Close or Right Parenthesis 
_   Underscore or Horizontal Bar 
+   Plus 
`   Acute 
-   Dash or Hyphen 
=  Equals 

{  Open or Left Curly Brace 
}  Close or Right Curly Brace 
[  Open or Left Square Bracket 
]  Close or Right Square Bracket 
:  Colon 
"  Quote 
|  Or or Vertical Bar 
;  Semi Colon 
'  Apostrophe or Single Quote 
\  Backslash 
< Less Than 
> Greater Than 
? Question Mark 
,  Comma 
.  Dot, Period or Full Stop 
/  Forward Slash 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Competency  6 :  Uses Word Processing Software To Solve Day-To-Day  
    Problems. 
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Competency Level  6.2 :  Performs basic tasks in Word Processing.   
Activity 6.2 :   Let’s acquaint ourselves with word processing. 

Time :   120 minutes.  

Quality Inputs :   ●   Two copies of the dialogue in Annexe 6.2.1. 

   ● Three copies group exploration instructions in  

Annexe 6.2.2 

   ●   Three copies of the Graded Directions in Annexe 6. 2. 3. 

     ● Three computers with three floppy disks each containing a self 

prepared multiple page document named Text1.doc.  

  ● Demy sheets and pastel. 

Learning –Teaching Process: 

Step 6.2.1 :   ●   Get two volunteers to present the dialogue to the class. 

     ●   Conduct a discussion to highlight the following. 

 

 

 

 

 

 

 

 

 

 

 

(15 minutes) 

Step 6.2.2 :   ●   Divide the class into three groups. 

     ●   Provide each group with copies of group exploration  

       instructions, graded directions, demy sheets and markers. 

     ●   Direct the groups and involve them in the exploration. 

  ●   Prepare them for a whole-class presentation. 
       (75 minutes) 

 
 
 

●    A new file is opened to store information on each student 

admitted to the school.   

● Documents in this file could be referred or retrieved at any 

time.  

● Systematic filing on the basis of aspects such as admission 

number and year of admission provides easy access to files. 

● File cover sizes vary to suit standard paper sizes used in 

documents.  

● Word Processing enables the above manual tasks to be 

performed both efficiently and effectively. 
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Step 6.2.3 :   ●   Get each group to present its findings. 

  ●   Provide opportunity for the presenters themselves to  

            elaborate  on their findings. 

                                    ●  Invite constructive comments from the other groups. 

  ●   Conduct a discussion to highlight the following.  

     
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

● There are a number of ways to open, close or save a 

document in word processing  

● A new blank document can be opened by 

o      Using file menu. 

o      Clicking on the ‘New Blank Document’ icon in the       

                 standard   tool bar     

o Using Key strokes  
● A document that already exists in storage media can be 

opened by 

o Using file menu. 

o Clicking on the ‘Open’ icon in the standard tool bar. 

o Using Keystrokes. 

●  Usually documents are saved for future reference. 

●     A document can be saved  by 

o Using file menu 

o Clicking on the icon in the standard tool bar 

o Using Key strokes  

●  When we save a new document for the first time we must 

go through the menu ‘ File --> Save as’.  

●  A document can be closed by 

o Using file menu 

o Clicking on the ‘Close window’ button, at the right end 

of the menu bar. 

o Using Key strokes ‘Ctrl+F4’ 
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(30 minutes) 
Criteria for Assessment and Evaluation  
 

●   Names basic tasks of Word Processing and describes them. 

●   Accepts the importance of attending to basic tasks in producing a quality     

     document. 

●   Uses basic features available in word processing to create and store files.  

●   Engages in tasks fully aware of the options available to perform them. 

●   Takes precautions to avoid wastage of time, energy and other resources. 

 

 

 

 

 

●  Word Processing application can be closed by 

o Using file menu 

o Clicking on the ‘Close’ control button at the right end 

of the title bar. 

o Using Key strokes ‘Alt+F4’  

●  Margin and the paper size can be changed using Page  

  Setup in the File menu   

●  Margins can be adjusted using Ruler in the print layout 

view or print preview.    

●  Standard paper sizes can be selected or customized in 

the page setup.     

●  An entered text can be edited by deleting, copying or 

moving. 

●  Copying or moving is done using 

o edit menu 

o standard toolbar 

o drag and drop method  

o key strokes 

o context menu (short cut menu)     
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Annexe 6. 2. 1 
Dialogue 

 
Office Assistant :  What can I do for you?  

Student :  I came to fetch my school leaving certificate.  

Office Assistant :  Do you remember your Admission Number and the Year you left  

    school? 

Student :  Yes of course.  My admission number is 26589 and I left school in  

    2003. 

Office Assistant :  Hold on a little.  I will look for your file.  

  (Rifles in the cabinet and pulls out the file)  

Student : Why are the files in the cabinet of different sizes?   

Office Assistant : Papers are of standard size. A3 papers are larger than A4 papers.  

  Documents in A3 papers, therefore, need larger files.   

Student : Now I understand why birth certificates need larger files.  

Office Assistant : Here is your file, but your birth certificate is missing.  You may have  

  taken it earlier.  

Student :  Yes, now I remember.  I took it for the circuit sports meet two years  

    ago. 

Office Assistant :  OK, then I will submit your file to the principal.  

 

 

 

 

 

 

 

 

 

 

 

 
 
. 
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Annexe 6.2.2 
Instructions for the Group Exploration 

 
• You will be working in three groups with the following three topics assigned randomly 

to the groups.  

o Identifying paper size and setting margins 

o Print previewing and adjusting margins 

o Entering and Editing text 

• Go to the computer assigned to your group. 

• Open the soft copy of Text1.doc stored in your computer. 

• Go to the end of the page and type the names of your group members along with the 

name of your school. 

• Close Text1.doc and create a new document. 

• Discuss the task assigned to your group with the others in the group.   

• Follow the graded directions and complete the task to the best of your ability.  

• Write down the steps you followed, on the demy sheet given. 

• Also write down the problems encountered and what you did to overcome them. 

• Save the new document as Text2.doc. on the Desktop and in the given floppy disk.   

• Be prepared to present your findings at the plenary session.  
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Annexe 6.2.3 

Graded Direction 

Word Processing using Microsoft Word 2003/2002 for Windows 
This tutorial teaches Microsoft Word basics. Although knowledge of how to navigate in a 
Windows environment is helpful, this tutorial was created for the computer novice. To begin, 
open Microsoft Word. Your screen will look like the one shown here. 

 
Click the X in the upper right corner of the New Document pane to close the New Document 
pane. Your screen will then look like the one shown here. 

  

The Ruler  
 

The ruler is generally found below the main toolbars. The ruler is used to change the format 
of your document quickly. To display the ruler:  
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1. Click View on the Menu bar.  
2. The option Ruler should have a check mark next to it. If it has a check mark next to it, 

press Esc to close the menu. If it does not have a check mark next to it, continue to 
the next step.  

3. Click Ruler. The ruler now appears below the toolbars.  

Document View  
In Word, you can display your document in one of five views: Normal, Web Layout, Print 
Layout, Reading Layout, or Online Layout.  
Normal View  

Normal view is the most often used and shows formatting such as line spacing, font, 
point size, and italics. Word displays multiple-column text in one continuous column.  

Web Layout  
Web layout view enables you to view your document as it would appear in a browser 
such as Internet Explorer.  

Print Layout  
The Print Layout view shows the document as it will look when it is printed.  

Reading Layout  
Reading Layout view formats your screen to make reading your document more 
comfortable.  

Outline view  
Outline view displays the document in outline form. Headings can be displayed 
without the text. If you move a heading, the accompanying text moves with it.  

Word 2002  
In Word 2002, you can display your document in one of four views: Normal, Outline, Page 
Layout, or Online Layout. 
Normal view  

Normal view is the most often used and shows formatting such as line spacing, font, 
point size, and italics. Word displays multiple-column text in one continuous column.  

Outline view  
Outline view displays the document in outline form. Headings can be displayed 
without the text. If you move a heading, the accompanying text moves with it.  

Print Layout view  
The Print Layout view shows the document as it will look when it is printed.  

Online Layout view  
The Online Layout view optimizes the document for online viewing (viewing the 
document in a browser such as Internet Explorer).  

Before moving ahead, check to make sure you are in Normal view:  

1. Click View on the Menu bar.  
2. The icon next to Normal should have a box around it. If the icon next to normal has a 

box around it, press Esc to close the menu. If the icon next to Normal does not have 
a box around it, continue on to the next step.  

3. Click Normal. You are now in Normal view.  



G.C.E.(O/L) IT Teacher Instructional Manual  

National Institute of Education- 2006 192

Text Area  

 
 
Just below the ruler is a large area called the "text area." You type your document in the text 
area. The blinking vertical line in the upper left corner of the text area is the cursor. It marks 
the insertion point. As you type, your work shows at the cursor location. The horizontal line 
next to the cursor marks the end of the document. 

Exiting Word  
You have completed Lesson One. Typically, you would save your work before exiting. This 
lesson does not require you to enter any text, so you might have nothing to save. To exit 
Word:  

1. Click File.  
2. Click Exit, which can be found at the bottom of the drop-down menu.  
3. If you have entered text, you will be prompted: "Do you want to save changes to 

Document1?" To save your changes, click Yes. Otherwise, click No.  
4. Specify the correct folder in the Save In box.  
5. Name your file by typing lesson1.doc in the File Name field.  
6. Click Save.  

Things You Need to Know  

This lesson instructs you on how to set up your computer so that you can compete the 
lessons that follow successfully and it provides you with background information on Microsoft 
Word. To begin the lesson, open Microsoft Word. 

Click 
During the lessons that follow, you will be asked to "click" items. When asked to click: 

1. Point to the item.  
2. Press your left mouse button once.  

If you are asked to double-click an item:  
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1. Point to the item.  
2. Quickly press your left mouse button twice.  

If you are asked to right-click: 

1. Point to the item.  
2. Press your right mouse button.  

Options  
The following is an introduction to various features of the Microsoft Word screen.  
Status Bar  

 
The Status bar appears at the very bottom of the screen and provides such information as 
the current page, current section, total number of pages, inches from the top of the page, 
current line number, and current column number. The Status bar also provides options that 
enable you to track changes or turn on the Record mode, the Extension mode, the Overtype 
mode, and the Spelling and Grammar check.  
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Word 2002 

The Status bar for the 2002 version of Word includes WordPerfect help, but does not include 
Spelling and Grammar check. 

Horizontal and Vertical Scroll Bars  

 
The Horizontal and Vertical scroll bars, if turned on, enable you to move up and down or 
across the window simply by pressing the icons located on the scroll bars. The Horizontal 
scroll bar is located above the Status bar. The Vertical scroll bar is located along the right 
side of the screen. To move up and down your document, click and drag the Vertical scroll 
bar up and down. To move back and forth across your document, click and drag the 
Horizontal scroll bar. 
Nonprinting Characters  
Certain characters do not print but do affect the document layout. You can elect to see these 
characters on the screen as you type or have them remain invisible. For these lessons, you 
should opt to see them onscreen. Here are most of them: 

 

Denotes a tab  

.. 

Denotes a space 

¶ 

Denotes the end of a paragraph 



G.C.E.(O/L) IT Teacher Instructional Manual  

National Institute of Education- 2006 195

.... 

Denotes hidden text 

To show non-printing characters: 

1. Click Home  
2. Click the Show/Hide button. The button is orange.  

Recently Used File List  

 
If you enable the recently used file list, clicking File displays the most recently opened files 
near the bottom of the drop-down menu. You can click the file name to open the file quickly. 
Setting Options  
Before proceeding, turn on the Status bar, Horizontal scroll bar, Vertical scroll bar, 
nonprinting characters, and the recently used file list. Follow the procedure outlined here:  

1. Click Tools on the Menu bar.  
2. Click Options.  
3. Click View to choose the View tab.  
4. In the Show frame, check to see if there are checks next to Status Bar, Horizontal 

Scroll Bar, and Vertical Scroll Bar.  
5. If all these items do not have check marks, go to the box next to the unchecked 

item(s) and click the left mouse button.  
Note: You toggle the check mark on and off by clicking the left mouse button.  

6. In the Formatting Marks frame, check to see if there is a check mark next to All.  
7. If there is no check mark next to All, go to the box next to All and click the left mouse 

button. A check mark will now appear.  
8. Click General to choose the General tab.  
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9. Check to see if there is a check mark next to the Recently Used File List. If there is 
no check mark, go to the box next to Recently Used File List and click the left mouse 
button. Check to see if the number in the Entries box is at least four. If it is not, type 4 
in the box.  

10. Check to see if Inches is selected in the Measurement Units box (this sets the unit of 
measurement for the ruler). If it is not, click the pull-down menu and then click 
Inches.  

11. Click OK to close the dialog box.  

New blank document 

To open a new blank document  

Click on the New icon from the standard tool bar. 
 

 

Or select File > New from the menu 

Or Use Keystrokes ‘Ctrl+N’ 

 

Highlighting Text  
Throughout these lessons, you will be asked to highlight text. You can use either of the 
following methods:  
Highlighting by Using the F8 and Arrow Keys  

1. Place the cursor before or after the text you wish to highlight and click the left mouse 
button.  

2. Press the F8 key, which will serve as an "anchor" showing where text you wish to 
highlight begins or ends.  

3. Press the appropriate arrow key (left arrow to move to the left or right arrow to move 
to the right) until the text is highlighted. You can use the up or down arrow key to 
highlight one line at a time. Press Esc to remove the anchor.  

 
Highlighting by Using the Mouse  

1. Place the cursor before or after the text you wish to highlight.  
2. Hold down the left mouse button.  
3. Move the mouse left, right, up, or down until the text is highlighted.  

Highlighting Menu Items  
Menu Bar  
To select a Menu bar item: 

1. Click the Menu bar item. A drop-down menu will appear.  
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2. To change the Menu bar option selected, move the mouse pointer across the Menu 
bar. 
Note: After you highlight an item on the Menu bar, you can also use the left and right 
arrow keys to move across the Menu bar.  

Drop-Down Menu Items  
When you click any option on the Menu bar, a drop-down menu appears. To choose a drop-
down menu item: 

• Click the drop-down menu item.  

Or 

1. Use the arrow keys to move up or down the drop-down menu.  
2. Press Enter to select a drop-down menu item.  

Placing the Cursor  
During the lessons, you will often be asked to place the cursor at a specific location on the 
screen. You place the cursor by moving the cursor to the specified location and pressing the 
left mouse button or by using the arrow keys to move to the specified location. 

Choosing Menu Commands by Using the Alt Key  
There are many methods to accomplish tasks when you are using Microsoft Word. 
Generally, when selecting items from the menu, we will ask you to click or highlight the menu 
item. However, you can also select a menu option by: 

1. Pressing the Alt key while typing the underlined letter on the Menu bar.  
2. Typing the letter underlined on a drop-down menu. If a dialog box appears, you can 

move around the dialog box by pressing the Alt key and any underlined option.  

Shortcut Key Demonstration  

1. Hold down the Alt key and press "o" to select Format from the menu.  
2. Press "p" to select Paragraph from the drop-down menu.  
3. Hold down the Alt key and press "i" to select the Indents and Spacing tab.  
4. Hold down the Alt key and press "b" to select Before from the Spacing frame.  
5. Press Enter to close the dialog box.  

Shortcut Notations  
A key name followed by a dash and a letter means to hold down the key while pressing the 
letter. For example, Alt-o means you should hold down the Alt key while pressing "o." A 
shorthand notation of the above demonstration would read as follows:  

1. Press Alt-o, p.  
2. Press Alt-i.  
3. Press Alt-b.  
4. Press Enter.  

Typists who are slowed down by using a mouse usually prefer using keys.  
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Typing and Using the Backspace Key  
The exercises that follow will teach you how to enter and delete text. To enter text, simply 
type just as you would if you were using a typewriter. To capitalize, hold down the Shift key 
while typing the letter. Use the Backspace key to delete text. You do not need to press Enter 
to start a new line -- Microsoft Word automatically wraps at the end of the line. Press Enter 
to start a new paragraph.  
Exercise 1  

1. Type the following sentence:  
Joe has a very large house.  

2. Now delete the word "house." Using either the arrow keys or the mouse, place the 
cursor between the period and the "e" in "house."  

3. Press the Backspace key until the word "house" is deleted.  
4. Type boat. The sentence should now read: 

"Joe has a very large boat."  

 

The Delete Key  
You can also delete text by using the Delete key. First, highlight the text you wish to delete; 
then press the Delete key.  
Exercise 2  
Delete the word "very" from the sentence you just typed. 

1. Highlight the word "very." Place the cursor before the "v" in the word "very" and press 
the F8 key. Then press the right arrow key until the word "very" is highlighted.  

2. Press the Delete key. The sentence should now read:  
"Joe has a large boat."  

Inserting Text  
You can insert text. To insert text, you must be in the Insert mode. To check to see whether 
you are in the Insert mode, look at the Status bar, located at the very bottom of the screen. 
Look at the right side of the Status bar. If the letters "OVR" are gray, you are in the Insert 
mode. If the letters "OVR" are black, you are in the Overtype mode.   

 
Insert Mode 

 
Overtype Mode 

To change to the Insert mode:  

1. Double-click the letters "OVR."  
2. The letters "OVR" are now gray.  

 
Alternate Method -- Setting Options by Using the Menu 
You can also use the menu to change to the Overtype mode.  



G.C.E.(O/L) IT Teacher Instructional Manual  

National Institute of Education- 2006 199

1. Choose Tools > Options from the menu. The Options dialog box opens.  
2. Click the Edit tab to choose the Edit tab.  
3. The Overtype Mode box should be blank. If the box is blank, click OK.  
4. If the Overtype Mode box is not blank, click the box to remove the check mark. Then 

click OK.  

Alternate Method -- Setting Options by Using Key 
 You can use the keyboard to change to the Overtype mode. 

1. Press Alt-t, o.  
2. Click Edit.  
3. Press Alt-v (toggles between overtype and insert).  
4. Press Enter.  

Exercise 3  
Make sure the letters "OVR" are gray before proceeding. You are going to insert the word 
"blue" between the words "large" and "boat."  

1. Place the cursor after the dot between the words "large" and "boat."  
2. Type the word blue.  
3. Press the spacebar to add a space.  
4. The sentence should now read:  

"Joe has a large blue boat."  

Overtype  
You can type over the current text (replace the current text with new text). However, you 
must be in the Overtype mode. Do the following to change to the Overtype mode.  

1. Double-Click "OVR" on the Status bar.  
2. The letters "OVR" should now be black.  

Make sure the letters "OVR" are black before proceeding to the following exercise.  
Exercise 4  
Change the word "blue" to "gray."  

1. Place the cursor before the letter "b" in "blue."  
2. Type the word gray.  

The sentence should now read:  
"Joe has a large gray boat." 
 

Saving a File  

You must save your files if you wish to recall them later. Before you can save, you must give 
your file a name. To save your file and close Word, follow the instructions given here:  

1. Choose File > Save As from the menu.  

2. Specify the correct folder in the Look In box.  

3. Name your file by typing in the File Name box. 

4. Click Save.  
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Or 

 

 

 

 

 

 

 

Or 

 

 

Select save icon from the standard tool bar and click it. 

 

Or 

Press Key strokes Ctrl+S 
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    Or       Click close button on the title bar. 
 
 
 
 
 

 

 

Microsoft Word Basic Features  
This lesson covers typing, the Backspace key, the Delete key, inserting text, bolding, 
underlining, and italicizing. To begin this lesson, open Microsoft Word.  

Typing and Using the Backspace Key  
The exercises that follow will teach you how to enter and delete text. To enter text, simply 
type just as you would if you were using a typewriter. To capitalize, hold down the Shift key 
while typing the letter. Use the Backspace key to delete text. You do not need to press Enter 
to start a new line -- Microsoft Word automatically wraps at the end of the line. Press Enter 
to start a new paragraph.  

More Basic Features  
This lesson covers cut, copy, paste, AutoText, spell check, find, replace, and fonts. To begin 
this lesson, open Microsoft Word.  

Open File  
To continue working on a file you previously saved, you must open the file. To open the file 
you used in Lesson 3:  

1. Choose File > Open from the menu.  
2. Make sure the folder you noted during the previous lesson displays in the Look In 

field.  
3. Select the file or type the file name in the File Name field.  
4. Click Open. The file you created during the previous lesson appears.  
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Alternate Method -- Opening a File by Using the Drop-Down Menu  

1. Click File.  
2. Look for the file name near the bottom of the drop-down menu.  
3. Click the file you created during the previous lesson opens.  

Cut and Paste  
In Microsoft Word, you can cut (delete) text from one area of a document and save that text 
so it can be pasted elsewhere in the document. When you cut text, it is stored on the 
Clipboard. You can also copy text. When you copy text, it is also stored on the Clipboard. 
Information stored on the Clipboard stays there until new information is either cut or copied. 
Each time you execute Cut or Copy, you replace the old information on the Clipboard with 
whatever you just cut or copied. You can paste Clipboard information as often as you like.  
Exercise 1  
Cut - Using the Menu  

1. Type the following:  
I want to move. I am content where I am.  

2. Highlight "I want to move."  
3. Choose Edit > Cut from the menu.  
4. Your text should now read:  

"I am content where I am."  

Paste - Using the Menu  

1. Place the cursor after the period in the sentence "I am content where I am."  
2. Press the spacebar to leave a space.  
3. Choose Edit > Paste from the menu.  
4. Your text should now read 

"I am content where I am. I want to move."  

Alternate Method -- Cut by Using the Icon  

1. Type the following:  
I want to move. I am content where I am.  

2. Highlight "I want to move."  

3. Click the Cut icon .  
4. Your text should now read: 

" I am content where I am."  

Alternate Method -- Paste by Using the Icon  

1. Place the cursor after the period in the sentence  
"I am content where I am."  

2. Press the spacebar to leave a space.  

3. Click the Paste icon .  
4. Your text should now read: 

"I am content where I am. I want to move."  
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Alternate Method -- Cut by Using Keys  

1. Type the following:  
I want to move. I am content where I am.  

2. Highlight "I want to move."  
3. Press Ctrl-x.  
4. Your text should now read.  

" I am content where I am."  

Alternate Method -- Paste by Using Keys  

1. Place the cursor after the period in the sentence: "I am content where I am."  
2. Press the spacebar to leave a space.  
3. Press Ctrl-v.  
4. Your text should now read.  

  "I am content where I am. I want to move."  

Copy and Paste  
In Microsoft Word, you can copy text from one area of the document and place that text 
elsewhere in the document. As with cut data, copied data is stored on the Clipboard.  
Exercise 2  
Copy - Using the Menu  

1. Type the following:  
You will want to copy me. One of me is all you need.  

2. Highlight "You will want to copy me."  
3. Choose Edit > Copy from the menu.  

Paste - Using the Menu  

1. Place the cursor after the period in the sentence: "One of me is all you need."  
2. Press the spacebar to leave a space.  
3. Choose Edit > Paste from the menu.  
4. Your text should now read:  

"You will want to copy me. One of me is all you need. You will want to copy me."  

Alternate Method -- Copy by Using the Icon  

1. Type the following:  
You will want to copy me. One of me is all you need.  

2. Highlight "You will want to copy me."  

3. Click the Copy icon .  

Alternate Method -- Paste by Using the Icon  

1. Place the cursor after the period in the sentence: "One of me is all you need."  
2. Press the spacebar to leave a space.  

3. Click the Paste icon .  
4. Your text should now read:  

"You will want to copy me. One of me is all you need. You will want to copy me."  
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Alternate Method -- Copy by Using Keys  

1. Type the following:  
You will want to copy me. One of me is all you need.  

2. Highlight "You will want to copy me."  
3. Press Ctrl-c.  

Alternate Method -- Paste by Using Keys  

1. Place the cursor after the period in the sentence "One of me is all you need."  
2. Press the spacebar to leave a space.  
3. Press Ctrl-v.  
4. Your text should now read:  

"You will want to copy me. One of me is all you need. You will want to copy me."  

AutoText  
Cut and Copy both store information on the Clipboard. Each time you store new information 
on the Clipboard, the old information is lost. If you wish to store text permanently so you can 
use it repeatedly, use AutoText.  
Exercise 3  

1. Type the following:  
AutoText information is stored permanently.  

2. Highlight "AutoText information is stored permanently."  
3. Choose Insert > AutoText > New from the menu.  
4. Microsoft Word suggests a name. The suggestion displays in the dialog box. Change 

the name by typing AT in the Please Name Your AutoText Entry field.  
5. Click OK.  
6. Click anywhere in the text area to remove the highlighting.  
7. Place the cursor between the period in the sentence you just typed and the 

paragraph marker (¶).  
8. Press the spacebar twice to leave two blank spaces.  
9. Type AT.  
10. Press F3.  
11. Your text should now read:  

"AutoText information is stored permanently. AutoText information is stored 
permanently."  
Note: Whenever you need the text, simply type the name and press F3.  

Spell Check  
Word checks your spelling and grammar as you type. Spelling errors display with a red wavy 
line under the word. Grammar errors display with a green wavy line under the error. If you 

want to spell check your entire document, press F7 and click the spelling icon , or 
choose Tools > Spelling and Grammar from the menu. If you want to spell check part of your 
document, highlight the area you want to spell check. Then press F7 and click the spelling 

icon , or choose Tools > Spelling and Grammar from the menu. 
Exercise 4  

1. Type the following exactly as shown. Include all errors.  
Open thr door for Mayrala. She is a teacher from the town of Ridgemont.  

2. Highlight: "Open thr door for Mayrala. She is a teacher from the town of Ridgemont."  
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3. Press F7 or click the Spelling icon on the Standard toolbar.  
4. "The" is misspelled, so it is highlighted on the screen and noted in the Not in 

Dictionary box.  
5. Word suggests correct spellings. These suggestions are found in the Suggestions 

box.  
6. To change the word to the correct spelling, make sure "the" is highlighted in the 

Suggestions box. Click Change.  
Note: If the word is misspelled in several places in the document, click Change All to 
correct all misspellings.  

7. The name "Mayrala" is not in the dictionary, but it is correct. Click Ignore Once to 
leave "Mayrala" in the document with its current spelling. 
Note: If a word appears in several places in the document, click Ignore All so you are 
not prompted to correct the spelling for each occurrence.  

8. "Ridgemont" is not found in the dictionary. If you frequently use a word not found in 
the dictionary, you should add that word to the dictionary by pressing the Add to 
Dictionary button. Word will then recognize the word the next time it encounters it. 
Click Add to Dictionary.  

9. The following should appear on your screen: "Word finished checking the selection. 
Do you want to continue checking the remainder of the document?"  

Click No. If you wanted Word to spell-check the entire document, you would have clicked on 
Yes. 
 

Page Margins 

The page margins of the document can be changed using the rulers on the page and the 
Page Setup window. The ruler method is discussed first: 

 Move the mouse over the area where the white ruler changes to gray. 

 
 When the cursor becomes a double-ended arrow, click with the mouse and drag the 

margin indicator to the desired location.  
 Release the mouse when the margin is set.  

The margins can also be changed using the Page Setup dialog box: 

 Select File|Page Setup and choose the Margins tab in the dialog box. 
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 Enter margin values in the Top, Bottom, Left, and Right boxes. The Preview window 
will reflect the changes.  

 If the document has Headers and/or Footers, the distance this text appears from the 
edge of the page can be changed.  

 Click OK when finished. 

Page Size and Orientation 
Change the orientation page within the Page Setup dialog box. 

 Select File|Page Setup and choose the Paper Size tab. 

 
 Select the proper paper size from the drop-down menu.  
 Change the orientation from Portrait or Landscape by checking the corresponding 

radio button 
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Print Preview and Printing 

Preview your document by clicking the Print Preview button on the standard toolbar or by 
selecting File|Print Preview. When the document is ready to print, click the Print button from 
the Print Preview screen or select File|Print. 

 

Exiting Microsoft Word  
You have completed this lesson. Typically, you would save your work before exiting. This 
lesson does not require you to enter any text, so you might have nothing to save. To exit 
Microsoft Word:   

1. Click File on the Menu bar.  
2. Click Exit, which can be found at the bottom of the drop-down menu.  
3. If you have entered text, you will be prompted: "Do you want to save changes to 

Document1?" To save your changes, click Yes. Otherwise, click No.  
4. Specify the correct directory in the Save In box.  
5. Name your file by typing in the File Name field.  
6. Click Save.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



G.C.E.(O/L) IT Teacher Instructional Manual  

National Institute of Education- 2006 208

 

 

 
Competency Level  6.3 :  Uses different types of formatting in Word Processing   
Activity  6.3 : Let’s prepare different types of documents in MS Word 

Time :  120 minutes.  

Quality Inputs : ●  A copy of the sample document in Annexe 6.3.1 to be enlarged.     

  ●  Four copies of graded directions for the user on formatting in  

   Annexe 6.3.2     

  ● Four copies group exploration instruction in Annexe 6.3.3   

Learning - Teaching Process:  

Step 6.3.1    :   ●  Initiate a discussion on formats used in Newspapers,  

   Invitation cards that the students have viewed. 

● Get students to reflect on the format they have observed in news 

papers and invitation cards. 

●  Conduct a discussion to highlight  the following.  

   

     

        

 

 

 

 

(15 minutes) 

 
Step 6.3.2 :   ●   Divide the class into four groups. 

● Provide each group with the copies of group exploration 

instructions and the labeled diagram on toolbars. 

  ●    Get the groups involved in the group exploration. 

  ●    Prepare them for a whole class presentation. 

(60 minutes) 

Step 6.3.3  :  ● Get each group to present its findings. 

● Initiate a game where one group names a format and the other 

group identifies it on the document prepared. 

● Lead a discussion to highlight the following.  

 

 

 
Competency  6 :  Uses Word Processing Software To Solve Day-To-Day  
    Problems. 

● Word processing features available in MS Word are used for   

formatting 

● Bold, italic and bullet are formatting features. 

● Inserting pictures using Clip Art, Word Art are the facilities 

available.   
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(45 minutes) 

 
Criteria for Assessment and Evaluation 

● Names different formats used in word processing and describes them. 

● Accepts the need to follow standard formats to develop documents.  

● Prepares professional documents. 

● Works cooperatively with peers.. 

● Justifies one’s own answer.  

 

 

● To change the format of a typed text highlight the text 

and click on the format button from the formatting toolbar. 

● To change the font and the size of a highlighted text,  

the font or font size drop down button is clicked and the 

required font or font size is selected. 

● Aligning text could be done using the align buttons; Left, 

Center, Right, Justify. 

● Numbering and bullets buttons are used to list items.  

● Drawing tool bar can be used to draw auto shapes, lines, 

circles and other shapes. 

● Text and the contents within the text box can be moved 

easily anywhere on the page. 

● Different types of Word Art are available in word 

processing.  

● The document can be made impressive by inserting clip 

art and pictures. 
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Annexe 6.3.1 
Computer System 

 
Basic Components of a computer 

1. Input Devices 
2. Central Processing Unit 
3. Out put Devices 
4. Auxiliary/Secondary Storage 

 
Input Devices 

● Keyboard 
● Mouse 
● Light Pen 
● Joy Stick 
● Scanner 
● Etc… 

 
 
 

Computer System 
 
 
 

         Hardware              Software         Liveware 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
 
 
 
 
 
 
 
 

 

 
 
 
 

 

 

 

R/Gankanda National School 
Pelmadulla 

Personal Data 
 
Name with Initials:………………………….. 
 
Address  :…………………………………… 
 
Sex: Male-1  Female-2 
 
Date of Birth:          

Date      Month        Year   
    

      
            …………………. 
Date:…………………..   Signature 
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Annexe 6.3.2 
 

A Labeled Diagram on Toolbars 
 
Formatting Toolbar 
 
 
 

 
 
 
 
 
 
 
Drawing Toolbar 
 
 
 

 
 
 
 
 
 
AutoShapes using Drawing Toolbar 
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Drawing Toolbar 
1. Line 

2. Arrow 

3. Rectangle 

4. Oval 

5. Text Box 

6. Insert Word Art 

7. Insert Diagram and 

Organization Chart 

8. Insert Clip Art 

9. Insert Picture 

10. Fill Color 

11. Line Color 

12. Font Color 

13. Line Style 

14. Dash Style 

15. Arrow Style 

16. Shadow style 

17. 3-D style 

 

Formatting Toolbar  
1. Style 

2. Font 

3. Font Size 

4. Bold 

5. Italic 

6. Underline 

7. Align Left 

8. Center 

9. Align Right 

10. Justify 

11. Line Spacing 

12. Numbering 

13. Bullets 

14. Decrease Indent 

15. Increase Indent 

16. Outside Border 

17. Highlight 

18. Font Color 



G.C.E.(O/L) IT Teacher Instructional Manual  

National Institute of Education- 2006 213

Annexe 6.3.3 
Instructions for the Group Exploration 

 

● You will be working in four groups with the following four topics assigned to the four 

groups randomly. 

o Prepare an Invitation card for a birthday party using Clip Art and drawing 

features.  

o Prepare an application form similar to the one shown in the Annexe 3.3.1 

o Prepare an application for a job: use all possible formats. 

o Prepare a Bio Data using bullets and other formats appropriately 

 

● Prepare the document given using all the formats. 

● Get ready for a whole class presentation. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



G.C.E.(O/L) IT Teacher Instructional Manual  

National Institute of Education- 2006 214

 
 
Competency Level  6.4 :  Inserts tables into documents and acquires the ability of  

                   customizing them. 
 
Activity 6.4 :  Let’s insert tables and learn how to customize tables and documents.  
 
Time  : 60 minutes. 
 
Quality Inputs: ●   The timetable in Annexe 6.4.1 

  ●   Three copies of group exploration instructions in Annexe 6.4.2 

  ● Three copies of Tables for group activity in Annexe 6.4.3                                                   
  ● Graded Directions in Annexe 6.4.4 for creating and customizing tables.  

 
Learning -Teaching Process: 
 
Step 6.4.1       : ●    Expose the timetable to the class. 

                          ●    Conduct a discussion to highlight the following. 
 
 
 
 
 
 
 
 

 (10 minutes) 
Step 6.4.2 : •  Divide the class into three groups. 

• Provide each group with copies of group exploration instructions  

• Involve the groups in the exploration. 

• Prepare groups to present their findings 

(30 minutes) 
Step  6.4.3 :●   Get each group to present its findings 

• Request other groups to submit their constructive comments. 

• Conduct a discussion to highlight the following. 

 

 
 
 
 
 
 
 
 

 
 

● A table consists of columns and rows  

● Table facilities in word processing enable data within a table to be 

organized in a meaningful manner 

● A table can be customized according to user needs to give 

meaningful information. 

• In creating tables the number of columns and rows have to be 

specified. 

• Column width and row height can be adjusted. 

• New columns and rows can be inserted and unwanted columns and 

rows can be deleted 

• Adjacent cells can be merged while cells also can be divided. 

 
Competency  6 :  Uses Word Processing Software To Solve Day-To-Day  
    Problems. 
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(20 minutes) 
 
Criteria for Assessment and Evaluation 

 
● Describes the facilities made available by the word processor in working with 

tables. 

● Accepts the value of tables in handling information. 

● Creates tables to arrange data in an organized manner 

● Demonstrates ability to organize according to situation. 

● Works cooperatively with peers.  
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Annexe 6.4.1 

Time Table 

Time Monday Tuesday Wednesday Thursday Friday 
08.00 - 08.40 Sinhala Maths Social 

studies 
Religion Health & 

Phy. Ed. 
08.40 – 09.20 Health & 

Phy. Ed. 
Maths Sinhala Science Maths 

09.20 – 10.00 Maths Social 
studies 

English Science Maths 

10.00 – 10.40  Maths English Religion Sinhala Sinhala 
10.40 – 11.00 Science Religion Health & 

Phy. Ed. 
Maths Social 

studies 
11.30 – 12.10 Aesthetic Health & 

Phy. Ed. 
Science Maths English 

12.10 – 12.50 Social 
studies 

Sinhala Aesthetic Social 
studies 

Religion 

12.50 – 13.20 English Science Maths English Science 
13.20 – 13.00 Religion Science Maths Health & 

Phy. Ed. 
Aesthetic 
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Annexe 6.4.2 

Instructions for the Group Exploration 

• You will be working in three groups with one of the tables annexed 

• Study the table given to your group. 

• Use the word processor to create the table. 

• Identify instances wherein you have done the following. 

o Defining columns and rows 

o Merging cells  

o Aligning cell entries 

o Applying Text direction 

o Formatting 

• Be prepared for an innovative whole-class presentation 
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Annexe 6.4.3 

Tables for group activity                                                                             

Table 1 

Time Monday Tuesday Wednesday Thursday Friday 
 La Le La Le La Le La Le La Le 

8.00am - 8.40 A B C D A B C D A B 
8.40 – 9.20 C D E F C D E F C D 
9.20 – 10.00 E F A B E F B A F E 

10.00 – 10.40 G H G H G H G H G H 
10.40 – 11.00 I          N            T            E           R               V        A            L 
11.30 – 12.10 A B C D A B C D A B 
12.10 – 12.50 C D E F C D E F C D 
12.50 – 1.20 E F A B E F B A F E 
1.20 – 2.00 G H G H G H G H G H 

 

Table 2 

 
N

IM
A

L 

SU
N

IL 

K
A

M
A

L 

W
IM

A
L 

PA
LITH

A
 

Sales Software CDs Sales Computer Items 

Hard Disks C
orel Floppy Disks 

Processors 

M
S O

ffices 

M
acrom

edia 

Flash Ver 12 

Ver 11 

Photoshop cs 9 

Visual B
asic .N

et 

A
utocad 14 

Motherboards 
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Table 3 

Package1 Package2 Package3 Package4 
Monthly Rent 100/- Monthly Rent 200/- Monthly Rent 300/- Monthly Rent 500/-

 Rs  Rs  Rs  Rs
Peek Hour 13 Peek Hour 10 Peek Hour 8 Peek Hour 5 

Off Peek Hour 10 Off Peek Hour 8 Off Peek Hour 6 Off Peek Hour 2 
CLI 50 CLI 50 CLI 50 CLI 50

SMS 25 SMS 25 SMS 25 SMS 25

GPRS 25 GPRS 25 GPRS 25 GPRS 25
MMX 25 MMX 25 MMX 25 MMX 25

Call waiting 30 Call waiting 30 Call waiting 30 Call waiting 30
Call 

forwarding 
15 Call 

forwarding 
15 Call 

forwarding 
15 Call 

forwarding 
15
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Annexe 6.4.4 

Graded Directions 

Creating Tables 

To create a table with four-columns and five-rows:  

1. Choose Table > Insert > Table from the menu. 
The Insert Table dialog box opens.  

2. Type 4 in the Number of Columns field.  
3. Type 5 in the Number of Rows field.  
4. Select Auto in the Column Width field. you can 

adjust the column width later.  
5. Click OK. Your table should look like the one 

shown here, with four columns and five rows. 

 

  

 

Moving Around a Table  
Each block in a table is called a cell. Use the Tab key to move from cell to cell from left to 
right. Use Shift-Tab to move from cell to cell from right to left. The following exercise 
demonstrates.  

1. Click in any of the cell in the table.  

Or 

2. Press the Tab key to moves forward cell and Shift + Tab to moves backward 

Or 
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3. You can also move to a cell by clicking in the cell. In addition, you can move around 
the table by using the left, right, up, and down arrow keys Note:.  

Entering Text into a Table  
To enter text into a table, simply type as you normally would. Press Tab to move to the next 
cell. Enter the text shown below into your table.  

Salesperson Dolls Trucks Puzzles 
Kennedy, Sally 1327 1423 1193 
White, Pete  1421 3863 2934 
York, George  2190 1278 1928 

 
 

Adding a New Row to the End of the Table  

1. Move to the last column of the last row of your table.  
2. Press the Tab key.  
3. Type the text shown here.  

    

Inserting a Row Within the Table  
You can add a new row anywhere in the table. The exercise that follows demonstrates.  
To add a row just above York, George:  

1. Place the cursor where you want to insert Rows. 
2. Choose Table > Insert > Rows Above from the menu to insert a row above to the 

current row.. Rows Below from the menu to insert a row below to the current row 
3. Add the information shown here to the new row.  

Resizing the Columns  
To widen the first column:  

1. Place the cursor anywhere in the first column.  
2. Choose Table > Select > Column from the menu.  
3. Choose Table > Table Properties from the menu.  
4. Choose the Column tab.  
5. Type 1.5 in the Preferred Width field.  
6. Click OK.  

Alternate Method -- Resizing Your Column Widths by Using the Width Indicator  
By placing the cursor on the line that separates two columns. When width indicator appears 
click and drag towards left or right with the mouse to adjust the column width.  
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Adding a New Column to a Table  
You can add new columns to your table. To add a new column between the Salesperson 
and Dolls columns:  

1. Place the cursor anywhere in the column.  
2. Choose Table > Insert > Columns to the Left  or columns to the right from the menu.  
3. Label the new column to your requirement.  

. Deleting a Column  

You can delete columns from your table. To delete the Trucks column:  

1. Place your cursor anywhere in the Trucks column.  
2. Choose Table > Delete> Columns from the menu.  

Deleting a Row  
You can delete rows from your table. To delete the York, George row:  

1. Place your cursor anywhere in the York, George row.  
2. Choose Table > Delete > Rows from the menu.  

Note: The context menu is a useful tool. When you right-click, Microsoft Word supplies you 
with a list of menu choices. You can execute a command by selecting an option from the 
context menu.  

Merge Cell 
Using Microsoft Word, you can merge cells -- turn two or more cells into one cell. In this 
exercise, you are going to create a new row at the top of your table, merge the cells, and 
add a title to the table.  

1. Move to the cell located on the first row of the first column of your table (the 
Salesperson cell).  

2. Choose Table > Insert > Rows Above from the menu.  



G.C.E.(O/L) IT Teacher Instructional Manual  

National Institute of Education- 2006 223

3. Choose Table > Merge Cells from the menu.  
4. Type Toy Sales in the new cell.  
5. Press Ctrl-e to center the title.  

 

Splitting a Table  
With Microsoft Word, splitting a single table into two tables is easy. To separate the table 
you just created into two tables:  

1. Place your cursor anywhere on the row that reads "Name, Age, Sex."  
2. Choose Table > Split Table from the menu.  

Splitting Cells 

Any cell can be splitted into one or more columns and rows 
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Competency 6 : Uses Word Processing Software To Solve Day-To-Day  
      Problems. 

 
Competency Level 6.6:  Uses mail merge facility. 
 
Activity 6.6 :   Let’s use mail merge facility. 

Time :  120 minutes 

Quality inputs   :   ●   Standard letter in Annexe 6.6.1 

       ●    Three copies of address list in Annexe 6.6.2 

       ●   Three copies of group exploration instructions on mailing  

   letters, envelopes, labels in Annexe 6.6.3 

       ● Three copies of Graded directions in Annexe 6.6.4 

  ● Soft copy of standard letter and address list 

 

Step 6.6.1 :    ●   Distribute Annexe 6.6.1 & 6.6.2 to the class. 

            ●   Conduct a discussion about their experiences in  

                  sending copies of a letter to a number of recipients       

                               ●   Conduct a discussion to highlight the following 

 

 

 

 

 

 

(20 minutes) 

Step 6.6.2 :   ●    Divide the class into three groups.    

●   Distribute copies of the soft copy of standard letter, address    

     list and reading material to the groups.    
●   Involve the groups in the exploration as described in the    

     reading material. 
 ● Prepare them for a presentation at the plenary. 

(60 minutes) 

Step 6.6.3 :   ●   Get groups to present their findings. 

 ● Request others to submit constructive comments.  

 ● Conclude the activity by highlighting the following 

 

   ●    The original massage repeated.  

 ●    Writing multiple copies of a letter manually is very  

       laborious. 
 ●    Recipients of printed copies feel that they do matter. 
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(40 minutes) 

 
Criteria for assessment & evaluation: 

● Describes the steps used to create letters, envelopes, labels, using mail merge. 

●  Accepts the need to use mail merge facility. 

● Creates letters, envelopes, labels, using mail merge. 

● Uses simple method to perform complicated task. 

● Learns from experience. 

 
 
 
 
 

 

 
 
 
 
 
 
 

● Merge Wizard in Microsoft Word XP is a six-step process. 

● There are five document types. 

o Letters 

o Envelopes 

o Labels 

o Email massages 

o Directory 

● Document type letters can be used to create multiple copies 

of letters. 

● In letters, original massage is repeated. 

● Recipient’s information is unique. 

● Envelope size can be selected. 

● Paper size and label size can be selected with respect to 

labels.  
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Annexe 6.6.1 
 

Director (Personal) 
Board of investment of Sri Lanka 
9th floor, West tower 
World trade centre 
Echelon square 
Colombo 01 

 
 

………………………………………………… 
 
………………………………………………… 
 
………………………………………………… 
 
………………………………………………… 
 
 
Dear …………… ……………………. 
 
Interview for the post of Management Trainee 
 
I am pleased to inform you that you have been short-listed for the above post. We intend to 
hold interviews on the morning of Saturday, 26 April 2005.    
 
Your actual interview before the panel is scheduled for ………………………. a.m. Please 
attend the interview.  
 
Yours sincerely, 
 
 
 
 
Director-Personnel 
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Annexe 6.6.2 

 
 

Address List 
 

 
 

 
 

 
 

Annexe 6.6.3 
 

Instructions for the Group Exploration 

 
• You will be in three groups with the following three topics randomly assigned to the 

groups 
 
• mailing letters,  

• envelopes,  

• labels 

• On the basis of the document provided carry out the part assigned to you. 

• Write down the important points relevant to your topic. 

• Be prepared to present your findings at the plenary session. 

 
 
 
 
 

Title FirstName LastName Address1 Address2 City Time 
Mr A.B. Samanadasa 65/3, 

Samanala 
palama 

Samanabedda Sathutukele 9.00 

Miss Filishiya Fernando 4th lane Erambuma Akarawita 9.30 
Mr Joseph Gowder No. 65/12 Longdon 

place 
Greenwood 10.00 

Miss Thilini Kodikara Pleasent 
avenue 

Gilferd cresent Colombo 10.30 

Mr Malaka Ranbanda No 14A 2nd cross 
road 

Colombo 11.15 
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Annexe 6.6.4 
 
 

Graded direction 1- Mailing letters 
 

The following steps illustrate how to complete a Mail Merge in your new XP environment. 

● Open Microsoft Word 

● Select Letters & Mailing 
● Choose Mail Merge Wizard 

 

 
 

A new window will appear on the right hand side of the document. (View 

Diagram Below) 
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How to Use the Mail Merge Wizard 
Using the Mail Merge Wizard in Microsoft Word XP is a six-step process. 

Step 1 – Select Document Type 
● Select Letters 
● Click Next: Starting Documents 

 
 

Step 2 – Selecting Starting Document 
 

 
 

 

● Select Start from existing document 
o Click open and open the relevant file 

● Click Next: Select Recipients 
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Step 3 – Selecting Recipients 

 
 

● Select Use an Existing List. 
● Choose Browse and locate the relevant file. 

The following window will display. 

 
 

● Choose Select All 
● Click ok 
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● Choose Next Write Your Letter 
 

Step 4 - Insert your Address Data 
 

 
● Place your cursor in your letter on the screen at the point where you want to 

place your address 

● Click on Address Block 
The Following Window will pop-up. 
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Select the address type 

● Click OK 

The following line will appear in your letter: 

<< << Address Block >> >> 

● Place your cursor in your letter on the screen at the point where you want to 

place your greeting 

● Click on Greeting Line 
The Following Window will pop-up 

 

 
 

The following line should appear in your letter: 

<< << Greeting Line >> >> 

● Now choose Preview your letter. 
Step 5 – Preview Your Letters 

● Preview the merged pages by clicking on arrows (View Diagram below) 

See your letters individually in preview mode. 
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Step 6 – Complete the Merge 
● Click on Next: Complete the Merge. 

 

 
 

To see the individual letters  

● Click on Edit individual letters 
Merge to New Document dialog box appears.  

 

● Click OK 
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You can save all the envelopes or a range to a new document. This allows you to save the 

document and print at another time. 

 

Guided direction 2- Envelopes 
The following steps illustrate how to complete a Mail Merge in your new XP environment. 

● Open Microsoft Word 

● Select Letters & Mailing 
● Choose Mail Merge Wizard 

 

 
A new window will appear on the right hand side of the document. (View 

Diagram Below) 
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How to Use the Mail Merge Wizard 
Using the Mail Merge Wizard in Microsoft Word XP is a six-step process. 

Step 1 – Select Document Type 
● Select Envelopes 
● Click Next: Starting Documents 

 
 
Step 2 – Selecting Starting Document 
Step 2 of 6 – Starting document 

 Under Change document layout click on 

Envelope Options 

 Click in the down arrow and select the type of 

envelope you are using. 

 Click on the Printing options tab, your default 

printer is listed. Select the correct feed 

method.  

 Click OK. 
 

 

 
An Envelope is displayed. 
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● Click Next: Select Recipients 

Step 3 – Selecting Recipients 

 
 

● Select Use an Existing List. 
● Choose Browse and locate the relevant file. 

The following window will display. 
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● Choose Select All 
● Click ok 
● Click Next: Arrange your envelope 

Step 4 of 6 Arrange your envelope 
An envelope is displayed. If you want a return address, click in the bottom left corner of the 

envelope and type the address. It will appear on each envelope. If you don’t want a return 

address, leave it blank. 

● Click in the center of the envelope and a box appears 

Under Arrange your envelope is a list of 5items. 

● Click address block 
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The Following Window will pop-up. 

 

 
 

● Select the address type 

● click OK 

The following line will appear. 
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<< << Address Block >> >> 

 

 
● Click Next: Preview envelopes 

Step 5 of 6 Preview envelopes 
Under Preview your envelopes are arrows that will take you forward and back through the 

envelopes. 

 If all looks well Click Next: complete the merge.  

If it’s not right, click Previous: Arrange your envelope and make corrections. 

● Click Next: Complete the merge 

Step 6 of 6 - Complete the merge 
● Select Edit individual envelopes  

 
Merge to New Document dialog box appears. 

 
● Click OK 

 You can save all the envelopes or a range to a new document. This allows you to save the 

document and print at another time. 
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Guided direction 3 - Creating mailing labels  
Open Microsoft Word and start a new document. 

● Click Tools / Letters and Mailings / Mail Merge Wizard.  

● The Mail Merge Wizard will open in the task pane on the right hand side of 

your screen.  To use this wizard you will need to complete each step and then 

click on the next step at the bottom. 

 

● First choose Labels as your document type. 

● Click on Next: Starting document. 

● Choose Change document layout and then click on Label options. 

  

● A Label Options dialog box is displayed.  Under Label products choose the 

Avery A4 and A5 size  

● Click OK 

● Click on Next: Select recipients. 



G.C.E.(O/L) IT Teacher Instructional Manual  

National Institute of Education- 2006 241

 

For this task choose to Use an existing list. 

● Choose Browse and locate the relevant file : 

 
The following window will display. 
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● Choose Select All 
● Click ok 

 

● Click on Next: Arrange your labels. 

To add recipient information to your label, click a location in the first label, and click the 

address block. 
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● Select the address type and click OK  

You can copy the layout of the first label to the other labels on the page by clinking the 

button Update all labels 
● Click Update all labels 

● Click on Next: Preview your labels. 

● You can now see your merged labels as below: 

 



G.C.E.(O/L) IT Teacher Instructional Manual  

National Institute of Education- 2006 244

 
● Click on Next: Complete the merge. 

 

● Edit individual labels will allow you to to choose some or all of your labels to 

create a new document where you can edit individual labels if you need to.  

This new document is no longer a mail merge document.  It contains only the 

labels and the address text and can be edited like a normal Word document. 
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●  

 

 

Competency 7.1: Explores a Spreadsheet to identify its basic features and   
                              functions. 
 
Activity 7.1 :    Let’s explore a spreadsheet application package. 

Time :    90 minutes. 
Quality inputs :    ●    Six copies of labeled diagram of starting window of spreadsheet in  

                                          Annexe 7.1.1.       

            ●   A poster containing the definition of a “spreadsheet” in Annexe  

                                        7.1.2.                                             

Learning-Teaching process: 
Step 7.1.1      :    ●   Get the class to denote their expenses of a particular week  

    on a table.  
      ●   Conduct a discussion to highlight the following. 

                                 
 

 

 

 

 
 
 
 
 
 
 
 

(30 minutes) 

Step 7.1.2 :    ●   Divide the class into six groups. 
  ●   Distribute copies of the labeled diagram to the groups. 

     ●  Assign the 18 features equally to the groups. 

    ● Get groups study the features. 

  ● Help groups to start the spreadsheet package and study the 

features on the screen as well.  
                               ●  Prepare groups for a presentation.      

(30 minutes) 

• A table with rows and columns provides a suitable means for 

presenting data. 

• The two variables – days of the week and   expenses – of 

the exercise given can be represented on rows and columns. 

• Cells resulting from the intersection of rows and columns 

provide places for data entry. 

• Incorporation of data pertaining to variables separately in a 

table facilitates understanding of data when compared to a 

paragraph. 

• It is also easier to manipulate data presented in a table. 

 
Competency 7 : Uses Spreadsheet to solve simple statistical problems. 
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Step 7.1.3 :   ●   Get each group to present its findings. 

       ●   Expose them to the poster containing the definition of   

                                         spreadsheet 

     ●   Lead a discussion to highlight the following. 

 

 

 

 
 
 

 

 

(30 minutes) 

Criteria for assessment and evaluation 

• Describes the basic features of a spreadsheet. 

• Accepts the value of being familiar with the starting window of a spreadsheet    

application to be a successful user. 

• Adopts the standard procedure to gain access to an application package. 

• Uses observations to confirm learning experiences gained through reading. 

• Learns from peers. 

 

 
 
 
 
 
 
 
 
 

• A spreadsheet package is opened through a standard 

procedure. 

• The 18 items studied represent the basics features of the 

starting window of the application.  

• Familiarity with these features helps users to access the 

package to meet their needs. 
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Annexe 7.1.1 
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1. Menu 

2. Toolbars 

3. Formula bar 

4. Row Number 

5. Row 

6. Active Cell  

7. Cell 

8. Column 

9. Column Letter 

10. Title Bar 

11. Minimize 

Button 

12. Maximize 

Button 

13. Close Button 

14. Status Bar 

15. Work Sheet 

Tabs 

16. Grid Lines 

17. Horizontal 

Scroll bar 

18. Vertical Scroll 

Bar
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  Annexe 7.1.2 
Poster 

What is a spreadsheet? 
 
In the realm of accounting jargon a "spread sheet" or spreadsheet was and is a large sheet 
of paper with columns and rows that organizes data about transactions for a businessperson 
to examine. It spreads or shows all of the costs, income, taxes, and other related data on a 
single sheet of paper for a manager to examine when making a decision. 
 
An electronic spreadsheet organizes information into software-defined columns and rows. 
The data can then be "added up" by a formula to give a total or sum. The spreadsheet 
program summarizes information from many paper sources in one place and presents the 
information in a format to help a decision maker see the financial "big picture" of the 
company. 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 
National Institute of Education- 2006 

254

 
Competency Level 7.2:  Moves around the worksheet to gain hands on  experience of  

     data entry. 
 
Activity 7.2 :  Let’s manipulate the worksheet. 
Time : 60 Minutes 

Quality inputs :     ●  The table displayed on computer screens in Annexe 7.2.1. 

  ● Three copies of Graded directions to guide the user in 

         Annexe 7.2.2. 

 

Learning – Teaching Process: 
Step 7.2.1 :  ● Expose  the table to the class.  
  ● Get students to state the difficulties of following these instructions  

   manually.     

    ●  Conduct a discussion to highlight the following. 

 

 

 

 

 

 
 

 

(15 minutes) 

 
Step 7.2.2 :  ●    Divide the class into three groups. 

• Distribute copies of graded directions to students. 

    ●  Ask students to go through the directions and change the table   

   given according to  instructions. 

     ●  Prepare them for a presentation on the experiences. 

(30 minutes) 
Step 7.2.3 :  ●  Get groups to present their experiences.  

    ●  Lead a discussion to highlight the following. 

 

 
Competency 7 : Uses Spreadsheet to solve simple statistical problems. 
 

• A spreadsheet provides the following editing facilities on the 

original itself.   
o Inserting and deleting of rows and columns. 

o Cutting and pasting data in the cells. 

• When compared to manual methods of doing these, the   

spreadsheet saves time and effort, and removes the  need 

for rechecking. 
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(15 minutes) 
Criteria for assessment and evaluation 

• Describes editing facilities made available by spreadsheet package. 

• Accepts the value of spreadsheet as a time saving device, application and user  

   types. 

• Manipulates a worksheet according to instructions. 

• Learns through hands on experiences. 

• Learns from the experiences of others. 

     

 

 

 

 

 

 

 

 

 

 

 

 

 

• A worksheet consists of 65536 rows and 256 columns. 

• A cell constitutes the smallest element of a spreadsheet.   

• Each cell has a unique address that refers to columns and 

rows. 

• The cells are the data containers of the worksheet. 

• Placing the cell pointer where manipulation is needed helps 

track changes made to data.  
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Name English Mathamatics science
Saman Perera 55 85 62
Nimal Rathnayake 48 55 25
kamala Perea. 56 84 31
Nimali Pieris 55 71 60

 

 

 
 
 
 

Annexe 7.2.1 
Manipulate worksheet. 

 
Make following table. 
 
 
 
 
 
 
 
 
 

● Insert two rows above Saman Perera and add two names and give the marks. 

● Insert a column between English and Mathamatics for Religion and give   

marks. 

● Cut all data of Saman Perera and paste them below Nimali Pieris.  

●  Delete the empty row. 

● Adjust cells according to the length of student names and the subject names.   
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Annexe 7.2.2 

 
Graded directions 

 
1. Insert Columns and Rows 2. Cut, Copy and paste    
                                                                                               Columns and rows. 

• Place the cell pointer where you need  The row or the column  
            to insert a column.  Must be selected.   
     
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Place the cell pointer where you need  
            to insert a row. 
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Competency Level 7.3: Performs basic mathematical operations 
 
Activity 7.3 :  Let’s do some mathematical operations on worksheet. 

Time : 60 Minutes 

Quality Inputs :  ●  A document containing numbers, texts and basic mathematical   

     operations in Annexe 7.3.1. 

         ●   Four copies of graded directions and exercises in Annexe 7.3.2. 
 
Learning-Teaching Process: 
 
Step 7.3.1  :  ●  Distribute document containing numbers, texts and basic   

                                     mathematical operations 

          ● Request participants to enter numbers and texts in worksheet.      

   ● Ask them to press enter key after each entry. 

       ●  Lead a discussion to highlight the following. 

  

 

 

 

 
 
 

 

(15 minutes) 

 
Step 7.3.2 :  ●  Divide the  class into four groups. 

         ●   Distribute copies of graded directions and exercises. 

   ●   Ask each group to carry out one of four exercises.  

  ● Ask them to check the formula bar.  

         ●   Prepare them to present their ideas about their new experience 

(30 minutes) 

 
 

 
Competency 7 : Uses Spreadsheet to solve simple statistical problems. 

● The enter key should be pressed after typing in the cell. 

● Spreadsheet accepts data of three types. 

● Generally numbers are right aligned in a cell. 

● Generally texts are left aligned in a cell. 

● Calculations can be done using mathematical expressions 

called formulae. 
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Step 7.3.3 :  ●  Get each group to present its findings. 

         ●  Lead a discussion to emphasize the following. 

 

 

 

 
 
 

 

 

 

(15 minutes) 

Criteria for assessment and evaluation 
● Names three data types in a cell. 

● Accepts that basic mathematical operation can be performed in an electronic 

   spreadsheet. 

● Demonstrate skills in the use of mathematical calculations in a spreadsheet. 

● Works cooperatively with group. 

● Learns from the experiences of others. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

● A formula should begin with the equals sign. 

● The result will be displayed in the same cell in which the 

formulae entered.  

● The formula of the selected result will be displayed on the 

formula bar. 

● The spreadsheet application follows the hierarchy of order of 

mathematical operations. 
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Annexe 7.3.1 
 

Numbers, texts and basic mathematical operations. 
 
Numbers are aligned rightwards in a cell. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Texts are aligned leftwards in a cell. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Basic mathematical operations.  

 

 

1. Go to highlighted cells and 

observe the status of each 

cell on the formula bar. 

2. Note important features 

about information in the cell 
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Formulas 

Formulas calculate values in a specific order. A formula in Microsoft Excel always 
begins with an equal sign (=). The equal sign tells Excel that the succeeding characters 
constitute a formula. Following the equal sign are the elements to be calculated (the 
operands), which are separated by calculation operators. Excel calculates the formula from 
left to right, according to a specific order for each operator in the formula. You can change 
the order of operations by using parentheses. 

Calculation operators in formulas 
Operators specify the type of calculation that you want to perform on the elements of 

a formula. Microsoft Excel includes four different types of calculation operators: arithmetic, 
comparison, text, and reference. 
 
Arithmetic operators    

To perform basic mathematical operations such as addition, subtraction, or 
multiplication; combine numbers; and produce numeric results, use the following arithmetic 
operators. 
 
 

Arithmetic 
operator 

 
Meaning 

 
Example 

+ (Plus sign) Addition 3+3 

– (Minus sign) Subtraction 
Negation 

3–1 
–1 

* (Asterisk) Multiplication 3*3 

/ (Forward slash) Division 3/3 
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Annexe 7.3.2 
Graded Directions 

 
Click the cell pointer where you want to get the answer and do following exercises. 

Observe the formula bar when you do them. 

 
Exercise 1 

 

a) =5 + 4 

b) =3 + (5 – 2) * 2 

c) =(4 – 2) / 2 +3 

d)  

Exercise 2 

 

a) =2 + 6 

b) =3 + 5 – 2 * 2 

c) =4 – 2 / 2 +3 

 

 

 

Exercise 3 

a) =2 + 3 * (2(4 – 3)) 

b) =4 * 3 * (5 – 2) 

c) =1 + 2 * (6 – 2) / 2 

 

 

 

Exercise 4 

a) =2 + 3 * 4 – 3 

b) =4 * 3 * 5 – 2 

c) =12 * 6 - 2 / 2 
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Competency Level 7.4:   Uses inbuilt functions for calculations 
Activity 7.4 :   Let’s do some mathematical operations. 

Time : 60 Minutes 

Quality inputs :  ●  Four copies of work sheet in Annexe 7.4.1. 

  ●   Four copies of graded directions to guide user in Annexe 7.4.2. 

Learning-Teaching process: 
Step 7.4.1 :  ●  Distribute copies of Work sheet. 

    ●  Ask students to do as many activities as possible. 

    ●  Conduct a discussion to highlight the following.  

 

 

 

 
 

 
 

(30 minutes) 

Step 7.4.2 :  ●  Divide the class into four groups. 

    ●  Distribute copies of Graded directions. 

    ●  Assign the tasks and involve groups in the work.                         
    ●  Prepare groups for a whole class presentations. 

(15 minutes) 

 
Step 7.4.3. :  ●  Ask the students to present their findings to the class. 

    ●  Lead a discussion to highlight the following. 

 
 

 
 
 
 

 

(15 minutes) 

 
 

 
Competency 7 : Uses Spreadsheet to solve simple statistical problems. 
 

● Some mathematical operations on worksheet are more 

effective than human manual calculations. 

● Therefore there must be predefined functions or formulas. 

● Some mathematical operations can be defend according to 

the purpose 

● There are predefined formulas in spreadsheet application. 

● It is very easy to perform mathematical operations using 

predefined formulas.   
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Criteria for assessment and evaluation. 
 

● Uses predefined functions to do mathematical operations. 

● Accepts the need of formulas to do mathematical operations.                 

● Demonstrate skill of  selecting formulas to suit  application. 

● Makes concise presentations  

● Justifies one’s own answers.  
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Annexe 7.4.1 
Worksheet 

Give solutions for the following. 
 
Group 1 

1. Find the total sum. 
 

 
 
 
 
 
 
 
 
 
 
    
Total 
                    
Group 2 

2. Find the average number of above. 

Group 3 

3. Find the minimum number. 
 

Group 4 

4. Find the maximum number. 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

10 
250 

9999 
481 

1966 
20 

50856 
456 

250368 
5698 
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Annexe 7.4.2  
 

Predefined functions. 
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Competency Level 7.5: Formats a worksheet 
Activity 7.5 :   Let’s format the worksheet using formatting toolbar.  

Time :   90 minutes 

Quality inputs :  ●   Four copies of completed table in Annexe 7.5.1.  

                                    ●  Four copies of labeled diagram of formatting tool bar and directions   
                                          in Annexe 7.5.2. 
 
Learning – Teaching process: 
 
Step 7.5.1. :   ● Request the class to note their expenses for a particular    
      week on a table 

  ● Ask them to draw it attractively using colours and different sizes of 

letters. 

     ●  Lead discussion to highlight the following.  

 
 

 
 

(30 minutes) 
Step 7.5.2 :  ●  Divide the whole class into four groups. 

● Provide each group with copies of Labeled diagram and completed 

table. 

● Get students to familiarize themselves with the formatting  

      bar and the directions.         

● Ask them to create a table as the completed table. 

(30 minutes) 
 
Step 7.5.3 :  ●  Request each group to present ideas about their new                          

                                          experiences. 

• Conduct discussion to highlight the following. 

 

 

 

 

 

 

 

 
Competency 7 : Uses Spreadsheet to solve simple statistical problems. 

● It is important to make a table attractive to the reader. 

● The table can be made attractive by formatting same. 

● Font styles can be changed in spreadsheet application. 

● Font size can be changed in spreadsheet application. 

● Justifications are possible. 

● Numbers can be formatted. 

● Decimal and indent can be increased or decreased. 

● Table border can be applied. 
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(30 minutes) 

Criteria for assessment and evaluation 
● Makes a complete table according to requirements. 

● Accepts  need to format worksheet to match the nature and requirements of the user.   

● Demonstrate skills of formatting worksheets      

● Makes concise presentations. 

● Learns from peers. 
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Annexe 7.5.1 

Formatting 

  
Examine the following table. 
 

 
 
 
 
 
Then create this table according to the guidance in the Annexure 2.  
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Annexe 7.5.2 
Formatting cells. 

Formatting  Toolbar 
The content of a highlighted cell can be formatted in many ways. Font and cell attributes can be added from shortcut buttons on the 
formatting bar. If this tool bar is not already visible on the screen, select View              Toolbar             Formatting   from the menu bar. 
                                                                                                                 
 Percent 
                                                                                                                                Style  
  
  Font menu Center across cells Fill color 
 Increase / 
 Decrease 
 decimal 
 
        Bold, Italic. Underline 
                                                                                                                                                                                   Border 
 
 
 
 
 
 
 
    Font    
                                                                                                                                                                                                              color 
  
                                                                                                                                     Comma style 
 
 Left, center, right Increase / decrease 
 Justification Indent 
 
                                Font size                                                            Currency
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Format Cells dialogue box 
 
Right click on the highlighted cells and choose Format Cells from the short cut menu or 
select Format              Cells from the menu bar. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 

 
Number tab     : The data type can be selected from the options on this tab. 
Alignment tab : These options aloe you to change the position and alignment  
                                            of  the data with the cell. 
Font tab           : All the font attributes are displayed in this tab including font  
                                            face, size, style, and effects. 
Border and pattern tabs: These tabs allow you to add borders, shading a 

                                                  background colors to a cell.  
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Competency Level 7.6:   Recognizes relative versus absolute cell references. 
 
Activity 7.6           :  Let’s do some calculations using relative cell reference and   

                                   absolute cell reference. 

Time : 90 Minutes         
  
Quality inputs      :   ●   Four copies of worksheet containing exercises in Annexe 7.6.1.   

     ●   A work sheet with graded directions in Annexe 7.6.2. 

Learning – Teaching process: 

Step 7.6.1 :   ●   Distribute copies of worksheet containing exercises. 

  ● Ask students to do exercises manually. 
       ●    Conduct a discussion to highlight the following. 

 

 

 
(30 minutes) 

Step 7.6.2 :   ●   Divide the whole class into four groups. 

  ● Distribute copies of the work sheet. 

  ● Ask the students to do the activities described. 

  ● Request students to check the formula bar after each    

                                         calculation. 

(30 minutes) 
Step 7.6.3. :   ●  Let each group present its findings to the class. 

           ●  Conduct discussion to highlight the following. 

 

 

 
 

(30 minutes) 
 
 
 
 
 
 

 
Competency 7 : Uses Spreadsheet to solve simple statistical problems. 

● Manual calculation takes much time. 

● Manual calculation is sometimes difficult. 

● Formulae can be copied using relative cell references. 

• When we want to retain a permanent cell in a formula, the 

Absolute call reference is used. 
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Criteria for assessment and evaluation. 

• Identifies difference between  Relative and Absolute cell reference. 

• Accepts the value of Relative and Absolute cell reference to suit the application and 

 user types. 

• Demonstrate ability to use Relative and Absolute cell reference 

• Justifies one’s answers. 

• Learns from peers. 
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Annexe 7.6.1 
Do following activities. 

1. Find the total marks of the following students.  
 

Name English Science Maths IT Religion Total 
A 45 56 85 66 89  
B 12 46 49 36 95  
C 85 96 74 16 52  
D 52 63 41 74 85  
E 14 25 36 69 58  
F 47 58 69 74 85  
G 12 23 45 56 78  
H 15 48 26 95 84  
I 75 53 95 51 48  
J 46 79 13 64 46  
K 87 98 65 54 32  
L 32 21 65 54 98  
M 78 46 13 13 46  
N 46 54 64 95 84  
O 13 16 18 19 16  
P 59 56 59 64 64  
Q 73 46 46 80 92  
R 20 45 80 94 97  
S 45 90 80 61 23  

 
2. Now give 25 bonus marks to each student and give them total marks. 

Name English Science Maths IT Religion Bonus 
Marks 

Total 

A 45 56 85 66 89   
B 12 46 49 36 95   
C 85 96 74 16 52   
D 52 63 41 74 85   
E 14 25 36 69 58   
F 47 58 69 74 85   
G 12 23 45 56 78   
H 15 48 26 95 84   
I 75 53 95 51 48   
J 46 79 13 64 46   
K 87 98 65 54 32   
L 32 21 65 54 98   
M 78 46 13 13 46   
N 46 54 64 95 84   
O 13 16 18 19 16   
P 59 56 59 64 64   
Q 73 46 46 80 92   
R 20 45 80 94 97   
S 45 90 80 61 23   
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 Annexe 7.6.2 

Relative cell reference and absolute cell reference. 
Work Sheet. 
Create following table and locate Palitha’s total marks as follows.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Then drag using fill handle. The result is given below. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Then go on to each cell in column F and check the formula bar and observe that the cell 

references change. This is Relative cell reference. 
 
Now insert another column “Bonus marks” and type 50 in F2 as follows. Then find the total 

marks as given in the example. 

Note that 2F is typed as $F$2 to keep it permanent. 
 
 
 
 
 
 
 
 
 



 

 National Institute of Education- 2006 276

 
 
 
Then drag and find the total marks of the rest of the students. Then go on to each cell in 
column G and check the formula bar and observe the absolute cell reference. 
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Competency Level 7.7:  Creates charts Using Spreadsheet 
 
Activity 7.7 :  Let’s create charts. 

Time :  90 minutes 
Quality inputs  :  ●   Five copies of an exercise about charts in 

             Annexe 7.7.1. 

●   Five copies of Graded directions  in Annexe 7.7.2 

●    Five copies of Work sheet  in Annexe 7.7.3. 

 
Learning – Teaching process: 
Step 7.7.1 :     ●   Distribute copies of exercise. 

            ●   Let the students to do the activity. 

            ●   Conduct a discussion to highlight the following. 

 

 

 

 

 

(30 minutes) 

Step 7.7.2 :  ●   Divide the class into five groups. 

 ● Distribute copies of graded directions and Work sheet. 

 ● Tell them that each group should create a chart type different 

from others. 

 ● Request students to follow the steps when doing    

                        the activity. 

(30 minutes) 

 
Step 7.7.3 :  ●   Let each group present its findings to the class. 

   ●   Lead a discussion to highlight the following. 

 

 
Competency 7 : Uses Spreadsheet to solve simple statistical problems. 

● It is very important to create graphical representations of 

data. 

● There are different types of charts used for different forms 

of presentation. 

● A chart is a graphical representation of data. 

● A chart can be understood easily. 
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(30 minutes) 

 
 
 
Criteria for assessment and evaluation. 

● Names different types of charts  

● Accepts the need to select charts to match the nature and the requirement of the 

user. 

● Analyses the qualities of a good charts should have.. 

● Creates complete charts. 

● Learns from peers. 
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Annexe 7.7.1 
 
Create a chart according to data in the following table. Create a complete chart. You 
can draw any type of chart  
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Annexe 7.7.2 
Creating a Chart. 

 
1. Select the cells that contain the data you want to appear in the chart. 
 
 
 
 
 
 
 
 
 
 
 
 
 
2 Click Chart Wizard. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
3. Select a chart type and click  
                        button to the second step. 
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4. Select the data range you want to include in the chart. Then select Series in rows or 
Series in columns to determine which data range to be displayed  also   with X axis and click                        
button 
 
        . 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
5. Under chart option see chart titles, gridlines, legends, data labels and other   
    options. Then click  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
   
 

5. Select the location where you want to place the chart. Select As new sheet to place 
the chart in a chart sheet and select As an object in to place the chart in a particular 
sheet as an object. Then click FINISH button and place the chart in the particular 
location. 
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AN EXAMPLE. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Annexe 7.7.3 

Spread Sheet - Charts 
Work sheet 
 
Enter the following data to the work sheet and create a chart. 
 
  
 
 
 

Title of the 
Y axis 

Title of 
the X 
axis 

Grid 
Line 

X Axis 

Y 
Axis 

Chart 
Title 

Legend 
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The chart will be as follows. 
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Competency 8.1: Makes attractive presentations using basic features of presentation 

software. 
Activity  8.1 :    Let’s make our presentations attractive by using different layouts,  

                             designs, colours and objects. 

Time :    120 minutes  

Quality inputs      : • Teacher developed slide show on a CD.   

  •    Three copies of group exploration instructions in Annexe 8.1.1  

    • Three copies of graded direction in Annexe 8.1.2 

  •    Three hard copies of a previously developed presentation in 

                                          Annexe 8.1.3 

  •     Three computer stations with software  

                     
Learning – Teaching Process: 

Step 8.1.1 :    •    Expose the class to the slide show given.  

  •   Get students to comment on the presentation comparing with their 

own manual presentation. 

  •   Conduct a discussion to highlight the following. 

 

 

 

 
 
 

 

 

 

(15 minutes) 

 

• Use of multimedia including text, sound, pictures, animation 
and video helps highlight important aspects of the   
 presentation.  

• Easy access to a variety of layouts enables those to be 
selected to suit the content covered. 

• Variety of backgrounds facilitated through appropriate designs 
and suitable colours enhance the attractiveness of the 
presentation. 

• The ability to manipulate text enables short, simple and easy to 
understand presentations. 

• The high initial cost, however, does not allow all interested 
parties to access the needed software and hardware.  

Competency 8 : Uses Presentation software to design electronic 
presentations. 
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Step 8.1.2 : • Divide class into three groups.    

  • Distribute group exploration  instructions, graded directions, pre-

prepared presentation, demy sheets and markers across the 

groups.  

 • Involve groups in the exploration.  

  • Prepare groups for a presentation at the plenary.         

    (30minutes) 

Step 8.1.3 : • Get each group to present its findings. 

• Request the presenters themselves to fill gaps, if any. 

• Seek for constructive comments of other groups  

  •  Conclude the session by highlighting the following.  

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

(20 Minutes) 
 

(30 minutes) 

 

 

 

(20 minutes) 

•   The text of the pre-prepared presentation has to be studied  

        carefully as a first step in improving the presentation 

•   The layout as well as the background designs and colours  

have to be carefully selected to make them relevant and  

attractive. 

•    Clip art, Word art, charts, tables, photographs and  videos    

      are some objects that can be inserted to improve the  

      quality of the presentations.  

•    There are three modes to view the presentation.  

•    The normal view allows only one slide to be viewed at  

a time, with editing facilities made possible  

simultaneously.  

•   The sorter view presents all slides developed on one  

screen allowing the users to select  any file that they  

wish to edit. 

•   The outline view presents an overview of all slides  

already developed and yet to be developed with the  

content providing an opportunity for the user to enter  

or edit text as required. 

•   The slide show enables the total output to be viewed  

on the full screen one at a time.  
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Criteria for Assessment and Evaluation 
 

• Names the basic features in a presentation software and describes each of them. 

• Accepts the value of electronic presentations as aginst traditional method. 

• Makes good presentation using basic features of software. 

• Presents ideas simply and precisely. 

• Demonstrates sensitivity to needs and feeling of others.  
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 
 
 



 

 National Institute of Education- 2006 287

 

Annex 8.1.1  
Instructions for the Group Exploration 

 
• You will be working in three groups with the following three basic features of presentation 

software randomly distributed among the three groups. 

o Changing the slide layout  

o Introducing new slide designs with different background colours  

o Inserting objects. 

• Go to the computer assigned to your group. 

• Use any method that you are familiar with to open the presentation software package. 

o Identify the menu that helps you accomplish the task given. 

o Familiarize yourself with each option made available by the menu.  

• Tryout the options and be creative to develop a slide show on the task assigned to your 

group.  

• Use a variety of methods to view the presentation developed. 

o Identify the problems that you encountered while engaged in the task and note them 

down on the demy sheet given, with the action you have taken to solve them.  

o Be prepared to make a whole-class presentation.  
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Annexe 8.1.2 
Graded Directions 

Starting a Microsoft PowerPoint package  
Click START button from the task bar  

Move to programs  Microsoft Office  Microsoft PowerPoint( Click) 

Or 

Move to programs  Microsoft PowerPoint( Click) 
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The Parts of the PowerPoint Window 
The PowerPoint Window has toolbars and panes to help you quickly create presentations. 
Most of the toolbars are common in Office applications but may feature options unique to 
PowerPoint. 

• Title Bar - displays the document name followed by a program name.  
• Menu Bar - contains a list of options to manage and customize documents.  
• Standard Toolbar - contains shortcut buttons for the most popular commands.  
• Formatting Toolbar - contains buttons used for formatting.  
• Status Bar - displays slide position and the type of design in PowerPoint.  
• Drawing Toolbar - contains tools for drawing lines, shapes and objects.  
• Help - provides quick access to Help topics.  

PowerPoint XP has a new default Normal view - the Tri-Pane View. This view, which opens 
when you launch PowerPoint, allows you to see multiple parts of a presentation at once. 
One of the other noticeable changes between PowerPoint 2000 and PowerPoint 2002 is 
the Task Pane. Located on the right side of the computer screen, this pane allows you to 
select tasks in different categories and allows you to quickly enhance your slides in a few 
steps. You'll learn more about the Task Pane later in this 
module.

 
 
Also new in PowerPoint 2002 are the Outline and Slides Tabbed Panes. Click on the tabs 
on the left side of the screen to view an outline or a slide of your presentation. The tabs 
render differently based on the size of the pane. 
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You can show or hide PowerPoint's toolbars. Click on the View menu and choose 
Toolbar. Decide which ones you want to show or hide. 
 

View Buttons and Slide Views 
The view buttons at the left bottom corner of the screen allow three slide views: Normal 
View, Slide Sorter View and Slide Show. 

 
The view buttons can be useful as you prepare your presentation. They control the way 
slides are displayed on the screen. Click a view button to see a different view. 

Normal View contains the Outline and Slides Tabbed Panes on the left, the Slide 
pane in the center and the Task Pane on the right.  
The Outline View shows the text of your presentation for easy editing while Slides View 
shows text and graphics of the slide you're working on. Click on the tabs to switch between 
the two views. Under the center slide area is a place for notes. 

 
You can hide or show the different panes in Normal View. To hide the Task Pane, click 

on the View menu and choose Task Pane. (The View menu also allows you to choose other 
views). To hide the Outline View and Slide Tabbed Panes, click on the X to the left of the 
Slides Tab.  

More Views 
Here are some other views that may be useful as you create your presentations: 

Slide Sorter View lets you see small versions of all the slides you have created. You 
can delete, copy, and move slides in this view. 

Slide Show lets you see your presentation electronically as it will appear to an audience. 
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The Task Pane 
The PowerPoint XP Task Pane replaces the dialog boxes used in PowerPoint 2000. The 
down-pointing arrow in the top, right corner of the pane allows you to select different menus 
and tools. By default, the Task Pane appears when PowerPoint XP is launched. 

 
The Slide Layout and Slide Design panes within the Task Pane help organize layouts, 
design templates, and color schemes. When you select a design option, your slides are 
quickly updated with the new look. 
You can view the Slide Layout and Slide Design panes by clicking on the down-pointing 
arrow next to New Presentation in the Task Pane. 

 
Select Slide Layout or Slide Design (Design Templates, Color Schemes, Animation 
Schemes). You'll learn more about using these panes later in this course. 
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Using the Task Pane 
If you do not see the Task Pane on the right side of the PowerPoint window, you can easily 
access it.  

 
To Open the Task Pane: 

• Click View Task Pane  

 
To View Different Panes: 

• Click on the down-pointing arrow next to New Presentation and select different 
panes.  

• Once you open different panes, you can move through them by clicking on the 
backward and forward arrow buttons on the left.  

 
To Close the Task Pane: 

• Click the X on the right corner of the bar.  

 
You can hide or view the Task Pane by clicking on View  Task Pane.  

 

Creating a Blank Presentation 
PowerPoint offers three ways to create a presentation: Blank presentation, From Design 
Template or From AutoContent Wizard. 
The Blank presentation option is one of the more commonly used methods. It offers several 
blank slides with layouts for text and graphics. 
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To Create a Blank Presentation: 

• Open PowerPoint.  
• A slide featuring a place for a title and subtitle appears by default. You may begin 

your presentation with this slide or choose a different slide layout.  

 

• The New Presentation Pane appears on the right side of the screen.  
• Under New, click Blank Presentation.  
• A list appears.  
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Choosing a Slide Layout 
As you work on your presentation, think about the type of layout you want. Do you want a 
slide with text and lots of clip art or one with text and a chart? PowerPoint offers many layout 
options. 

To Choose a Slide Layout: 

• Move your arrow pointer over the layouts or use the scroll bar in the Slide Layout 
Pane.  

• A gray bar appears on the right of each layout.  
• When you find a layout that you like, click the down-pointing arrow and choose Apply 

to Selected Slide.  
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You can also click on the slide layout to apply it. Notice that the slide you are currently 

working on has a dark border in the Outline Pane. 

Placeholders 
Once you choose a layout for your slides, you can begin adding text, graphics or other items. 
You do this with placeholders - special places within a slide where you can add content. 

To Add Text to a Placeholder: 

• Click on the placeholder.  
• Start typing.  
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(You'll learn about inserting clip art and other graphics into placeholders later in this course) 
 

Saving a Presentation 
You can save, close, and exit presentations in PowerPoint just as you would while using 
other Microsoft applications. 

To Save a Presentation: 

• Click on File  Save. (Ctrl + S)  
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• Choose the location where you want to save your presentation. (My Documents is a 
good place).  

• Type a name in the File Name box or keep the one that PowerPoint has provided.  

Closing a Presentation and Exiting PowerPoint 
Once you've finishing working on your presentation, you can quickly close it. 

To Close a Presentation: 

• Click the X in the PowerPoint presentation window (Ctrl + W).  

 

• The PowerPoint application remains open and you can start a new presentation. 
(See next page for details).  

To Exit PowerPoint: 

• Click the X in the far right top corner.  

 
OR 

• Choose File  Exit. (Alt + F4)  

Before you exit PowerPoint, make sure that you save any work that you want to keep. 
 

Creating a New Presentation Using the Traditional Method 
Remember, after you have closed one presentation, you can easily start a new one while 
PowerPoint is still open by using the traditional new file creation method. 

To Start a New Presentation: 

• Click on File  New. (Ctrl + N)  



 

 National Institute of Education- 2006 298

 

• In the New Presentation Pane, under New choose Blank Presentation.  

 

• Choose the design layout that you want.  

Remember, if your Task Pane disappears from the right side of the screen, click on View 
Task Pane 

 

Opening a Presentation 
You can quickly open a presentation that you've previously saved by using the Task Pane. 

To Open a Presentation 

• Start PowerPoint.  
• In the Task Pane under Open a Presentation, click on the presentation that you 

want to open.  
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OR 

• Choose File  Open.  
• Navigate the file you want to open.  

Group A 

Inserting a New Slide 
Once you've created your opening slide, you'll want to add more slides to your presentation. 

To Insert a New Slide: 

• Click on Insert New Slide. (Ctrl + M)  
• Move your arrow pointer over layouts or use the scroll bar and choose a slide layout.  
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• A gray bar appears on the right  
• Click the down-pointing arrow and choose Insert New Slide.  

OR 

• Click the New Slide button at the top of the screen  
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• Move your arrow pointer over layouts or use the scroll bar and choose a design 
layout.  

• A gray bar appears on the right  
• Click the down-pointing arrow and choose Insert New Slide.  

Copying a Slide 
Copying is another technique that you may use as you work on your slide presentation. For 
example, you may want to repeat a slide later in the presentation or copy a slide and make 
slight changes to it to make a different point. 

To Copy a Slide: 

• Click the slide you want to copy in the pane on the left.  
• Click on the Copy Button on the Standard Toolbar. (Ctrl + C)  
• Move the arrow pointer to where you want the copied slide to appear.  

OR 

• Right click the slide you want to copy in the pane on the left.  
• Move the arrow pointer to where you want the copied slide to appear.  
• A horizontal cursor appears.  
• Click the Paste Button on the Standard Toolbar or right click Paste. (Ctrl + V)  

Deleting a Slide 
Sometimes you may want to take one or more slides out of your presentation. 

To Delete a Slide: 

• Click the slide.  
• Press Delete on your keyboard.  

OR 

• Right click the slide you want to delete in the pane to the left Delete Slide.  
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Slide Sorter View 
As you are working on your presentation, you may want to change the order of your slides. 
You can rearrange slides in Slide Sorter View. It allows you to view miniature slides that 
you can drag and drop. 

To Manipulate Slides in Slide Sorter View: 

• Click on the Slide Sorter View button in the left bottom corner of the page.  
• Click the slide you want to move.  
• Hold down the left mouse button and drag the slide to its new location. A pointer with 

a box appears as you drag the slide.  
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• Click on the Normal View button to return to Normal View.  

Working with Slides in Normal View 
You can also easily move slides in Normal View. Remember, this is the Tri-Pane View that 
shows small slides on the left, a slide in the center and the Task Pane on the right. 

To Move Slides in Normal View: 

• Click on the Normal View button .  
• Click a slide in the left pane and drag and drop it to its new location.  
• Hold down the left mouse button and drag the slide to its new location. A pointer with 

a box appears as you drag the slide.  

 
To toggle between the different views in PowerPoint XP, click on the View buttons or 

click on View Slide Sorter, Normal or Slide Show. 
 

Changing and viewing Slides in Outline View 
Outline View also allows you to make changes to slides. While you can drag and drop 
slides in this view, it's also useful for making changes to the text of your slides or for viewing 
multiple slides. 
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To View or Make Changes to Text in Outline View: 

• Click the Outline View tab in the left pane.  

 

• An outline view of your slides appears with text.  
• Click on the small gray slide you want to make changes to.  
• Scroll through the slides in outline view.  
• Select the slide in the outline and then type changes directly onto the center slide.  
• You can view the text of all of your slides in this view.  
• Return to Normal View by clicking the Slides tab in the left pane.  

Viewing Slides in Slide Show View 
After you have made some changes to your PowerPoint presentation, you can get an idea of 
how it will look as a slide show. 

To View Slides in Slide Show View: 

• Click on the Slide Show button  at the bottom left corner of the screen.  

OR 

• Click on View Slide Show.  

 

• Click on each slide until you reach the end of the slide show. (black screen)  
• Click to exit and return to Normal View 

Group B 

Applying a Design Template 
PowerPoint offers Design Templates to make it easy to create an attractive presentation. 
These templates come in a variety of colors and styles. You can apply a design to existing 
slides or begin a new presentation with a template. 
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To Begin a New Presentation with a Design Template: 

• Open PowerPoint.  
• In the Task Pane under New, click on From Design Template.  

 

• A list of templates appears.  
• Move your mouse pointer through the different designs or use the scroll bar.  
• Click on the down-pointing arrow in the gray box next to the template that you like.  
• Choose Apply to All Slides.  

Adding a Design to an Existing Presentation 
Do you have an existing presentation that you want to add a design to? PowerPoint makes it 
easy to enhance existing slides with a design template. 

To Apply a Design to an Existing Presentation: 

• Open PowerPoint.  
• In the Task Pane, under Open a presentation, click on the presentation you want.  
• Click on the down-pointing arrow in the New Presentation pane and choose Slide 

Design - Design Templates.  
• A list of templates appears.  
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• Move your mouse pointer through the different designs or use the scroll bar.  
• Click on the down-pointing arrow in the gray box next to the template that you like.  
• Choose Apply to All Slides.  

 

Applying a Design Template to Selected Slides 
As you are working on your presentation, you can choose Apply to Selected Slides if you 
want one or more slides to have a different look. 
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A Closer View of Design Templates 
If you want a closer look at the Design Templates, follow these steps:  

• With a presentation open, click on a template.  
• Click on the down-pointing arrow in the gray bar to the left.  
• Choose Show Large Previews. (It is now checked).  

 

• To return to the smaller views of the slides, click in the gray bar of any template and 
uncheck Show Large Previews 

Choosing a Color Scheme 
PowerPoint's Design Templates have pre-selected colors but you can choose your own 
color scheme. A color scheme is a combination of colors for the text and background of 
your slides. 

To Choose a Different Color Scheme: 

• In the Task Pane, click on the down-pointing arrow in the gray bar next to New 
Presentation.  

• Choose Slide Design - Color Schemes.  
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• A list of color schemes appears.  
• Move your arrow pointer through the different color scheme options or use the scroll 

bar.  
• When you find a color scheme that you like, click on the down-pointing arrow in the 

gray box and choose Apply to All Slides.  

Group C 

Adding Text to an Original Slide 
Many of PowerPoint's slides have text boxes already included and ready for you to add 
information. However, if you create an original slide you'll need to add a text box or two. 

To Add Text to an Original Slide: 

• Insert a blank New Slide.  

 

• Click on the Text Box button in the Drawing Toolbar.  

 

• Click and drag your mouse pointer to create a text box on the slide.  
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OR 

• Click on Insert Text Box.  

 

• Click and drag your mouse pointer to create a text box.  

 

The Formatting Toolbar 
PowerPoint's default font or text type is Arial. However, you may want to change the font 
type, font size and more. Use the Formatting Toolbar to set the color, size, and overall look 
of your text. It doesn't matter whether the text is an original slide or is in a preset layout.  
Here are some of the formatting options: 

• Font type  
• Font size  
• Bold, Italics, and Underline  
• Center, Align Left, and Align Right  
• Bullets and Numbering  
• Font color  
• Increase Font Size  
• Decrease Indent  

 
For more formatting buttons, click on the down-pointing arrow at the end of the toolbar. 

Choose Add or Remove Buttons - Formatting. Choose any additional options you want on 
the Formatting Toolbar. You can also choose Show Buttons on Two Rows. 
 

Formatting Text 
The Formatting Toolbar allows you to make many changes to your text to give it the look you 
want for your presentation. 
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To Format Text 

• In the Formatting Toolbar, click on the down-pointing arrow OR button for the item 
you want to format.  

• For example, to set the font size for text you haven't typed yet, click on the down-
pointing arrow next to the number and choose the font size. To change the font color, 
click on the down-pointing arrow next to the "underlined" A.  

 

• To make formatting changes to existing text, highlight the text and click on the down-
pointing arrow OR button for the formatting change.  

 
Take some time to experiment with the different formatting options to decide what's best for 
your presentation. 
 

The Format Menu 
You can also use the Format menu to make formatting changes to the text in your 
presentation. 

To Use the Format Menu: 

• Click on Format Font.  

 

• A dialog box opens.  
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• Choose the font, font style, and/or size.  
• Click OK  

Cut, Copy, and Paste 
Once you've determined how your text will appear in your slides, you may need to cut copy 
or paste some information. 

To Copy and Paste: 

• Select the text you want to copy.  

 

• Click the copy button on the Standard Toolbar. (Ctrl + C)  

 

• Move your mouse pointer to the location on the slide where you want the text to 
appear.  

• Click the paste button on the Standard Toolbar. (Ctrl +V)  
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To Cut and Paste: 

• Select the text you want to cut.  
• Click the cut button on the Standard Toolbar. (Ctrl + X )  

 

• Move your mouse pointer to the location on the slide where you want the text to 
appear.  

• Click the paste button on the Standard Toolbar. (Ctrl +V)  

The keyboard shortcuts - Ctrl + C, Ctrl + X, and Ctrl + V - can help make cutting, copying 
and pasting faster. If you don't already know them, learn these shortcuts. 
 

Inserting Clip Art into a Slide 
Clip art is a collection of graphical images. You can easily enhance your presentation with 
clip art in a few easy steps.  

To Insert Clip Art into a Slide: 

• In the Outline view in the left pane, select the slide in which you want the clip art to 
appear.  

• Click the Clip Art button on the Drawing Toolbar.  

 
OR 

• Select the slide you want to work on.  
• Click on the down-pointing arrow in the Task Pane Insert Clip Art.  

If you are working with a slide that has an icon for clip art, click on the icon. You'll learn 
more about this later in this module. 
 

Searching for Clip Art 
Once you activate the Insert Clip Art option, a list of clip art appears on the screen. If you 
don't see the clip art that you want for your presentation, you can browse for it using the 
Search feature. 
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To Search for Clip Art 

• With the Search dialog box open, type the name of the image that you are looking 
for. For example, people, buildings, winter.  

• Click on Search.  

 

• Click on the clip art that you want to insert  

 

• Click OK.  
• The clip art appears in your slide.  

You can move or resize clip art and other content once it has been inserted into a slide. 
You'll learn more about this later in this module. 
 

Inserting Pictures from File 
Adding pictures to your presentation may also help engage the audience's attention. You 
can insert pictures that you have on file on your computer. 
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To Insert a Picture from File: 

• Click on Insert Picture From File.  

 

• Navigate to the folder where you've saved your picture.  
• Click on the picture you want to insert into the slide.  

OR 

• Click the Insert Picture button on the Drawing Toolbar.  

 

• Navigate to the picture that you want to use.  
• Select the picture and click Insert.  

Inserting Pictures or Clip Art Using a Slide Design Layout 
Some slide layouts already have icons for clip art and pictures. PowerPoint allows you to 
insert pictures through these slide design layouts.  

To Insert Pictures Using a Slide Design Layout: 

• Browse the slide design layouts to find one with an icon for a picture.  
• Click on the picture icon.  
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• Navigate to the picture you want to insert.  
• Select the picture and click Insert.  
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Annexe 8.1.3 

Sample Presentation 
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Competency Level  9.1: Explores the Concept of Database 
Activity 9.1         :   Let's explore the concept of Database 

Time                   :   120 minutes                

Quality Inputs   :   ●  Four copies of  in Reading Material 9.1.1  

                               ●  Student Registration Table in Annexe 9.1.2  

  ● Four copies of group exploration instructions in  

    Annexe 9.1.3 
  ● Demy sheets and Markers 

Learning – Teaching Process:                          

Step 9.1.1 :  ● Tell students that they are going to develop a database of 

students. 

 ● Get them to suggest some important data items and a framework 

for presenting the data items. 

  ●   Conduct a discussion to highlight the following:  

 

 

 

 

 

 

 

 

 

 

   (15 minutes) 

 

 
Competency  9 : Develops simple databases to elicit information. 

● Data can be presented through a table. 
●   A table can be prepared to illustrate fields & records.  
●   Serial No, Name, Address, and Age are some fields. 
     of a student database 

Serial 

No 

Name Address Age 

    

    

    

●  Data presented in rows are records. 
●  Serial No is the unique field that helps differentiate 

between similar records. 
●  A database can consist of one or more tables. 
●  A key field helps link a number of tables together.  

 



 

 National Institute of Education- 2006 319

   

 

 

 

 

 

Step 9.1.2 :     ● Divide the class into four groups.    

    ●     Provide each group with the Reading Material and a copies of  

     the student registration table and the assignment. 

 •  Involve groups in the exploration.  

•    Prepare groups for a presentation at the plenary.. 

(60 minutes) 

Step 9.1.3 :     • Get each group to present its findings. 

• Request the presenters themselves to fill gaps, if any. 

• Seek for constructive comments of other groups  

•  Conclude the session by highlighting the following. 

 

●    A database is a collection of related data organized in one or 

more tables. 

●   Student Registration Table on its own is a simple database. 

●   This can be converted to a complex database by combining   

       it with other Tables on Courses, Teachers and   

       Examinations. 

●   The five fields of the student registration database are   

       Registration No, Name, Address, Group and Payments. 

●   Data on a particular student pertaining to these fields form    

a record. 

●  The Student Registration Table given has five fields and eight 

records. 

●   Each data item of a record is called an attribute. 

●   Each field represents one attribute of a record. 

●   A table can have two or more similar records. 

●   In such situations a key field helps identify these records  

separately. 

●   The Student Registration No. That serves this purpose is  

   the key field of the record.  

   
   (45 minutes)    

    Criteria for Assessment and Evaluation 
● Names basic components of a Table and defines them. 

● Accepts the table as a useful tool for systematic organization of data. 

● Interprets a table in terms of the basic components of a DBMS. 

● Develops a complex concept in terms of its basic components. 

● Derives meaning from text. 
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Annexe 9.1.1 
Reading Material 

 
What is a database? 
A collection of data can be defined simply as a database.  A database is organized in lists of 

related information.  For example, a database for a school can have about details of 

Teachers, Students, subjects, Equipments and so on. 

A Relational database is a collection of tables, which are related to each other and stored in 

one place.  A relational database in which more than one table can share information. 

 

What is a table? 
Table is a primary object of a database.  In a database, it may contain several topics that 

represent tables. For example, a database for a school can have tables of Teachers, 

Students, subjects, Equipments and so on. 

 In a table, there are two components named as Record and Fields. 

  

What is a Record? 
A record shows information about a single item or a single person in the table.  All the details 

relating to one person or item can be put on that record.  Information in a record can be 

broken down into several fields.  Therefore record can be defined as a collection of fields. 

 

What is a field? 
A field is a piece of data within a record.  In a teacher record, things like NAME, ADDRESS, 

BIRTH DATE, JOB TITLE, GRADE, SALARY etc. can be identified as Fields of the record. 

Each field has a name that identifies it. 

 

 

 

 

 

 

 

 



 

 National Institute of Education- 2006 321

 

Annexe 9.1.2 

 

Table of Student Registration                                                                         

 

      

 

 

 

 

 

 
 
 
 
 
 
 
 

Register 
No 

Name Of Student Address        
Group 

     Payment 
(Rs.) 

001 Kamal Polonnaruwa A 1000 

002 Nimal Kandy A 1200 

003 Ravi  Galle B 800 

004 Wimal Colombo C 1200 

005 Lal Negambo B 1000 

006 Nayana Jaffna C 1200 

007 Dinithi Matale A 1000 

008 Sandini Ratnapura C 750 
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Annexe 9.1.3 

Instructions for the group exploration 

• You will be working in four groups with the following four topics assigned to the four 

groups 

o Database 

o Table 

o Field 

o Record 

 

• Go through the relevant definition in the handout to be familiar with the topic given. 

• Study the table to identify the place of topic in it  

• Be prepared to introduce the topic to the whole class in relation to the table 
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Competency Level 9.2 :  Creates a simple database with a single table, manually 

Activity   9.2      :   Let's design a simple database  

Time                   :   90 minutes                

Quality Inputs   :  ●  Five copies of datasheet in Annexe 9.2.1   

     Demy sheets and markers. 

                    

Learning – Teaching Process: 

Step 9.2.1 :  ●  Expose the data sheet to the class, prepared for developing a 

database Annexe 9.2.1 

● Ask them to write down the appropriate field names from given 

table.  

● Conduct a discussion to highlight the following. 

 

 

 

 

 

 

 

 

 

 

 

                       

 

● Data in the sheet can be categorized 
under the following eight headings 
referred to as field names 

o Registration number 
o Name 
o Address 
o Telephone Number 
o Date of Birth 
o Sex 
o School 
o Fees 

 
● Data in a field is associated with type 

and size 
● Some examples of data types are: 

o Text (e.g. Name of a student) 
o Number (Marks) 
o Date/Time (Date of birth) 
o Currency  (Registration Fees) 

● A collection of fields makes a record 
● Each record is identified through a 

unique field  

 
Competency  9 : Develops simple databases to elicit information. 
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(20 minutes) 

Step 9.2.2 :     ●  Divide the class into five groups 

● Get each group to identify a different set of data 

●  Provide each group with a copy of the data sheet 

● Get them to use the data to develop a manual database 

● Identify every field of records & complete the table 

● Add a identification field as the key field to identify each record 

                (40 minutes) 

 

Step 9.2.3 :   ●  Get each group to present its completed tables. 

   ●  Conduct a discussion to highlight the following. 

 

 

 

 

 

 

                                         

       (30 Minutes) 

          

Criteria for Assessment & Evaluation 

● Describes the main characteristics of a database. 

● Accepts that each record of a database needs to have a unique identification 

● Uses given information to develop a database. 

● Organizes information systematically to facilitate decision-making. 

● Selects relevant items for a task at hand. 

● In developing a database it is very important to identify a 

unique field.  

● Student registration number is the unique field in the student 

database.  

● In designing a table, one has to identify relevant field names 

and data types.  

● Field size has to be decided in terms of the maximum 

number of characters to be incorporated
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Annexe 9.2.1 

Personal Data of Ten Students 

 
 

 

 
 
 
 
 

 

 

 

 

 

 

Dinithi Thilanga 

487, Govt Housing Scheme, 

New Town, 

Polonnruwa 

Thopawewa M.V 

1988.06.06 

Female 

027-2222755 

1200/= 

Amali Silva 

15, “Vasana” 

1st Cross Street, 

Hingurakgoda. 

Ananda B.V 

1988.06.01 

Female 

027-2245452 

1200/= 

Rohini Amarasinghe 

12,Jayagath Mawatha, 

Aluthwewa. 

Seevali M.V 

1978.03.21 

Female 

078-5187701 

1200/= 

Tharaka Amarasena 

Lake View Garden, 

Polonnruwa 

Thopawewa M.V 

1990.12.04 

Male 

027-2222755 

1200/= 

Dammika Arunakanthi 

New Town, 

Polonnaruwa 

Nagara M.V 

1967.04.09 

Female 

077-9023771 

1200/= 

Sandini Amasha, 

100, School Lane, 

New Town 

Minneriya C.C 

1990.05.24 

Female 

027-2221212 

1200/= 

Ajith Rajapaksha  

15, Circular Rd, 

Polonnaruwa 

Royal Central College 

1967.05.27 

Male 

0777-851517 

1200/= 
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Annexe 9.2.2 
Instructions for the group exploration 

  
● You will be assigned with the task of developing one of the following databases. 

● Inventory of a school Computer Learning Center (CLC). 

●  Salary particulars of schoolteachers. 

● Daily sales of the school canteen. 

● Identify at least five fields for the database given. 

● Select data at least for five records. 

● Develop your database incorporating fields and records.  

● Use the data in the data sheet to develop a separate database. 

● Identify the unique field of this database. 

● Check to see whether the database assigned to your group is also associated with a 

key field.  
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Competency Level 9.3 :  Creates relational database manually 
Activity 9.3 :   Let’s simplify our tasks by manipulating relational databases. 

Time :   120 minutes 

Quality inputs :   ●   An enlarged version of the diagram in Annexe 9.3.1. 

  ● Three copies of the Group Exploration Instructions in  

   Annexe 9.3.3. 

     ●    Three copies of the graded directions 9.3.2 

  ● Three computers with DBMS installed. 

  ● Demy sheets and markers 

Learning –Teaching process: 

Step 9.3.1 :   ●   Expose the diagram to the class. 

  ● Get students to match the companies with their products. 

  ● Also request students to name three attributes each for the  

   companies and their products. 

  ● Ask them to identify the difficulties that they would encounter  

   when combining the two sets of attributes. 

     ●   Conduct a discussion to highlight the following. 

 

 

 

 

 

 

 

 

 

 

 

(15 minutes) 

 

 
Competency  9 : Develops simple databases to elicit information. 
 

●     Some attributes of the company are company number, 
name and address.   

● Some attributes of a product are Item number, name, 
volume and colour.   

● The two unique attributes in the two groups are company 
number and item number  

● These are unique because no number can be duplicated 
and no record can exist without a number.  

● When developing a single table including all the attributes 
time and storage space are normally wasted due to 
duplication.  

● Relational databases enable users to prevent these 
difficulties. 
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Step 9.3.2 :   ●   Divide the class into three groups. 

     ●   Provide each group with copies of exploration instructions, graded 

directions, demy sheets and markers. 

  ● Send the three groups to the three computers.  

  ● Assign tasks and involve the groups in developing the databases  

     ●   Prepare groups for a whole-class presentation.      
     (45 minutes) 

Step 9.3.3 :   ●   Get groups to present their findings. 
  ●    Conduct a discussion to highlight the following.  
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

(40 minutes) 
 
Criteria for assessment and evaluation  
 

●   Explains the concept of relational database in one’s own words. 

●  Accepts the value of using relational databases to save time and energy of users and 

storage space of computers. 

● Designs tables to manage data, needs of users and converts same into electronic     

media. 

●   Develops models to facilitate complex tasks. 

●   Avoids duplication to make the maximum of available limited resources. 

 

● A relational database consists of a collection of tables that 

store particular sets of data. 

● Repeating groups are identified and placed in two tables to 

reduce redundancy of data. 

● A Primary Key is one or more columns whose values 

uniquely identify a row in a table  

● A unique attribute which does not allow duplication in a table 

is called a primary key.  

● If the primary key is not assigned, there can be duplication 

of records in a table.  

● Unique key field helps to create a relationship between two 

tables.  

● The relationship in a Relational DBMS are of three types. 

o One-to-one 

o One-to-many 

o Many-to-Many 
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Company 

One Company Many Items 

Annexe 9.3.1 

Diagram to simplify the concept of relational database 

 

 
Company  
     No 

Company 
    Name 

Company
   
Address 

   Item 
    No 

Item 
Name 

Item 
Volume 

Item 
Colour 
 

01 ABC Colombo A001 Soda 300ml no 

01 ABC Colombo A002 Orange 200ml Orange

01 ABC Colombo A003 Ginger 300ml Brown 

01 ABC Colombo A004 Lime 300ml Green 

02 XYZ Galle A005 Soda 300ml no 

02 XYZ Galle A006 Orange 200ml Orange

02 XYZ Galle A007 Ginger 300ml Brown 

03 PQR Kandy A008 Cola 300ml Red 

03 PQR Kandy A009 B&W 300ml White 

03 PQR Kandy A010 Choco 300ml Brown 

 
 
 
 

Annexe 9.3.2 
           

 
 

 

 

 

 

 

 

 

 

Item4 

Item3 

Item2 

Item1 
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•  

Annexe 9.3.3 
Instructions for the Group Exploration 

 

• You will be working in three groups developing the following three databases assigned 

randomly to the groups.  

o Database of students by courses offered. 

o Database of teachers by schools 

o Database of divisions by province  

• Go to the computer assigned to your group. 

• Read the task assigned to your group to familiarize yourself on the two databases to be 

combined. 

• List attributes separately for the two databases. 

• Open the DBMS package loaded in the computer. 

• Start by assigning a name to the newly created database. 

• Develop two tables including the attributes identified. 

• Identify one attribute unique to each group of attributes and assign it as the primary key.   

• Identify the relationship among the tables as one to one, one to many or many to many.  

• Combine the two tables by placing one of the primary keys as appropriate. 

• Discuss with others in your group to identify the foreign key. 

• Write down, on the demy sheet given the steps you followed. 

• Also write down the problems encountered and what you did to overcome them. 

• Be prepared for a whole-class presentation.  
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Competency Level 9. 4  :  Creates a Relational Database manually 

Activity  9.4       :   Let’s design a database containing several   tables. 

Time                   :  60 minutes             

Quality Inputs   :  ●  Table containing details of Education divisions and schools in   

   Annexe   9. 4. 1 

  ● List of Definitions in Annexe 9.4.2  

                               ● Five copies of group exploration instructions in Annexe 9.4.3 

Learning – Teaching Process:   

Step  9.4.1 :   ●  Divide the class into 5 groups. 

  ● Provide each group with a copy of Annexure 9.4.1 

  ● Let them study the table & list out some of its drawbacks. 

  ● Conduct a discussion about the previous database and highlight 

the following. 

     

                                

 

              

 

 

 

(15 Minutes) 

 

 
● A Database is a collection of tables. 

● Tables can be used to enter different types of data. 

● To identify each record, there should be a unique field 

known as Primary Key. 

● Storing same data repeatedly (data duplication) limits the 

storage capacity and wastes the time. 

 

 
Competency  9 : Develops simple databases to elicit information. 
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Step 9.4.2 :  ●  Divide the group into five groups. 

  ● Provide each group with a copy of Annexure 9.4.2 and ask them to 

study it. 

  ● Provide each group with group exploration instruction  

              (25 Minutes) 

Step 9.4.3  :  ●  Get each group to present their findings 

     ●  Let them give their comments 

     ●  Conduct a discussion and highlight the following. 

 

 

 

                                         

 

 

 

 

 
 
 
 
 
 
 
 
 
 

(25 Minutes) 

● Relational database can contain one or more tables, which 

are related to each other. 

● Each table should consist of a unique field known as 

Primary key. 

● Such a system is called A Relational Database 

Management System (RDBMS). 

● When we place the primary key of the table in another 

table as one of its fields to create a relationship, this key is 

known as Foreign key 

● A relationship is an association between two or more 

tables. Relationships are expressed in the data values of 

the primary and foreign key.  
● A foreign key is a field whose values are the same as the 

primary key of another table.  

● Related tables are useful to make any queries only with 

required data. 
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Criteria for Evaluation & assessment 

● Explains the Relational Database Management system 

● Identifies primary & foreign keys to make relationships 

● Design a database with multiple tables 

● Builds up good relationships. 

● Simplifies complex databases.   
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Annexe   9. 4. 1 
 

Details of Education divisions & schools in Polonnruwa. 

Div_Name Div_Address Div_ContactNo School_Name Sch_Address Sch_ContactNo No_Teachers 

Polonnaruwa New Town, 

Polnnaruwa 

027-2228967 Royal Central 

College 

New Town, 

Polnnaruwa 

027-2222401 141 

Polonnaruwa New Town, 

Polnnaruwa  

027-2228967 Thopawewa M.V Sacred City, 

Polonnruwa 

027-2221234 98 

Polonnaruwa New Town, 

Polnnaruwa 

027-2228967 Muslim Central 

College 

Kaduruwela, 

Polonnaruwa 

027-2222471 89 

 Polonnaruwa New Town, 

Polnnaruwa 
027-2228967 

Vigitha Central 

College 

Pulasthigama, 

Polonnruwa 

027-2228321 75 

Polonnaruwa New Town, 

Polnnaruwa 

027-2228967 Nagara M.V Kaduruwela, 

Polonnruwa 

027-2225055 64 

Hingurakgoda Main Street, 

Hingurakgoda 

027-2247513 Ananda Balika 

M.V 

Hathmuna Rd, 

Hingurakgoda 

027-2224111 132 

Hingurakgoda Main Street, 

Hingurakgoda 

027-2247513 Minneriya Central 

College 

Minneriya Rd, 

Hingurakgoda 

027-2224518 114 
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Hingurakgoda Main Street, 

Hingurakgoda 

027-2247513 Medirigiriya 

Central College 

Minneriya, 

Hingurakgoda 

027-2224110 134 

Hingurakgoda Main Street, 

Hingurakgoda 

027-2247513 Giritale M.V Polonnruwa Rd, 

Giritale 

027-2228857 84 

Hingurakgoda Main Street, 

Hingurakgoda 

027-2247513 Bakamoona 

Central College 

Matale Rd, 

Bakamoona 

027-2226363 102 

Dimbulagala Manampitiya, 

Polonnruwa 

027-2222471 Manampitiya M.V Manampitiya, 

Polonnruwa 

027-2225151 69 

Dimbulagala Manampitiya, 

Polonnruwa 

027-2222471 Vilayaya Central 

College 

New Town, 

Aralaganvila 

027-2227788 105 

Dimbulagala Manampitiya, 

Polonnruwa 

027-2222471 Valikanda M.V Main Street, 

Valikanda 

027-2220707 66 

Dimbulagala Manampitiya, 

Polonnruwa 

027-2222471 Dimbulagala M.V Dimbulagala, 

Polonnruwa 

027-2223333 44 
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Annexe 9.4.2 

Relational Database 
 

A database system in which the database is organized and accessed according to the 

relationships between data items. Relationships between data items are expressed by 

means of tables. 

 

Relational Database Management System. 
 

A database management system with the ability to access data organized in tabular files 

that can be related to each other by a common field (item). An RDBMS has the 

capability to recombine the data items from different files, providing powerful tools for 

data usage 

 

Relationships and Keys  
 

A relationship is an association between two or more tables. Relationships are 

expressed in the data values of the primary and foreign keys.  

 

A primary key is a column or columns in a table whose values uniquely identify each 

row in a table. A foreign key is a column or columns whose values are the same as the 

primary key of another table. You can think of a foreign key as a copy of primary key 

from another relational table. The relationship is made between two relational tables by 

matching the values of the foreign key in one table with the values of the primary key in 

another.  

Keys are fundamental to the concept of relational databases because they enable tables 

in the database to be related with each other.  

 

 

 

 

 
 



 

 National Institute of Education- 2006 337

Annexe 9.4.3 

Instruction for the group exploration 

 

Engage on the following assignment in groups and prepare to make a team 

representation at the end. 

 

1. Division_No, Division_Name, Division_Address, School_No, School_name, 

School_Address 

2. Doctor_id, Doctor_Name, Doctor_Addres, Patient_no   patient_Name, Patient 

Address, Patient_Phone   
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Competency Level 9.5 : Uses DBMS software to convert a manually developed     
         relational database into electronic media 

Activity 9.5         :   Let’s design a Relational database using a DBMS  application.                               

Time  :  120 minutes    

 

 

Quality Inputs    :   ●    Copy of two tables in Annexe 9.5.1  

  ● Ten copies of Reading material containing steps for the 

creation of Relational  tables in Annexe 9.5.2 

                               ●  Tables created by the students in previous activity in  

    Annexe 9.5.3                             

Learning – Teaching Process: 

Step  9.5.1           :  ●    Expose two tables to the class and ask them to study the          

         tables and find whether the tables contains related records. 

   ●    Conduct a discussion to highlight the following 

 

 
    
 
 
 
 
 
Step  9.5.2           :  ●  Divide the class into 10 groups 

● Provide each group with a copy of Annexure 9.5.1 

● Ask them to study the previous manually database with two 

tables 

o Divisions 

o School 

Competency  9 : Develops simple databases to elicit information. 
 

● Both tables contains data of same students 

● The field Reg No appears in both tables. 

● Therefore, there is a relationship between these two tables. 
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● Load the database software 

● Ask them to create the database with two tables with relevant  

data types & formats. 

● Save the tables and enter the data given.  

● Move around the computer lab, monitor progress & help. 

● Conduct a discussion & highlight the following 

       

 

        (50 minutes) 

 

 

Step 9.5.3 :   ●    Ask the participants to go through the Annexe 9.5.1. 

● Open created database and & follow the grade directions to  

        make a make relationship between the tables.  

● Define primary keys and foreign keys. 

                                          (50 minutes) 

Step 9.5.4            :    ●  Move around the computer lab, monitor progress & help. The   

             following is highlighted.                                    

● DBMS software provide facilities dealing with multiple tables 

● These tables can be related with one and other. Data stored in 

related tables can be Manipulated and utilized. 
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(20minutes) 

 

 

Criteria for Assessment & Evaluation  

● Explains technology of relational databases.  

● Designs a relational database using database software. 

● Accepts value of relational database 

● Selects appropriate primary & foreign keys, data types, formats and field sizes. 

● Manipulates information to suit different purposes 

● RDBMS is a collection of related tables. 

 
 
 
 
 
 
 

● Tables can be related to each other in a variety of ways. 

● The simplest relationship is the one-to-one relationship, in 

which one record in a table is related to another record in a 

separate table. A one-to-many relationship is one in which 

one record in a table is related to multiple records in another 

table.  

● Tables can contain a primary key, which differentiates 

records from one another. Foreign keys relate tables in the 

database to one another. A foreign key in one table is a 

primary key in another. 

● RDBMS software facilitates to create other important objects 

from the related tables. They are 

o Queries 
o Forms 
o Reports

Education database 

Divisions Schools
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Annexe 9.5.1 

 
Students’ registration table 

    Students’ marks table 

 
 
 

 
 
 
 
 
 
 
 

 
            
 
 
 
 
 
 
 
 
 
 
 

REG NO NAME ADDRESS BIRTH DATE 
001 Dinithi Thilanga Galle 06/06/1996 
002 Saman Perera Colombo 01/02/1995 
003 W.Vazeer Polonnaruwa 01/18/1996 
004 Kavindi 

Amarasekara 
Kandy 12/12/1995 

005 Nuwan Bandara Kegalle 02/23/1996 

INDEX NO REG NO WORD 
MARKS 

EXCEL 
MARKS 

ACCESS 
MARKS 

E1 001 32 56 58 
E2 002 98 87 76 
E3 003 69 67 81 
E4 004 36 45 44 
E5 005 31 28 55 
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Annexe 9.5.2 
Creating a Relationship using Ms Access 2000 

 

Step1: Open the database & show the tables 

 

 

 

Step2: Tool                        Relationships 
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Step 3: From the Relationship window, right click and select the Show Table 

 
 

Step 4: From the Show Table click Add button to add the tables onto the Relationships 

window. 
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Step5: Click close on the Show table dialog box 

Step6: From the Relationship window Drag the field name from one   table and drop it                  

           onto the related field in the other   table    

 

Step 5: From the Edit Relationship dialog box, select Enforce Referential Integrity 

check box and click Create. Relationship type is shown below dialog box. 

  
 

Step 6: Save the Relationship and Close the Relationships window. 
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Annexe 9.5.3 

 
 

Engage participants on the assignment in groups and prepare them to make a team 

representation at the end. 

 

 

 

 

 

 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

Create tables using following fields and make relationship between both tables. 

(make relationship using  MS Access facilities) 

Fields: 
1. Division_No, Division_Name, Division_Address, School_No, School_name, 

School_Address 

2. Doctor_id, Doctor_Name, Doctor_Addres, Patient_no   patient_Name, 

Patient Address, Patient_Phone   
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Exercise 1. Creating database with two tables. 
 

1. Create a database named as "My second table" on the D: drive. 

2. Create first table in design view and add the following fields. 

o Product Id 

o Product Code 

o Description 

o Producer Id 

o Price 

 

3. Set the data type and field size 

4. Set the Product Id as the primary key 

5. Save the table design as Product & close. 

6. Open the table & enter the data. 

7. Create the second table in design view with the following fields. 

o Producer Id 

o Producer name 

o Address 

o Telephone Number 

o Web site 

8. Set the appropriate data types & field size. 

9. Set the Producer Id as the primary key. 

10. Close the and save the table as Producer. 

11. Open the Producer table & enter the data. 
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Exercise 2. Creating Relationships 

 

1. Open the Relationship window and add all the tables. 

2. Set up a “proper” relationship between the Producer Id & the Product Id. 

 

 

Exercise 3. Creating a simple query. 
 

1. Open the "My second database". 
2. Select Queries object & select design view. 

3. Add the tables named Product and Producer. 

4. Add Product Id, Description, and Price from Product table and add Producer 

name and telephone number from Maker table. 

5. Close & save the Query as My first Query. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 National Institute of Education- 2006 348

Education database  
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Competency Level 9.6 : Creates quarries to extract information  
Activity 9.6 :  Lets  design a query 
 
Time : 60 minutes 
 
Quality input  : ●   Student database on a bristol board in Annexe 9.6.1 

     ●   Four copies of soft copy in  Annexe 9.6.2 

     ●   Four copies of Graded directions in Annexe 9.6.3 

 
Teaching Learning process: 
 
Step 9.6.1 : •   Teacher displays the manually prepared database (Name ,  

      Address,  DOB, Gender) 
●   Ask the following questions 

o Name two students who are under 25 years of age 

o Find 3 girls who come from Bandarawela 

● Conduct the discussion to highlight the following. 

 
 
 
 
 
 
 
 
 
 
 
 
 
          
 

(15 minutes) 
 
 
 
 
 
 

● Data can be extracted for requirements. 

● DOB column should be referred and calculated to find the 

names of the students who are below 25 years of age.. 

● Gender column and Address column should be referred to 

find the names of the girls whose addresses are in 

Bandarawela  

● Referring to more columns for a requirement is a difficult 

task. 

● These tasks can be easily done by using computers.  

 
Competency  9 : Develops simple databases to elicit information. 
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Step 9.6.2:    •    Divide the class into four groups. 

• Provide each group with a copy of Annexe 9.7.2 and Annexe 9.7.3  

• Assign each group a different set of conditions for data extraction.  

• Prepare each group to present its findings 

 

 
(30 minutes) 

 
Step  3:   ●    Get each group to present its findings. 

●    Conduct a discussion to highlight the following 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

(15 minutes) 
 
Criteria for assessment and Evaluation 
 
 
● Describes the usefulness of a query. 

● Accepts that data duplication can be avoided by using query. 

● Uses quarries to obtain information. 

● Reflects on previous experiences to arrive at suitable answers. 

● Expresses verbally the facts obtained from an experience. 

 

 
 
 
 
 
 
 

• Query is used for extracting data from table 

• Data can be extracted using conditions on one or more fields. 

• Conditions should be written according to the valid syntax 

• Data from one or more table can be retrieved (When they are 

relational) 

• Sorting and show are some facilities that can be used when 

extracting data 

• The extracted data can be saved or printed 
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Competency Level 9.7 : Uses forms to append data and view information. 

 
Activity : Lets design a form 

Time : 60 minutes 

Quality Input:  •   A printed list of records on a single sheet. Annexe 9.7.1 

•   A set of printed cards each containing the same records in annexe  

 1 with record number in  Annexe 9.7.2 

   •   Graded directions to create a form in Annexe 9.7.2 

   •   Soft copy of School database 

 

Learning teaching process: 

Step 9.7.1:  •    Get two volunteers and ask one to display  Annexe 9.7.1 and the  

Other  to display Annexe 9.7.2  

• Ask both volunteers to show the fifth record to the class 

• Ask both volunteers to tell the address of the ninth record to the class 

• Conduct a discussion to highlight the following 

 

 

 

 

 

(15 minutes) 

Step 9.7.2:    •   Divide the class into three groups. 

• Provide each group with a copy of  Annexe 9.7.1 , Annexe 9.7.2 and 

School database. 

• Assign each group to design a form for the given table. 

• Assign each group the following task 

o Adding new records 

• Displaying one record at a time gives clear view of the record. 

• Form gives attractive view.  

• Forms can be designed electronically in computers as an 

interface to the records in the table. 

 
Competency  9 : Develops simple databases to elicit information. 
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o Editing records 

o  Deleting records 

(30 minutes) 

Step 9.7. 3:  •   Get each group to present its findings. 

  •   Conduct a discussion to highlight  the following.  

 

 

 

 

 

 

 

(15 minutes) 

Criteria for assessment and evaluation. 
 

• Describes the advantages in the use of forms. 

• Accepts that attractively design form is easy to understand. 

• Handles records using forms 

• Works with peers cooperatively.  

• Understands a document. 

 

• A database with source table is essential to create forms 
• The form gives an attractive graphical user interface to handle 

records 
• Properties are useful to make forms attractive.. 
• Adding, Deleting and Editing records is quick and simple in form 

view. 
. 
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Annexe 9.7.1 

Data Sheet View 

No Student Name Age Sex Address1 

01 Nimal Fernando 23 Male Negombo  
02 Sriyantha Perera 22 Male Matara 
03 Nilmini Dissanayaka 24 Female Colombo 
04 Kanthi Samaranayaka 23 Female Matale 
05 Susantha Perera 20 Male Maharagama 
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Annexe 9.7.2 

Creating Form in Design View 

To create a form, follow these steps: 

 Click Forms object on the database window 
 Click the New button on the window.  
 Select "Design View" and choose the table or query associated with the form 

from the drop-down menu.  
 Select View       Toolbox from the menu bar to view the floating toolbar with 

additional options. 
 Add controls by clicking and dragging the field names from the Field List to the 

floating window. 

o To add controls for all of the fields in the Field List, double-click the Field 
List window's title bar and drag all of the highlighted fields to the form 

o Text box is used for value controls 
o Label is used to display any text messages. 

 Arrange the field name controls as you wish.  
 Right click on any control and click properties and in the list change Back color 

/Fore color / Special Effects etc. to make it attractive 

 

 

 

 

 

 

 

 

 

 

 

(Screen capture of a form Design) 

 

Property list
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To add controls for header/footer to display a form heading. 

 Click View            Form Header/ Footer to have a form heading 
 Draw a text box in the form header part using the toolbox. 
 Type heading text in it. 
 Once designing part is over save the form. 

 
Adding Records Using A Form 
 

• Open the form you saved 
• click the New Record button at  the bottom or Insert           New Record 
• Fill out the fields of the form. Press the Tab key to move from field to field or click 

the mouse on the field . 
• Click next / previous / First / Last buttons to display records.  

 

 
 
Deleting Records using a form 
 

• Open the form  
• Click next / previous / First / Last buttons to display any specific record 
•  Then click Delete record button or Edit Delete Record 

 
 
Editing Records using a form 
 

• Open the form  
• Click next / previous / First / Last buttons to display any specific record 
•  Then click edit the data you want  

 
Note: Any changes made in the form is applied to the source data (table /query ) 

New Record

Delete Record
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Part 3 
 
 
 

Assessment and Evaluation 
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Introduction 
Assessment and Evaluation can be identified as two interconnected programs that can 

be conveniently implemented in the classroom in order to identify the levels of 

competence achieved by students so as to establish that the students have actualized 

the expected learning outcomes through the learning-teaching process.  If the 

assessment is implemented properly, it is not difficult for all the students studying in the 

class to acquire a competency at least proximate to the relevant skill.  On the other 

hand, what evaluation expects is to identify what the levels of competency the students 

have achieved are. 

 

Teachers involved in assessment can provide their students with guidance of two types.  

This guidance is commonly called “feedback” and “feed forward”.  When the 

weaknesses and inabilities of students are discovered, it is the task of the teacher to 

provide feedback in order to overcome their learning difficulties and to provide feed 

forward to improve their skills when their abilities and strengths are discovered. 

 
It is necessary that students find out as to which competencies in the course they have 

been able to actualize and the relevant levels for the success of the learning-teaching 

process.  Accordingly, determination of the levels of competency students have 

achieved through the program of evaluation and the communication of student progress 

to parents as well as other relevant sections, is expected of the teacher. 

 

This curriculum comprises a student centered, competency-based, activity oriented 

approach.  The transformation role of the teacher and learning through action becomes 

the core for the purpose of making life meaningful. 

 

An attempt has been made to integrate assessment and evaluation with the learning and 

teaching of the curriculum implemented through a series of activities developed in the 

past.  When students are involved in exploration under the second step of each activity, 

the teacher will be able to subject them to assessment and to evaluation when students 

present their findings and subject same to elaboration.   
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The teacher is expected to move among the students engaged in exploration, observe 

the tasks they are involved in, help them to solve in the classroom itself any problems 

they happen to encounter and provide them facilities and guidance.  

 

Five common criteria are suggested to facilitate the task of assessment and evaluation. 

Out of these criteria, the first three criteria are based on knowledge, skills and attitudes 

that combine to develop each competency. The two final criteria support students in the 

inculcation of two attitudes important in their life. The teacher should make an effort to 

identify these criteria and the five behavioral changes within the classroom itself while 

the students are active and strengthen them under assessment and quantify these 

behaviors under evaluation.  

 

The third part of the course guide has been planned in order to introduce the suggested 

evaluation points and instruments of evaluation selected for this purpose. In this manner, 

students will be able to involve themselves in learning with interest and motivation while 

the learning teaching process is further broadened as a result of the evaluation process 

being implemented between as well as in the course of activities. 

 

 

 

 

 

 

 



 

 National Institute of Education- 2006 362

 

Instruments to Extend the Learning-Teaching Process 
 
 

1. Extension Stage : Term 1, Instrument 1  
 

2. Objectives : · To develop a booklet on the theoretical  
  knowledge gained  
 · To demonstrate relevant skills at a  
  practical test  
 

3. Competency levels covered: 1.5, 2.2, 2.3, 5.1 and 5.2    
 

4. Subject content covered : Computer peripherals.  
Types of ports.  
Connections. 
Execution of menu driven packages. 
Work ethics pertaining to basic computer  
operations    

 
5. Nature of Instrument : Practical test based on completed  

assignment.   
 

6. Instructions for implementation: 
 

 For teachers:  
 

o At the commencement of activity 1.5,  tell students that they have to 
develop a booklet covering the following  
o Pictures/Drawings of computer peripherals with descriptions in 

own words.  
o Diagrams of connectors with relevant ports and descriptions. 
o Justification for selecting ports. 
o Sources of information collected 
 

o Tell them that they are expected to demonstrate one of the  following 
skills at the end of activity 5.2 assigned at random. 

 · Selects ports to connect power and commonly used input and  
  output devices.   
 · Boot up the computer 
 · Loads menu driven programs using given methods. 

o Also tell them that their performance on the above skills will be 
evaluated taking into consideration their work ethics as well. 

o Schedule the practical test and inform the date well in advance, to the 
students.  

o Assign topics randomly and get students to demonstrate their 
practical skills.  

o Get students to justify their actions, identify errors and report these to 
the class with what they have done to overcome the errors.   



 

 National Institute of Education- 2006 363

o Use the criteria suggested to give feedback on both theoretical and 
practical abilities developed.   

 
 For students:  

 
o Collect pictures/drawings of computer peripherals.   
o Draw diagrams of connectors with relevant ports. 
o Write brief descriptions to explain the items you have collected and 

the diagrams you have drawn.  
o Indicate your information sources.  
o Get the list of skills for the practical test from your teacher. 
o Practice skills daily to improve your performance.  
o Prepare and present yourself for the practical test. 
o Perform the task assigned to you at random. 
o Justify your actions and present the problems you have encountered 

with methods for solving them. 
o Discuss the proficiency level you have reached with your teacher and 

take action to develop it further.    
 
 

7. Format for assessment and evaluation : 
 
                                                     Criteria Student 

Names 

 
 
 
 

Descriptive 
information in 
terms of 
sources tapped 

Relevance 
of pictures 
and 
diagrams 

Practical skills 
acquired 

Verbal 
presentation 

Work ethics 

      
      
      
      
      

 
 Proficiency Levels  

A –  Excellent 
B -  Good 
C -  Average 
D -  Should Improve 
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Instruments to Extend the Learning-Teaching Process 
 

1.   Extension Stage  : Term 1, Instrument 2  
 

2.   Objectives : To study a variety of documents to identify as 
many features as possible of the Word 
Processing application. 
● To practise related skills.  
● To demonstrate skills acquired in a practical 
test.  

  
1. Competency levels covered: 6.1, 6.2, 6.3 and 6.4     
2. Subject content covered :  · The following facilities are made available 

in Word Processing. 
   · Page setup 
   · Entering text 
   · Text Editing and formatting 
   · Inserting objects and tables 
   · Saving and printing 
   · Closing and opening  
    

3. Nature of Instrument : Practical test based on completed  
assignment.   

 
4. Instructions for implementation: 

 
 For teachers:  

 
o At the commencement of activity 6.1, tell students that they have to 

collect various types of documents to study formats used.  
o Request them to paste the documents on bristol board with a brief 

description of the formats identified.    
o Prepare students to practice Word Processing skills for a practical test 

to be conducted at the end of activity 6.4. 
o At the test, pick one format from a document collected and request 

students to illustrate it. 
o Use the criteria suggested to give feedback to students.   

 
 For students:  

 
o Involve yourself in this extension task as you begin working on  

activity 6.1.  
o Collect various types of documents and study their formats.  
o Paste all your document on bristol board and write a few statements 

to describe the formats.    
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o Practice Word Processing skills on the basis of the documents 
collected to prepare for a practical test at the end of activity 6.4. 

o At the test, be prepared to replicate one of the documents you have 
collected. 

o Discuss the proficiency level you have reached with your teacher and 
take action to develop skills further.    

o  
 

5. Format for assessment and evaluation : 
 

Criteria Name of the 
Student 
 
 
 
 

Adequacy of 
documents 
collected  

Accuracy of 
descriptions 
provided  

Keyboard 
skills 

Use of 
correct tools 
for WP 
functions 

Creativity 

      
      
      
      
      

 
 

 Proficiency Levels  
A –  Excellent 
B -  Good 
C -  Average 
D -  Should Improve 
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Sample Questions 
 

1. Bill Gates: 1981 has said, “640 KB of primary memory is enough for any PC”. 
  

a. What does KB stand for?      [1 mark ]  
 
b. Express 640 KB in bytes?      [2 marks ] 

 
 
c. Give two differences between Primary Memory and Secondary Memory? 
         [ 3 marks  ] 
d. The Personal Computer developed during 1980’s is said to be belong to  

the 4th generation.  Which generation does ENIAC belong to? [1 mark  ] 
 
e. Do you think that the statement above is still valid today? Justify your  

answer.         [5 
marks ] 

 
2. Ravi wanted to buy a computer system. He asked Athula to help him in this 

matter. Athula is an expert in the use of computers. He had been a student at 
CRC. He took Ravi to the “Computer Shop”. There they were given a leaflet 
about computers and their specifications. 
 
This leaflet reads as follows: 

 
Processor: Intel® Pentium®4 CPU 3.2GHz. 
Motherboard: Intel® P4 
Memory: 512 MB 
Mouse: Wireless Optical Scroll mouse 
VGA memory: 64 MB 
Monitor: 17” Flat screen 
Keyboard: 104 Standard 
Sound: Inbuilt 32 Bit 
Speakers: 800 W 
CD Rom: 52x 
CD Writer: 16x 
Software: Linux (Open Source) 

 
Athula explains that this computer has a processor with a higher speed than his and 
that his is a Pentium III. 
a. List 3 other different processors. 

i. …………………………….. 
ii. …………………………….. 
iii. ……………………………..     [ 3 marks] 
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b. The latest mouse in the market is the Wireless Optical Scroll mouse. List two 
other mice used with computers. 
i. …………………..………… 
ii. ……………………………..      [ 2 

marks]  
c. In the 32 bit inbuilt sound card above,   

i. What is a Bit? ……………………………………………………… 
ii. Express 32 Bits in Bytes ……………………………………………. 

[ 2 marks] 
d. In the Linux open source software above,  

i. What is meant by software?      [ 1 mark] 
ii. What kind of software do you need to operate a computer?  [ 1 mark] 
iii. If you need to type a letter asking for quotations for a computer what software 

will you use?         [ 1 
mark] 

iv. Suppose you are left-handed and you need to change your mouse buttons, 
how would you do this?      [ 2 marks] 

 
 
 
 
 

Please forward your suggestions and comments to the following e-mail 
address:    nie.lk.@hotmail.com 


